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About This Book

/A WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

/A CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

Bf NOTE: Text set off in this manner provides important supplemental information.
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1 Installing and Customizing the Software

Bf NOTE: If the computer was shipped with Windows Vista loaded, you will be prompted to register the
computer with HP Total Care before installing the operating system. You will see a brief movie followed
by an online registration form. Fill out the form, click the Begin button, and follow the instructions on the
screen.

/A CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

Installing the Operating System

The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

/A CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process may damage
the software that runs the computer or prevent its proper installation.

Bf NOTE: If the computer shipped with more than one operating system language on the hard drive, the
installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this documentation
do not apply. Additional information is available in online help after you install the operating system.

Installing or Upgrading Device Drivers

When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C: \ 1386, or use the Browse button
in the dialog box to locate the i386 folder. This action points the operating system to the appropriate
drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and software
(and firmware), enter the model number of the computer, and press Enter.
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HP Backup and Recovery Manager

2

The HP Backup and Recovery Manager is an easy-to-use, versatile application that allows you to back
up and recover the primary hard drive on the PC. The application works within Windows to create
backups of Windows, all applications, and all data files. Backups can be scheduled to occur
automatically at designated intervals, or they can be initiated manually. Important files can be archived
separately from regular backups.

HP Backup and Recovery Manager is preinstalled on the C: drive and creates a Recovery Partition.

Recovery Points and file backups can be copied to CD or DVD discs, while all backups can be copied
to network or secondary hard disks.

HP highly recommends that you create a Recovery Disc Set immediately before using the computer
and schedule regular automatic Recovery Point backups.

To create the Recovery Disc Set:

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open the
Backup and Recovery Wizard, then click Next.

2. Select Create a set of recovery discs (Recommended) and click Next.
3. Follow the instructions in the wizard.

For more information on using HP Backup and Recovery Manager, refer to the HP Backup and Recovery
Manager User Guide by selecting Start > HP Backup and Recovery > HP Backup and Recovery
Manager Manual.

NOTE: You can order a Recovery Disc Set from HP by calling the HP support center. Go to the
following Web site, select your region, and click the Technical support after you buy link under the
Call HP heading to obtain the support center telephone number for your region.

http://welcome.hp.com/country/us/en/wwcontact us.html
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2 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

Q always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
Q always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

Secure integrated 1/O functionality, including the serial, USB, or parallel ports, audio, or embedded
NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Enable or disable legacy diskette write ability (when supported by hardware).
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e Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e Replicate the system setup by saving system configuration information on diskette and restoring
it on one or more computers.

e Execute self-tests on a specified ATA hard drive (when supported by drive).

e Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter
Computer Setup. Press Enter to bypass the title screen, if necessary.

=’ NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 when the monitor light turns green to access the utility.

3. Select your language from the list and press Enter.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Ultilities
menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e Toreset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

/A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10)
changes because the CMOS could become corrupted. It is safe to turn off the computer only after exiting
the F10 Setup screen.

Table 2-1 Computer Setup (F10) Utility

Heading Table

File Table 2-2 Computer Setup—File on page 5

Storage Table 2-3 Computer Setup—Storage on page 6

Security Table 2-4 Computer Setup—Security on page 8

Power Table 2-5 Computer Setup—Power on page 12

Advanced Table 2-6 Computer Setup—Advanced (for advanced users)
on page 13
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Computer Setup—File

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-2 Computer Setup—File

Option Description

System Information Lists:
e  Product name
e  SKU number (some models)
e  Processor type/speed/stepping
e  Cache size (L1/L2) (dual core processors have this listed twice)
e Installed memory size/speed, number of channels (single or dual) (if applicable)
o Integrated MAC address for embedded, enabled NIC (if applicable)
e  System BIOS (includes family name and version)
e  Chassis serial number
e  Asset tracking number
e  ME firmware version

e Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on a USB flash media device
or CD-ROM.

Replicated Setup Save to Removable Media

Saves system configuration, including CMOS, to a formatted 1.44-MB diskette, a USB flash media
device, or a diskette-like device (a storage device set to emulate a diskette drive).

Restore from Removable Media

Restores system configuration from a diskette, a USB flash media device, or a diskette-like device.

Default Setup Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Applies the currently selected default settings and clears any established passwords.
Exit

Ignore Changes Exits Computer Setup without applying or saving any changes.

and Exit

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

6

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-3 Computer Setup—Storage

Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Diskette Type (Legacy Diskettes only)

Identifies the highest capacity media type accepted by the diskette drive. Options are 3.5" 1.44 MB
and 5.25" 1.2 MB.

Drive Emulation

Allows you to select a drive emulation type for a certain storage device. (For example, a Zip drive
can be made bootable by selecting diskette emulation.)

Emulation Type

ATAPI Zip drive:

e None (treated as Other).

o Diskette (treated as diskette drive).

Legacy Diskette: No emulation options available.
CD-ROM: No emulation options available.
ATAPI LS-120:

e None (treated as Other).

e Diskette (treated as diskette drive).

Hard Disk:

e None (prevents BIOS data accesses and disables it as a boot device).
e Hard Disk (treated as hard disk).
Multisector Transfers (ATA disks only)

Specifies how many sectors are transferred per multi-sector PIO operation. Options (subject to
device capabilities) are Disabled, 8, and 16.

Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older versions
of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted, User, and
None.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was active
when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Translation Parameters (ATA disks only)

NOTE: This feature appears only when User translation mode is selected.
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Table 2-3 Computer Setup—Storage (continued)

Allows you to specify the parameters (logical cylinders, heads, and sectors per track) used by the
BIOS to translate disk I/O requests (from the operating system or an application) into terms the hard
drive can accept. Logical cylinders may not exceed 1024. The number of heads may not exceed
256. The number of sectors per track may not exceed 63. These fields are only visible and
changeable when the drive translation mode is set to User.

SATA Default Values

Allows you to specify the default values for the Multisector Transfers, Transfer Mode, and Translation
Mode for ATA devices.

Storage Options

Removable Media Boot

Enables/disables ability to boot the system from removable media.
Legacy Diskette Write

Enables/disables ability to write data to legacy diskettes.

NOTE: After saving changes to Removable Media Write, the computer will restart. Manually turn
the computer off then on.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are three supported options: IDE, RAID, and AHCI.

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage
of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID. Refer to the Advanced Host Controller Interface (AHCI) and
Redundant Array of Independent Disks (RAID) on HP Compaq dc7900 Business PCs white paper
at http://www.hp.com for more information.

NOTE: RAID is not available on USDT systems.
Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gpbs speed.
Some drive and cable combinations may not run reliably at 3.0 Gpbs.

NOTE: eSATA is not available on USDT systems.
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Table 2-3 Computer Setup—Storage (continued)

DPS Self-Test

Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self-
tests is attached to the system.

Boot Order

Allows you to:

e  Specify the order in which attached devices (such as a USB flash media device, diskette drive,
hard drive, optical drive, or network interface card) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration
as a bootable operating system source.

e  Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.

Computer Setup—Security
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B NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-4 Computer Setup—Security

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

See the Desktop Management Guide for more information.

Power-On Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle. If the user does not enter the correct power-on password, the unit will not boot.

NOTE: This password does not appear on warm boots , such as Ctrl+Alt+Delete or Restart from
Windows, unless enabled in Password Options (see below).

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to:
e Lock legacy resources (appears if a setup password is set)
e Enable/disable network server mode (appears if a power-on password is set)

e  Specify whether the password is required for warm boot (Ctrl+Alt+Delete) (appears if a power-
on password is set)

e Enable/Disable Setup Browse Mode (appears if a setup password is set) (allows viewing, but
not changing, the F10 Setup Options without entering setup password)

e Enable/disable Stringent Password (appears if a power-on password is set), which when
enabled bypasses the onboard password jumper to disable the power-on password.
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Table 2-4 Computer Setup—Security (continued)

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:

e  Lock/unlock the Cover Lock.

e Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if the

sensor detects that the cover has been removed.

This feature is supported on some models only. See the Desktop Management Guide for more
information.

Device Security

Allows you to set Device Available/Device Hidden for:
e  Serial ports

e  Parallel port

e  System audio

e  Network controllers (some models)

e Legacy diskette

e Embedded security device (some models)
e SATAO

e SATAT1 (some models)

e  SATA2 (some models)

e  SATA3 (some models)

e  eSATA (some models)

USB Security

Allows you to set Device Available/Device Hidden for:

° Front USB Ports

° USB Port 3
° USB Port 4
° USB Port 5
° USB Port 6

° Rear USB Ports

o USB Port 7
° USB Port 8
° USB Port 9

° USB Port 10
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Table 2-4 Computer Setup—Security (continued)

o USB Port 11

° USB Port 12

° Internal USB Ports

° USB Port 1

° USB Port 2

Network Service Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCl expansion
card or embedded on the system board.)

System IDs Allows you to set:

e  Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

e  Ownership tag (80-byte identifier) displayed during POST.
e  Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in

the factory and are used to uniquely identify the system.)

e Keyboard locale setting (for example, English or German) for System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

See the Desktop Management Guide for more information.

System Security (some Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
models: these options security breaches.

are hardware
dependent) PAVP (Some models) (disabled/min/max) - PAVP enables the Protected Audio Video Path in the

Chipset. This may allow viewing of some protected high definition content that would otherwise be
prohibited from playback. Selecting Max will assign 96 Megabytes of system memory exclusively to
PAVP.

Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed I/0 (some models) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying processor
and chipset features needed to support a virtual appliance. Changing this setting requires turning
the computer off and then back on. To enable this feature you must enable the following features:
e Embedded Security Device Support

e  Virtualization Technology

e  Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the computer

off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.
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Table 2-4 Computer Setup—Security (continued)

e Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

e  Power-on authentication support (some models) (enable/disable) - Controls the power-on
password authentication scheme that utilizes the Embedded Security Device. Changing this
setting requires turning the computer off and then back on.

e Resetauthentication credentials (some models) (Do not reset/Reset) - Selecting Reset disables
the power-on authentication support and clears the authentication information from the
Embedded Security Device. Changing this setting requires turning the computer off and then
back on.

OS management of Embedded Security Device (some models) (enable/disable) - This option allows
the user to limit operating system control of the Embedded Security Device. Changing this setting
requires turning the computer off and then back on. This option allows the user to limit OS control
of the Embedded Security Device.

e Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of
the Embedded Security Device. Changing this setting requires turning the computer off and
then back on.

NOTE: To enable this option, a Setup password must be set.
Smart Card BIOS Password Support (some models) (enable/disable) - Allows the user to enable/

disable the Smart Card to be used in place of the Setup and Power-On Passwords. This setting
requires additional initialization within ProtectTools® before this option will take effect.

Setup Security Level

Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The administrator
specifies access rights to individual setup options on a case-by-case basis via the Setup Security
Level menu. By default, all setup options are assigned Setup Password, indicating the user must
enter the correct Setup Password during POST to make changes to any of the options. The
administrator may set individual items to None, indicating the user can make changes to the specified
options when setup has been accessed with invalid passwords. The choice, None, is replaced by
Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.
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Computer Setup—Power

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-5 Computer Setup—Power

Option Description

OS Power °
Management

Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor.

Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle.

ACPI S3 Hard Disk Reset—Enabling this causes the BIOS to ensure hard disks are ready to
accept commands after resuming from S3 before returning control to the operating system.

ACPI S3 PS2 Mouse Wakeup—Enables or disables waking from S3 due to PS2 mouse activity.

USB Wake on Device Insertion (some models)—Allows system to wake from Standby on USB
device insertion.

Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.

° SO = Solid green LED.

° S3 = 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 3 blinks and a pause.

° S4 = 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 4 blinks and a pause.

° 85 =LED is off.

NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer supported)
and S3 use 1 blink per second.

Hardware Power SATA power management enables or disables SATA bus and/or device power management.

Management

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-6 Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:
e POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
° QuickBoot = Do not clear memory or perform a memory test.
0 FullBoot = Memory test (count) on cold boot. Clears memory on all boots.
° Clear Memory = No memory count on cold boot. Clears memory on all boots.

° FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

e POST messages (enable/disable).

e  F9prompt (hidden/displayed). Enabling this feature will display the text F9 = Boot Menu during
POST. Disabling this feature prevents the text from being displayed. However, pressing F9 will
still access the Shortcut Boot [Order] Menu screen. See Storage > Boot Order for more
information.

e  F10 prompt (hidden/displayed). Enabling this feature will display the text F10 = Setup during
POST. Disabling this feature prevents the text from being displayed. However, pressing F10
will still access the Setup screen.

e F11 prompt (hidden/displayed). Setting this feature to displayed will display the text F11 =
Recovery during POST. Hiding the feature prevents the text from being displayed. However,
pressing F11 will still attempt to boot to the HP Backup and Recovery partition. See Factory
Recovery Boot Support for more information.

e  F12 prompt (hidden/displayed). Enabling this feature will display the text F12 = Network during
POST. Disabling this feature prevents the text from being displayed. However, pressing F12
will still force the system to attempt booting from the network.

e  Factory Recovery Boot Support (enable/disable). Enabling this feature will cause an additional
prompt, F11 = Recovery, to be displayed during POST on systems with HP Backup and
Recovery software installed and configured with a recovery partition on the boot hard drive.
Pressing F11 causes the system to boot to the recovery partition and launch HP Backup and
Recovery. The F11 = Recovery prompt can be hidden with the F11 prompt (hidden/displayed)
option (see above).

e  Option ROM prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. (This feature is supported on some models only.)

e  WOL After Power Loss (enable/disable). Enabling this option will cause the system to power-
up momentarily after a power loss in order to enable the Wake On LAN (WOL) feature.

e Remote wakeup boot source (remote server/local hard drive).
e  After Power Loss (off/on/previous state): Setting this option to:
° Off—causes the computer to remain powered off when power is restored.

° On—causes the computer to power on automatically as soon as power is restored.
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

° On—allows you to power on the computer using a power strip switch, if the computer is
connected to an electric power strip.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able
to use the suspend/sleep feature or the Remote Management features.

e POST Delay (None, 5, 10 15, or 20 seconds). Enabling this feature will add a user-specified
delay to the POST process. This delay is sometimes needed for hard disks on some PCI cards
that spin up very slowly, so slowly that they are not ready to boot by the time POST is finished.
The POST delay also gives you more time to select F10 to enter Computer (F10) Setup.

e Limit CPUID Maximum Value to 3. Restricts the number of CPUID functions reported by the
microprocessor. Enable this feature if booting to Windows NT.

Execute Memory Test  Restarts the computer and executes the POST memory test.
(some models)

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable onboard system devices (diskette controller, serial port,
or parallel port).

PCI Devices e  Lists currently installed PCI devices and their IRQ settings.

e Allows you to reconfigure IRQ settings for these devices or to disable them entirely. These
settings have no effect under an ACPI-based operating system.

PCI VGA Configuration Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which
VGA controller will be the “boot” or primary VGA controller.

NOTE: In order to see this entry, you must enable Integrated Video (Advanced > Device
Options) and Save Changes and Exit.

Bus Options On some models, allows you to enable or disable:
e PCI SERR# Generation.

e PCIVGA palette snooping, which sets the VGA palette snooping bit in PCI configuration space;
only needed when more than one graphics controller is installed.

Device Options Allows you to set:
e  Printer mode (Bi-Directional, EPP + ECP, Output Only).
e Num Lock state at power-on (off/on).
e S5 Wake on LAN (enable/disable).

° To disable Wake on LAN during the off state (S5), use the arrow (left and right) keys to
select the Advanced > Device Options menu and set the S5 Wake on LAN feature to
Disable. This obtains the lowest power consumption available on the computer during
S5. It does not affect the ability of the computer to Wake on LAN from suspend or
hibernation, but will prevent it from waking from S5 via the network. It does not affect
operation of the network connection while the computer is on.

° If a network connection is not required, completely disable the network controller (NIC) by
using the arrow (left and right) keys to select the Security > Device Security menu. Set
the Network Controller option to Device Hidden. This prevents the network controller
from being used by the operating system and reduces the power used by the computer
in S5.

e  Processor cache (enable/disable).
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

Integrated Video (enable/disable). Allows you to use integrated video and PCI Up Solution
video at the same time (available on some models only).

NOTE: After Integrated Video is enabled and changes saved, a new menu item appears
under Advanced to allow you to select the primary VGA controller video device.

Inserting a PCI Express video card automatically disables Integrated Video. When PCI Express
video is on, Integrated Video must remain disabled.

Multi-Processor (enable/disable). This option may be used to disable multi-processor support
under the OS.

Internal speaker (some models) (does not affect external speakers).
Monitor Tracking (enable/disable). Allows BIOS to save monitor asset information.

NIC PXE Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC option
ROM thus giving more DCH space for additional PCI cards which may need option ROM space.
The default will be to have the NIC option-ROM-enabled.

Management Devices

The Management Devices menu will only be displayed in the Advanced menu when the BIOS detects
multiple management options.

This option is for installed NIC cards that support ASF or DASH. Use the Management Devices menu
to select if the BIOS management operations will be through the embedded solution or one of the
installed NIC cards.

Management
Operations

Allows you to set:

MEBXx Setup Prompt (enable/disable). Enabling this feature displays the CTRL+P prompt
during POST. Disabling this feature prevents the prompt from being displayed. However,
pressing Ctrl+P still accesses the utility used to configure manageability settings.

The CTRL+P function activates the MEBx Setup menu. If the Setup Password is configured,
the user will be prompted to correctly enter it before being allowed to enter the MEBx Setup. It
the password is entered incorrectly three times, the MEBx Setup will not be activated.

Remote Help Prompt (enable/disable). Enabling this feature displays the CTRL+ALT+F1
prompt during POST. Disabling this feature prevents the prompt from being displayed.
However, pressing Ctrl+Alt+F1 still accesses the utility used to attempt to connect to remote
help server or services.

Remote Help Lockout (enable/disable). Allows the user/administrator to lock out access to
Remote Help. If enabled, the Ctri+Alt+F 1 key sequence will not be acknowledged by the BIOS.

Remote Help Connection Timeout (5, 10, 15, 20, 30, 40, 50, 60, 120, 180, 240 seconds). Allows
the user/administrator is set a time limit for Remote Help to establish contact with a remote
server when initiated.

SOL Character Echo (enable/disable). Some remote consoles print remotely-entered
characters which can cause the characters to appear twice (once when entered remotely and
once when echoed back from local client video). This option allows the administrator to have
the SOL terminal emulator suppress echoing remotely-entered characters to the local video
display.

SOL Terminal Emulation Mode (enable/disable). Selects between VT100 and ANSI SOL
terminal emulation. SOL terminal emulation mode is only activated during remote AMT
redirection operations. The emulation options allow administrators to select which mode works
best with their console.

SOL Keyboard (enable/disable). Disable or enable client keyboard during SOL sessions. Some
remote remediation may involve having the local client boot a remote image provided by an
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

administrator. This option determines if the BIOS will keep the local keyboard enabled or
disabled for possible local client interaction. If the local keyboard is disabled, all keyboard input
is only accepted from the remote source.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command with
the Computer Setup (F10) Utility before Restore is needed. (See Save to Removable Media
on page 5 in the Computer Setup—File table.)

Bf NOTE: Itis recommended that you save any modified computer configuration settings to a diskette,
a USB flash media device, or a diskette-like device (a storage device set to emulate a diskette drive)
and save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media
emulating a diskette with the saved configuration and perform the Restore from Removable Media
command with the Computer Setup (F10) Utility. (See Restore from Removable Media on page 5 in the
Computer Setup—File table.)
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3

Computer Diagnostic Features

HP Insight Diagnostics

NOTE: HP Insight Diagnostics is included on CD with some computer models only.

The HP Insight Diagnostics utility allows you to view information about the hardware configuration of
the computer and perform hardware diagnostic tests on the subsystems of the computer. The utility
simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

The Survey tab is displayed when you invoke HP Insight Diagnostics. This tab shows the current
configuration of the computer. From the Survey tab, there is access to several categories of information
about the computer. Other tabs provide additional information, including diagnostic test options and test
results. The information in each screen of the utility can be saved as an html file and stored on a diskette
or USB flash drive.

Use HP Insight Diagnostics to determine if all the devices installed on the computer are recognized by
the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third party devices may not be detected by HP Insight Diagnostics.

Accessing HP Insight Diagnostics

To access HP Insight Diagnostics, you must create a Recovery Disc Set then boot to the CD containing
the utility. It can also be downloaded from http://www.hp.com. See Downloading the Latest Version of
HP Insight Diagnostics on page 21 for more information.

NOTE: HP Insight Diagnostics is included as part of the Recovery Disk Set with some computer
models only.

If you have already created a Recovery Disc Set, begin the following procedure at step 4.

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open the
Backup and Recovery Wizard, then click Next.

2. Select Create a set of recovery discs (Recommended) and click Next.
3. Follow the instructions in the wizard to create a Recovery Disc Set.

4. Use Windows Explorer to search the Recovery Disc Set for the CD with the compaq\hpdiags
directory.

5.  While the computer is on, insert the CD into an optical drive on the computer.
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6. Shut down the operating system and turn off the computer.

7. Turn on the computer. The system will boot to the CD.

B NOTE: If the system does not boot to the CD in the optical drive, you may need to change the
boot order in the Computer Setup (F10) utility so that the system attempts to boot to the optical
drive before booting to the hard drive. Refer to the Computer Setup (F10) Utility Guide for more
information.

8. Select the appropriate language and click Continue.

Bf NOTE: Itis recommended that you accept the assigned default keyboard for your language
unless you want to test your specific keyboard.

9. Inthe End User License Agreement page, click Agree if you agree with the terms. The HP Insight
Diagnostics utility launches with the Survey tab displayed.

Survey Tab
The Survey tab displays important system configuration information.

In the View level field, you can select the Summary view to see limited configuration data or select
the Advanced view to see all the data in the selected category.

In the Category field, you can select the following categories of information to display:

All—Gives a listing of all categories of information about the computer.

Overview—Gives you a listing of general information about the computer.

Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows product name, asset tag, system serial number, and processor information.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port settings,
plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices connected to
the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on the
system board and any memory modules installed.

Miscellaneous—Shows HP Insight Diagnostics version information, computer configuration memory
(CMQOS) information, system board data, and system management BIOS data.

Storage—Shows information about storage media connected to the computer. This list includes all fixed
disks, diskette drives, and optical drives.

System—Shows information about the computer model, processor, chassis, and BIOS, plus internal
speaker and PCI bus information.
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Test Tab

The Test tab allows you to choose various parts of the system to test. You can also choose the type of
test and testing mode.

There are three types of tests to choose from:

e Quick Test—Provides a predetermined script where a sample of each hardware component is
exercised and requires no user intervention in either Unattended or Interactive mode except for
keyboard and mouse devices.

e Complete Test—Provides a predetermined script where each hardware component is fully tested.
There are more tests available in the Interactive mode, but these require user intervention.

e Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test
mode allows you to specifically select which devices, tests, and test parameters are run.

For each test type, there are two test modes to choose from:

e Interactive Mode—Provides maximum control over the testing process. The diagnostic software
will prompt you for input during tests that require your interaction. You may also determine whether
the test passed or failed.

e Unattended Mode—Does not display prompts and requires no interaction. If errors are found, they
are displayed when testing is complete.

To begin testing:

1. Select the Test tab.

2. Select the tab for the type of test you want to run: Quick, Complete, or Custom.
3. Select the Test Mode: Interactive or Unattended.
4

Choose how you want the test to be executed, either Number of Loops or Total Test Time. When
choosing to run the test over a specified number of loops, enter the number of loops to perform. If
you want the diagnostic test for a specified time period, enter the amount of time in minutes.

5. If performing a Quick Test or Complete Test, select the device to be tested from the check list. If
performing a Custom Test, click the Expand button and select the devices to be tested or click
the Check All button to select all devices.

6. Click the Begin Testing button at the bottom right corner of the screen to start the test. The Status
tab, which allows you to monitor the progress of the test, is automatically displayed during the
testing process. When the test is complete, the Status tab shows whether the device passed or
failed.

7. If errors are found, go to the Log tab and click the Error Log to display more detailed information
and recommended actions.

Status Tab

The Status tab displays the status of the selected tests. The type of test executed (Quick, Complete,
or Custom) is also displayed. The main progress bar displays the percent complete of the current set
of tests. While testing is in progress, a Cancel Testing button is displayed for use if you want to cancel
the test.
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After testing has completed, the Cancel Testing button is replaced with a Retest button. The Retest
button will retest the last set of tests executed. This enables you to re-run the set of tests without having
to re-enter the data in the Test tab.

The Status tab also shows:

e The devices being tested

e The test status (running, passed, or failed) of each device being tested
e The overall test progress of all devices being tested

e The test progress for each device being tested

e The elapsed test times for each device being tested

Log Tab

The Log tab contains a Test Log tab and an Error Log tab.

The Test Log displays all tests that have been executed, the number of times of execution, the number
of times failed, and the time it took to complete each test. The Clear Test Log button will clear the
contents of the Test Log.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

e The Device section displays the device tested.
e The Test section displays the type of test run.
e The Description section describes the error that the diagnostic test found.

e The Recommended Repair will give a recommended action that should be performed to resolve
the failed hardware.

e The Failed Count is the number of times the device has failed a test.

e The Error Code provides a numerical code for the failure. The error codes are defined in the Help
tab.

The Clear Error Log button will clear the contents of the Error Log.

Help Tab

The Help tab contains an HP Insight Diagnostics tab, an Error Codes tab, and a Test
Components tab.

The HP Insight Diagnostics tab contains help topics and includes search and index features.

The Error Codes tab provides a description of each numerical error code that may appear in the Error
Log tab located on the Log tab. Each code has a corresponding error Message and a Recommended
Repair action that should help solve the problem. To find an error code description quickly, enter the
code in the box at the top of the tab and click the Find Error Codes button.

The Test Components tab displays low-level information on tests that are run.
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Saving and Printing Information in HP Insight Diagnostics

You can save the information displayed in the HP Insight Diagnostics Survey and Log tabs to a diskette
or a USB 2.0 flash drive (64MB or higher). You can not save to the hard drive. The system will
automatically create an html file that has the same appearance as the information displayed on the
screen.

1. Insert a diskette or USB 2.0 flash drive (capacity must be 64MB or higher). USB 1.0 flash drives
are not supported.

2. Click Save in the bottom right corner of the screen.
3. Select Save to the floppy or Save to USB key.

4. Enter a file name in the File Name box and click the Save button. An html file will be saved to the
inserted diskette or USB flash drive.

B NOTE: Do not remove the diskette or USB key until you see a message indicating that the html
file has been written to the media.

5. Print the information from the storage device used to save it.

Bf NOTE: To exit HP Insight Diagnostics, click the Exit Diagnostics button in the bottom left corner of the
screen then remove the CD from the optical drive.

Downloading the Latest Version of HP Insight Diagnostics

1. Go to http://www.hp.com.

Click the Software & Drivers link.

Select Download drivers and software (and firmware).

Enter your product number (for example, dc7900) in the text box and press the Enter key.
Select your specific computer model.

Select your OS.

Click the Diagnostic link.

© N o o » 0 b

Click HP Insight Diagnostics Offline Edition.
9. Click the Download button.

B NOTE: The download includes instructions on how to create the bootable CD.

Protecting the Software

To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of data files.
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HP Backup and Recovery Manager

The HP Backup and Recovery Manager is an easy-to-use, versatile application that allows you to back
up and recover the primary hard drive on the PC. The application works within Windows to create
backups of Windows, all applications, and all data files. Backups can be scheduled to occur
automatically at designated intervals, or they can be initiated manually. Important files can be archived
separately from regular backups.

HP Backup and Recovery Manager is preinstalled on the C: drive and creates a Recovery Partition.

Recovery Points and file backups can be copied to CD or DVD discs, while all backups can be copied
to network or secondary hard disks.

HP highly recommends that you create a Recovery Disc Set immediately before using the computer
and schedule regular automatic Recovery Point backups.

To create the Recovery Disc Set:

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open the
Backup and Recovery Wizard, then click Next.

2. Select Create a set of recovery discs (Recommended) and click Next.
3. Follow the instructions in the wizard.

For more information on using HP Backup and Recovery Manager, refer to the HP Backup and Recovery
Manager User Guide by selecting Start > HP Backup and Recovery > HP Backup and Recovery
Manager Manual.

B NOTE: You can order a Recovery Disc Set from HP by calling the HP support center. Go to the
following Web site, select your region, and click the Technical support after you buy link under the
Call HP heading to obtain the support center telephone number for your region.

http://welcome.hp.com/country/us/en/wwcontact us.html
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4 Desktop Management

HP Client Management Solutions provides standards-based solutions for managing and controlling
desktops, workstations, and notebook PCs in a networked environment. HP pioneered desktop
manageability in 1995 with the introduction of the industry’s first fully manageable desktop personal
computers. HP is a patent holder of manageability technology. Since then, HP has led an industry-wide
effort to develop the standards and infrastructure required to effectively deploy, configure, and manage
desktops, workstations, and notebook PCs. HP develops its own management software and works
closely with leading management software solution providers in the industry to ensure compatibility
between HP Client Management Solutions and these products. HP Client Management Solutions are
an important aspect of our broad commitment to providing you with solutions that assist you in lowering
the total cost of owning and maintaining the PCs throughout their lifecycle.

The key capabilities and features of desktop management are:
e Initial configuration and deployment

e Remote system installation

e  Software updating and management

e ROM flash

e Hardware option configuration

e Asset tracking and security

e Fault notification and recovery

B NOTE: Support for specific features described in this guide may vary by model or software version.

Initial Configuration and Deployment

The computer comes with a preinstalled system software image. After a brief software “unbundling”
process, the computer is ready to use.

You may prefer to replace the preinstalled software image with a customized set of system and
application software. There are several methods for deploying a customized software image. They
include:

e Installing additional software applications after unbundling the preinstalled software image.

e Using software deployment tools, such as HP Client Automation Standard Edition, HP Client
Automation Enterprise Edition (based on Radia technology), or Altiris Deployment Solution, to
replace the preinstalled software with a customized software image.

e Using a disk cloning process to copy the contents from one hard drive to another.
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The best deployment method depends on your information technology environment and processes.

The HP Backup and Recovery system, ROM-based setup, and ACPI hardware provide further
assistance with recovery of system software, configuration management and troubleshooting, and
power management.

B NOTE: See HP Backup and Recovery Manager on page 2 for information on creating a Recovery Disc
Set.

HP Software Agent

The management agent used by both HP Client Automation Standard and Enterprise Editions is pre-
loaded on the computer. When installed, it enables communication with the HP management console.

To install the HP Software Agent:

1. Click Start.

2. Click All Programs.

3. Click HP Manageability.

4. Click Radia Management Agent Readme.

5. Review and follow the instructions contained in the Readme file to install the HP Software Agent.

The HP Software Agent is a key infrastructure component for enabling all of the HP Client Automation
solutions. To learn about the other infrastructure components necessary for implementing the HP
configuration management solutions, please visit http://h20229.www2.hp.com/solutions/ascm/
index.html.

Altiris Deployment Solution Agent

This program is pre-loaded on the computer. When installed, it enables communication with the
administrator Deployment Solution console.

To install Altiris Deployment Solution Agent:

1. Click Start.

2. Click All Programs.

3. For Windows Vista, click Install Altiris DAgent. For Windows XP, click Install Altiris AClient.
4. Follow the onscreen instructions to set up and configure the Altiris client.

This agent is a key infrastructure component for enabling Altiris Deployment Solution which is part of
the Altiris Client Management Suite. To learn about the other infrastructure components necessary for
implementing Altiris Client Management Suite, please visit http://www.hp.com/go/easydeploy.

Remote System Installation

Remote System Installation allows you to start and set up the system using the software and
configuration information located on a network server by initiating the Preboot Execution Environment
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(PXE). The Remote System Installation feature is usually used as a system setup and configuration tool
and can be used for the following tasks:

e Formatting a hard drive
e Deploying a software image on one or more new PCs

e Remotely updating the system BIOS in flash ROM (Remote ROM Flash on page 33)

e Configuring the system BIOS settings

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot message
appears in the lower-right corner of the HP logo screen when the computer is booting up. Follow the
instructions on the screen to continue the process. The default boot order is a BIOS configuration setting
that can be changed to always attempt to PXE boot.

Software Updating and Management

HP provides several tools for managing and updating software on desktops, workstations, and
notebooks:

e HP Client Management Interface

e HP SoftPaq Download Manager

e HP System Software Manager

e HP ProtectTools Security Manager

e HP Client Automation Starter, Standard, and Enterprise Editions
e HP Client Manager from Symantec

e Altiris Client Management Suite

e HP Client Catalog for Microsoft System Center & SMS Products
e HP Backup and Recovery Manager

e Intel vPro-branded PCs with Active Management Technology

e Verdiem Surveyor

e HP Proactive Change Notification

° HP Subscriber's Choice

HP Client Management Interface

Regardless of the system management tools your IT department uses, managing both your hardware
and software assets is important to keeping your IT costs low and your business agile. The IT
administrator can access the HP Client Management Interface by writing simple scripts and integrating
those scripts to the management solution of their choice.

With the HP Client Management Interface (HP CMI), new HP business computers seamlessly integrate
into your managed IT environment. HP CMI provides an interface that simplifies the integration of HP
business computers with popular industry system management tools (including Microsoft Systems
Management Server, IBM Tivoli Software, and HP Operations) and custom in-house developed
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management applications. Using HP CMI, systems management tools and applications can request in-
depth client inventory, receive health status information, and manage system BIOS settings by
communicating directly with the client computer, reducing the need for agent or connector software to
achieve integration.

HP Client Management Interface is based on industry standards that include Microsoft Windows
Management Interface (MS WMI), Web-Based Enterprise Management (WBEM), System Management
BIOS (SMBIOS), and Advanced Configuration and Power Interface (ACPI). HP CMI is a foundation
technology utilized in HP Client Management Solutions. With HP CMI, HP gives you flexibility in choosing
how you manage your HP client computers.

HP Client Management Interface used in conjunction with system management software can:

e Requestin-depth client inventory information—Capture detailed information about the processors,
hard drives, memory, BIOS, drivers, including sensor information (such as fan speed, voltage, and
temperature).

e Receive health status information—Subscribe for a wide range of client hardware alerts (such as
over-temperature, fan stall, and hardware configuration changes) to be sent to the system
management console, application, or to the local client computer. Alerts are sent real-time when
triggered by hardware events.

e Manage system BIOS settings—Perform F10 functions including setting and changing the BIOS
passwords and computer boot order remotely from your system management console on any or
all of your client systems without having to visit each machine.

For more information on HP Client Management Interface, refer to http://www.hp.com/go/hpcmi/.

HP SoftPaq Download Manager

HP SoftPag Download Manager is a free, easy-to-use interface for locating and downloading software
updates for the HP client PC models in your environment. By specifying your models, operating system,
and language, you can quickly locate, sort, and select the softpaqgs you need. To download HP SoftPaq
Download Manager, visit http://www.hp.com/go/sdm.

HP System Software Manager

HP System Software Manager (SSM) is a free utility that automates remote deployment of device drivers
and BIOS updates for your networked HP business PCs. When SSM runs, it silently (without user
interaction) determines the revision levels of drivers and BIOS installed on each networked client system
and compares this inventory against system software SoftPags that have been tested and stored in a
central file store. SSM then automatically updates any down-revision system software on the networked
PCs to the later levels available in the file store. Since SSM only allows distribution of SoftPaq updates
to the correct client system models, administrators can confidently and efficiently use SSM to keep
system software updated.

System Software Manager integrates with enterprise software distribution tools such as HP Client
Automation solutions, HP Client Manager from Symantec, and Microsoft Systems Management Server
(SMS). Using SSM, you can distribute customer-created or third-party updates that have been packaged
in the SSM-format.

SSM may be downloaded at no charge by visiting http://www.hp.com/go/ssm.
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B NOTE: SSM does not currently support remote ROM flash on systems that have Windows Vista
BitLocker enabled and are using TPM measurements to protect the BitLocker keys because flashing
the BIOS would invalidate the trust signature that BitLocker created for the platform. Disable BitLocker
via Group Policy in order to flash the system BIOS.

You can enable BitLocker support without TPM measurements of BIOS to avoid invalidating the
BitLocker keys. HP recommends you keep a secure backup of the BitLocker credentials in case of
recovery emergencies.

HP ProtectTools Security Manager

HP ProtectTools Security Manager software provides security features that help protect against
unauthorized access to the computer, networks, and critical data. Enhanced security functionality is
provided by the following software modules:

e  Credential Manager for HP ProtectTools

e Embedded Security for HP ProtectTools

e Java Card Security for HP ProtectTools

e BIOS Configuration for HP ProtectTools

e Drive Encryption for HP ProtectTools

e Device Access Manager for HP ProtectTools
e File Sanitizer for HP ProtectTools

e  Privacy Manager for HP ProtectTools

The software modules available for your computer may vary depending on your model. For example,
Embedded Security for HP ProtectTools is available only for computers on which the Trusted Platform
Module (TPM) embedded security chip is installed.

HP ProtectTools software modules may be preinstalled, preloaded, or available for download from the
HP Web site. For select HP Compaq Desktops, HP ProtectTools is available as an after market option.
Visit http://www.hp.com/products/security for more information.

HP Client Automation Starter and Standard Editions

HP Client Automation is a hardware and software management solution for Windows Vista, Windows
XP and HP Thin Client environments that is easy to use and quick to deploy, while providing a strong
foundation for future requirements. It is offered in two editions:

e The Starter Edition is a free product for managing HP desktops, notebooks and workstations,
providing hardware and software inventory, remote control, HP alert monitoring, HP BIOS and
driver updates, integration with HP Protect Tools and add-on support for Intel AMT. The Starter
Edition also supports deployment and management of HP Thin Clients.

e The Standard Edition, available for purchase, includes all functionality provided in Starter Edition
and adds Windows deployment and migration, patch management capabilities, software
distribution and software usage metering.

HP Client Automation Starter and Standard Editions provide a migration path to HP Client Automation
Enterprise Edition (based on Radia technology) for automated management of large, heterogeneous
and continuously changing IT environments.
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For more information about the HP Client Automation solutions, visit http://www.hp.com/go/client.

HP Client Automation Enterprise Edition

HP Client Automation Enterprise Edition is a policy-based solution that enables administrators to
inventory, deploy, patch, and continuously manage software and content across heterogeneous client
platforms. With the HP Client Automation Enterprise Edition, the IT professional can:

e Automate the entire lifecycle management process from discovery, deployment, and ongoing
management through migration and retirement

e Automatically deploy and continuously manage an entire software stack (operating systems,
applications, patches, settings, and content) to a desired state

e Manage software on virtually any device, including desktops, workstations, and notebooks, in a
heterogeneous or standalone infrastructure

e Manage software on most operating systems

With continuous configuration management, HP customers report dramatic savings in IT costs,
accelerated time-to-market for software and content, and increased user productivity and satisfaction.

For more information about the HP Client Automation solutions, visit http://www.hp.com/go/client.

HP Client Manager from Symantec

HP Client Manager from Symantec, developed with Altiris, is available free for all supported HP business
desktop, notebook, and workstation models. SSM is integrated into HP Client Manager, and enables
central tracking, monitoring, and management of the hardware aspects of HP client systems.

Use HP Client Manager from Symantec to:

e  Get valuable hardware information such as CPU, memory, video, and security settings

e  Monitor system health to fix problems before they occur

e Automatically acquire and install drivers and BIOS updates without visiting each PC

e Remotely configure BIOS and security settings

e Automate processes to quickly resolve hardware problems

Tight integration with HP Instant Support tools reduces hardware troubleshooting time.

e Diagnostics—remotely run & view reports on HP desktop, notebook, and workstation models
e System Health Scan—check for known hardware issues in your installed base of HP client systems
e Active Chat—connect to HP customer support to resolve issues

e HP Knowledgebase—link to expert information

e Automated SoftPaq collection and delivery process for fast resolution of hardware problems
e Identify, inventory, and initialize systems with HP ProtectTools embedded security chip

e  Option for health alerts to display locally on the client system

e Report basic inventory information for non-HP clients
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e Setup and configure TPM security chip
e Centrally schedule client backup and recovery
e Add on support for managing Intel AMT

For more information on HP Client Manager from Symantec, visit http://www.hp.com/go/
clientmanager.

Altiris Client Management Suite

Altiris Client Management Suite is an easy-to-use solution for full life-cycle software management of
desktops, notebooks, and workstations. Client Management Suite Level 1 includes the following Altiris
products:

e Inventory Solution

e Deployment Solution

e  Software Delivery Solution

e Patch Management Solution

e Application Metering Solution

e Application Management Solution
e Carbon Copy Solution

For more information on Altiris Client Management Suite, visit http://www.altiris.com/Products/
ClientManagementSuite.aspx.

HP Client Catalog for Microsoft System Center & SMS Products

The HP Client Catalog enables IT professionals using Microsoft products to automate the deployment
of HP software updates (Softpags) to HP business PCs. The catalog file contains detailed platform
information on HP business desktops, notebooks and workstations. It can be used in conjunction with
the custom inventory and update features of Microsoft products to provide automated driver and patch
updates to managed HP client computers.

Microsoft products supported by the HP Client Catalog include:
e System Center Configuration Manager 2007

e System Center Essentials 2007

e Systems Management Server (SMS) 2003 R2

For more information on HP Client Catalog for SMS, visit http://h20331.www2.hp.com/Hpsub/cache/
486247-0-0-225-121.html.

HP Backup and Recovery Manager

The HP Backup and Recovery Manager is an easy-to-use, versatile application that allows you to back
up and recover the primary hard drive on the PC. The application works within Windows to create
backups of Windows, all applications, and all data files. Backups can be scheduled to occur
automatically at designated intervals, or they can be initiated manually. Important files can be archived
separately from regular backups.
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HP Backup and Recovery Manager is preinstalled on the C: drive and creates a Recovery Partition.

Recovery Points and file backups can be copied to CD or DVD discs, while all backups can be copied
to network or secondary hard disks.

HP highly recommends that you create a Recovery Disc Set immediately before using the computer
and schedule regular automatic Recovery Point backups.

To create the Recovery Disc Set:

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open the
Backup and Recovery Wizard, then click Next.

2. Select Create a set of recovery discs (Recommended) and click Next.
3. Follow the instructions in the wizard.

For more information on using HP Backup and Recovery Manager, refer to the HP Backup and Recovery
Manager User Guide by selecting Start > HP Backup and Recovery > HP Backup and Recovery
Manager Manual.

B NOTE: You can order a Recovery Disc Set from HP by calling the HP support center. Go to the
following Web site, select your region, and click the Technical support after you buy link under the
Call HP heading to obtain the support center telephone number for your region.

http://welcome.hp.com/country/us/en/wwcontact us.html

Management Technology

Models include either vPro technology or standard technology. Both allow for better discovery, healing,
and protection of networked computing assets. Both technologies allow PCs to be managed whether
the system is on, off, or the operating system is hung.

Management technology features include:
e Hardware inventory information
e Alerting
e Power management—power on/off, cycle power
e Remote diagnosis and repair
° Serial-over-LAN—allows console control of remote PC during its boot phase
o IDE-Redirect—allows system booting from a remote boot drive, disk, or ISO image

e Hardware-based isolation and recovery—Iimit or cut off PC network access, if virus-like activity is
detected

Ef NOTE: For an overview of Intel vPro technology, visit http://www.intel.com/vpro.

For HP-specific information on Intel vPro technology, see the white papers at http://www.hp.com/
support. Select your country and language, select See support and troubleshooting information,
enter the model number of the computer, and press Enter. In the Resources category, click Manuals
(guides, supplements, addendums, etc.). Under Quick jump to manuals by category, click White
papers.
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Available management technologies include the following:

e AMT (includes DASH 1.0)

e ASF

ASF and AMT may not be configured at the same time, but both are supported.
To configure Intel vPro systems for AMT or ASF:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. As soon as the computer is turned on, press the hot key, Cirl+P, before the computer boots to the
operating system.

Bf NOTE: If you do not press Ctrl+P at the appropriate time, you must restart the computer and
again press Ctrl+P before the computer boots to the operating system to access the utility.

This hot-key enters the Intel Management Engine BIOS Execution (MEBXx) setup utility. This utility allows
the user to configure various aspects of the management technology. Some of the configuration options
are listed below:

e Main Menu
o Intel ® ME Configuration
° Intel ® AMT Configuration
° Change Intel ® ME Password
o Exit
e Intel ® ME Platform Configuration
o Intel ® ME State Control (enable/disable)
o Intel ® ME Firmware Local Update (enable/disable)
° Intel ® ME Features Control
° Intel ® ME Power Control
e Intel ® AMT Configuration
° Host Name
o TCP/IP
o Provision Model (Enterprise, SMB)
o Setup and Configuration
° Un-Provision

o SOL/IDE-R (enable/disable)
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° Password Policy

o Secure Firmware Update (enable/disable)
o SetPRTC

° Idle Timeout

e Change Intel ® ME Password (HP highly recommends that this password be changed. The default
password is admin.)

In order to remotely manage AMT systems, the administrator must use a remote console that supports
AMT. Enterprise management consoles are available from suppliers such as HP, Altiris and Microsoft
SMS. In SMB mode, the client provides a Web browser interface. To access this feature, open a browser
from any other system on the network and enter http://host_name:16992 where host_name is

the name assigned to the system. Alternatively, the IP address may be used in place of the host name.

Verdiem Surveyor

Verdiem Surveyor is a software solution that helps manage PC energy costs. Surveyor measures and
reports how much energy each PC consumes. It also provides control over PC power settings enabling
administrators to easily implement energy saving strategies across their networks. An HP SoftPaq
containing the Surveyor agent may be downloaded from the HP Support site and installed on supported
commercial desktop models. Surveyor licenses for managing PCs may be purchased through your HP
representative.

HP Proactive Change Notification

The Proactive Change Notification program uses the Subscriber's Choice Web site in order to
proactively and automatically:

e Send you Proactive Change Notification (PCN) e-mail informing you of hardware and software
changes to most commercial computers and servers, up to 60 days in advance

e Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security
Bulletins, and Driver alerts for most commercial computers and servers

You create your own profile to ensure that you only receive the information relevant to a specific IT
environment. To learn more about the Proactive Change Notification program and create a custom
profile, visit http://h30046.www3.hp.com/subhub.php

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP.

Based on your profile, HP will supply you with personalized product tips, feature articles, and/or driver
and support alerts/notifications.

Subscriber’s Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you that the
information you subscribed to in your profile is available for review and retrieval. To learn more about
Subscriber’s Choice and create a custom profile, visit http://h30046.www3.hp.com/subhub.php.

Retired Solutions

Two software packages, Altiris Local Recovery, and Dantz Retrospect, will no longer be shipping on HP
business desktops, notebooks, or workstations. Starting with new business desktops, notebooks, and
workstations released in 2006, all will ship with HP Backup and Recovery Manager.
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ROM Flash

The computer's BIOS is stored in a programmable flash ROM (read only memory). By establishing a
setup password in the Computer Setup (F10) Utility, you can protect the ROM from being unintentionally
updated or overwritten. This is important to ensure the operating integrity of the computer. Should you
need or want to upgrade the BIOS, you may download the latest BIOS images from the HP driver and
support page, http://www.hp.com/support/files.

/A CAUTION: Formaximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to
set the setup password on one or more PCs simultaneously. For more information, visit
http://www.hp.com/go/ssm.

Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the BIOS on remote HP
computers directly from the centralized network management console. Enabling the system
administrator to perform this task remotely on multiple computers results in a consistent deployment of,
and greater control over, HP PC BIOS images over the network. It also results in greater productivity
and lower total cost of ownership.

Bf NOTE: SSM does not currently support remote ROM flash on systems that have Windows Vista
BitLocker enabled and are using TPM measurements to protect the BitLocker keys because flashing
the BIOS would invalidate the trust signature that BitLocker created for the platform. Disable BitLocker
via Group Policy in order to flash the system BIOS.

The computer must be powered on, or turned on through Remote Wakeup, to take advantage of Remote
ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or System
Software Manager at http://www.hp.com/go/ssm/.

HPQFlash

The HPQFlash utility is used to locally update or restore the system BIOS of individual PCs from a
Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the model number
of the computer when prompted.

Boot Block Emergency Recovery Mode

Boot Block Emergency Recovery Mode permits system recovery in the unlikely event of a ROM flash
failure. For example, if a power failure were to occur during a BIOS upgrade, the ROM flash would be
incomplete. This would render the system BIOS unusable. The Boot Block is a flash-protected section
of the ROM that contains code that checks for a valid system BIOS image when the system is turned
on.

e If the system BIOS image is valid, the system starts normally.

e Ifthe system BIOS image is not valid, a failsafe Boot Block BIOS provides enough support to search
removable media for BIOS image files. If an appropriate BIOS image file is found, it is automatically
flashed into the ROM.
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When an invalid system BIOS image is detected, the system power LED will blink red 8 times, one blink
every second. Simultaneously, the speaker will beep 8 times. If the portion of the system ROM containing
the video option ROM image is not corrupt, Boot Block Emergency Recovery Mode will be displayed
on the screen.

To recover the system after it enters Boot Block Emergency Recovery Mode, complete the following
steps:

1. Turn off the power.

2. Insert a CD or USB flash device containing the desired BIOS image file in the root directory.

B NOTE: The media must be formatted using the FAT12, FAT16, or FAT32 file system.

3. Turn on the computer.

If no appropriate BIOS image is found, you will be prompted to insert media containing a BIOS
image file.

If the system successfully reprograms the ROM, the system will automatically power off.
4. Remove the removable media used to upgrade the BIOS.

5.  Turn the power on to restart the computer.

Bf NOTE: BitLocker prevents Windows Vista from booting when a CD containing the BIOS image file is
in an optical drive. If BitLocker is enabled, remove this CD before attempting to boot to Windows Vista.

Replicating the Setup

The following procedures give an administrator the ability to easily copy one setup configuration to other
computers of the same model. This allows for faster, more consistent configuration of multiple
computers.

149,

¥ NOTE: Both procedures require a diskette drive or a supported USB flash drive.

Copying to Single Computer

/A CAUTION: A setup configuration is model-specific. File system corruption may result if source and
target computers are not the same model. For example, do not copy the setup configuration from a
dc7xxx PC to a dx7xxx PC.

1. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click Start >
Shut Down > Shut Down.

2. If you are using a USB flash media device, insert it now.
3. Turn on the computer.

4. Assoon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

5. If you are using a diskette, insert it now.
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10.

1.

Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB flash media device.

Turn off the computer to be configured and insert the configuration diskette or USB flash media
device.

Turn on the computer to be configured.

As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Click File > Replicated Setup > Restore from Removable Media, and follow the instructions on
the screen.

Restart the computer when the configuration is complete.

Copying to Multiple Computers

/A CAUTION: A setup configuration is model-specific. File system corruption may result if source and
target computers are not the same model. For example, do not copy the setup configuration from a
dc7xxx PC to a dx7xxx PC.

This method takes a little longer to prepare the configuration diskette or USB flash media device, but
copying the configuration to target computers is significantly faster.

NOTE: A bootable diskette is required for this procedure or to create a bootable USB flash media
device. If Windows XP is not available to use to create a bootable diskette, use the method for copying
to a single computer instead (see Copying to Single Computer on page 34).

1.

A

Create a bootable diskette or USB flash media device. See Supported USB Flash Media Device
on page 36 or Unsupported USB Flash Media Device on page 37.

CAUTION: Not all computers can be booted from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer
can be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

Select a setup configuration to copy. Turn off the computer. If you are in Windows, click Start >
Shut Down > Shut Down.

If you are using a USB flash media device, insert it now.
Turn on the computer.

As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F 10 before the computer boots to the operating system to access the utility.

If you are using a diskette, insert it now.

Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB flash media device.

Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette
or USB flash media device. To obtain this utility, go to http://welcome.hp.com/country/us/en/
support.html and enter the model number of the computer.
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10.

11.

On the configuration diskette or USB flash media device, create an autoexec.bat file containing the
following command:

repset.exe

Turn off the computer to be configured. Insert the configuration diskette or USB flash media device
and turn the computer on. The configuration utility will run automatically.

Restart the computer when the configuration is complete.

Creating a Bootable Device

Supported USB Flash Media Device

Supported devices have a preinstalled image to simplify the process of making them bootable. All HP
or Compaq and most other USB flash media devices have this preinstalled image. If the USB flash media
device being used does not have this image, use the procedure later in this section (see Unsupported
USB Flash Media Device on page 37).

To create a bootable USB flash media device, you must have:

a supported USB flash media device

a bootable DOS diskette with the FDISK and SYS programs (If SYS is not available, FORMAT may
be used, but all existing files on the USB flash media device will be lost.)

a PC that is bootable from a USB flash media device

/A CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can
be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1.
2.

Turn off the computer.

Insert the USB flash media device into one of the computer's USB ports and remove all other USB
storage devices except USB diskette drives.

Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM into a
diskette drive and turn on the computer to boot to the DOS diskette.

Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click Yes (Y) to
enable large disk support.

Enter Choice [5] to display the drives in the system. The USB flash media device will be the drive
that closely matches the size of one of the drives listed. It will usually be the last drive in the list.
Note the letter of the drive.

USB flash media device drive:

CAUTION: If a drive does not match the USB flash media device, do not proceed. Data loss can
occur. Check all USB ports for additional storage devices. If any are found, remove them, reboot
the computer, and proceed from step 4. If none are found, either the system does not support the
USB flash media device or the USB flash media device is defective. DO NOT proceed in attempting
to make the USB flash media device bootable.

Exit FDISK by pressing the Esc key to return to the A:\ prompt.
If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

36 Chapter 4 Desktop Management



1.
12.
13.

At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

CAUTION: Be sure that you have entered the correct drive letter for the USB flash media device.

After the system files have been transferred, SYS will return to the A:\ prompt. Go to step 13.

Copy any files you want to keep from your USB flash media device to a temporary directory on
another drive (for example, the system's internal hard drive).

. Atthe A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

CAUTION: Be sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more messages and ask you each time whether you want to proceed.
Enter Y each time. FORMAT will format the USB flash media device, add the system files, and ask
for a Volume Label.

Press Enter for no label or enter one if desired.
Copy any files you saved in step 9 back to your USB flash media device.

Remove the diskette and reboot the computer. The computer will boot to the USB flash media
device as drive C.

NOTE: The default boot order varies from computer to computer, and it can be changed in the
Computer Setup (F10) Utility.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the
USB flash media device.

Return to Copying to Multiple Computers on page 35.

Unsupported USB Flash Media Device

To create a bootable USB flash media device, you must have:

a USB flash media device

a bootable DOS diskette with the FDISK and SYS programs (If SYS is not available, FORMAT may
be used, but all existing files on the USB flash media device will be lost.)

a PC that is bootable from a USB flash media device

/A CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can
be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1.

A
2.
3.

4,

If there are any PCI cards in the system that have SCSI, ATA RAID or SATA drives attached, turn
off the computer and unplug the power cord.

CAUTION: The power cord MUST be unplugged.

Open the computer and remove the PCI cards.

Insert the USB flash media device into one of the computer's USB ports and remove all other USB
storage devices except USB diskette drives. Close the computer cover.

Plug in the power cord and turn on the computer.
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5. Assoon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

6. Go to Advanced > PCI Devices to disable both the PATA and SATA controllers. When disabling
the SATA controller, note the IRQ to which the controller is assigned. You will need to reassign the
IRQ later. Exit setup, confirming the changes.

SATA IRQ:

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM into a
diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new partition
and mark it active. Exit FDISK by pressing the Esc key.

9. Ifthe system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to reboot to the
DOS diskette.

10. Atthe A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash media
device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI cards
that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press F 10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Advanced > PCI Devices and re-enable the PATA and SATA controllers that were disabled
in step 6. Put the SATA controller on its original IRQ.

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

Bf NOTE: The default boot order varies from computer to computer, and it can be changed in the
Computer Setup (F10) Utility. Refer to the Computer Setup (F10) Utility for instructions.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the
USB flash media device.

Return to Copying to Multiple Computers on page 35.

Dual-State Power Button

With Advanced Configuration and Power Interface (ACPI) enabled, the power button can function either
as an on/off switch or as a standby button. The standby feature does not completely turn off power, but
instead causes the computer to enter a low-power standby state. This allows you to power down quickly
without closing applications and to return quickly to the same operational state without any data loss.
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To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Power Options.
2. Inthe Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Stand by.

After configuring the power button to function as a standby button, press the power button to put the
system in a very low power state (standby). Press the button again to quickly bring the system out of
standby to full power status. To completely turn off all power to the system, press and hold the power
button for four seconds.

/A CAUTION: Do not use the power button to turn off the computer unless the system is not responding;
turning off the power without operating system interaction could cause damage to or loss of data on the
hard drive.

HP Web Site Support

HP engineers rigorously test and debug software developed by HP and third-party suppliers, and
develop operating system specific support software, to ensure performance, compatibility, and reliability
for HP computers.

When making the transition to new or revised operating systems, it is important to implement the support
software designed for that operating system. If you plan to run a version of Microsoft Windows that is
different from the version included with the computer, you must install corresponding device drivers and
utilities to ensure that all features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software easier.
You can download the software from http://www.hp.com/support.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run the
latest Microsoft Windows operating system on the HP computer.

Industry Standards

HP management solutions integrate with other systems management applications, and are based on
industry standards, such as:

e Web-Based Enterprise Management (WBEM)
e  Windows Management Interface (WMI)

e Wake on LAN Technology

e ACPI

e SMBIOS

e Pre-boot Execution (PXE) support

Asset Tracking and Security

Asset tracking features incorporated into the computer provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager, HP Configuration Management
Solution, HP Client Configuration Manager, or other system management applications. Seamless,
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automatic integration between asset tracking features and these products enables you to choose the
management tool that is best suited to the environment and to leverage the investment in existing
tools.

HP also offers several solutions for controlling access to valuable components and information.

HP Embedded Security for ProtectTools, if installed, prevents unauthorized access to data and checks
system integrity and authenticates third-party users attempting system access. (For more information,
refer to the HP ProtectTools Security Manager Guide at http://www.hp.com/products/security.) Security
features such as HP Embedded Security for ProtectTools, the Smart Cover Sensor and the Smart Cover
Lock, available on some models, help to prevent unauthorized access to the internal components of the
personal computer. By disabling parallel, serial, or USB ports, or by disabling removable media boot
capability, you can protect valuable data assets. Memory Change and Smart Cover Sensor alerts can
be automatically forwarded to system management applications to deliver proactive notification of
tampering with a computer’s internal components.

B NOTE: HP Embedded Security for ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock
are available as options on some systems.

Use the following utilities to manage security settings on the HP computer:

e Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide included
with the computer for additional information and instructions on using the Computer Setup Utilities.
Some computers also have HP BIOS Configuration for ProtectTools, which is a Windows-based
component of ProtectTools that allows administrators to configure BIOS security settings from
within the running OS.

e Remotely, using HP Client Manager from Symantec, HP Client Automation, or System Software
Manager. This software enables the secure, consistent deployment and control of security settings.

The following table and sections refer to managing security features of the computer locally through the
Computer Setup (F10) Utilities.

Table 4-1 Security Features Overview

Option Description

Setup Password Allows you to set and enable setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable power-on password. The power-on password prompt appears after a
power cycle. If the user does not enter the correct power-on password, the unit will not boot.

NOTE: This password does not appear on warm boots , such as Ctrl+Alt+Delete or Restart from
Windows, unless enabled in Password Options (see below).

Password Options Allows you to:

(This selection appears e  Lock legacy resources (appears if a setup password is set)
only if a power-on
password or setup e Enable/disable network server mode (appears if a power-on password is set)

password is set.)
e  Specify whether the password is required for warm boot (Ctrl+Alt+Delete) (appears if a power-

on password is set)

e Enable/Disable Setup Browse Mode (appears if a setup password is set) (allows viewing, but
not changing, the F10 Setup Options without entering setup password)

e Enable/disable Stringent Password (appears if a power-on password is set), which when
enabled bypasses the onboard password jumper to disable the power-on password

40 Chapter 4 Desktop Management


http://www.hp.com/products/security

Table 4-1 Security Features Overview (continued)

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:

e  Lock/unlock the Cover Lock.

e Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if the

sensor detects that the cover has been removed.

This feature is supported on some models only.

Device Security

Allows you to set Device Available/Device Hidden for:
e  Serial ports

e Parallel port

e Rear USB ports

e  Front USB ports

e Internal USB ports

e  System audio

e  Network controllers (some models)

e Legacy diskette

e Embedded security device (some models)
e SATAO

e  SATAT1 (some models)

e SATA2 (some models)

e  SATA3 (some models)

e  eSATA (some models)

Network Service Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCl expansion
card or embedded on the system board.)

System IDs

Allows you to set:

e  Assettag (18-byte identifier), a property identification number assigned by the company to the
computer.

e  Ownership tag (80-byte identifier) displayed during POST.
e  Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in

the factory and are used to uniquely identify the system.)

e Keyboard locale setting (for example, English or German) for System ID entry.

DriveLock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.
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Table 4-1 Security Features Overview (continued)

System Security (some Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system

models: these options security breaches.

are hardware

dependent) Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed I/O (some models) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying processor
and chipset features needed to support a virtual appliance. Changing this setting requires turning
the computer off and then back on. To enable this feature you must enable the following features:

e Embedded Security Device Support
e  Virtualization Technology
e  Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the computer
off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

e Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

e  Power-on authentication support (some models) (enable/disable) - Controls the power-on
password authentication scheme that utilizes the Embedded Security Device. Changing this
setting requires turning the computer off and then back on.

e Resetauthentication credentials (some models) (Do not reset/Reset) - Selecting Reset disables
the power-on authentication support and clears the authentication information from the
Embedded Security Device. Changing this setting requires turning the computer off and then
back on

OS management of Embedded Security Device (some models) (enable/disable) - This option allows
the user to limit operating system control of the Embedded Security Device. Changing this setting
requires turning the computer off and then back on. This option allows the user to limit OS control
of the Embedded Security Device.

o Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of
the Embedded Security Device. Changing this setting requires turning the computer off and
then back on.

NOTE: To enable this option, a Setup password must be set.

Smart Card BIOS Password Support (some models) (enable/disable) - Allows the user to enable/
disable the Smart Card to be used in place of the Setup and Power-On Passwords. This setting
requires additional initialization within ProtectTools before this option will take effect.

PAVP (Some models) (disabled/min/max) - PAVP enables the Protected Audio Video Path in the
Chipset. This may allow viewing of some protected high definition content that would otherwise be
prohibited from playback. Selecting Max will assign 96 Megabytes of system memory exclusively to
PAVP.

Setup Security Level Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.
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Table 4-1 Security Features Overview (continued)

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The administrator
specifies access rights to individual setup options on a case-by-case basis via the Setup Security
Level menu. By default, all setup options are assigned Setup Password, indicating the user must
enter the correct Setup Password during POST to make changes to any of the options. The
administrator may set individual items to None, indicating the user can make changes to the specified
options when setup has been accessed with invalid passwords. The choice, None, is replaced by
Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.

Password Security

The power-on password prevents unauthorized use of the computer by requiring entry of a password
to access applications or data each time the computer is turned on or restarted. The setup password
specifically prevents unauthorized access to Computer Setup, and can also be used as an override to
the power-on password. That is, when prompted for the power-on password, entering the setup
password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password, even if one
has been established.

Establishing a Setup Password Using Computer Setup

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com. Establishing a setup password through Computer Setup prevents
reconfiguration of the computer (use of the Computer Setup (F10) utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F 10 before the computer boots to the operating system to access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Establishing a Power-On Password Using Computer Setup

Establishing a power-on password through Computer Setup prevents access to the computer when
power is turned on, unless the password is entered. When a power-on password is set, Computer Setup
presents Password Options under the Security menu. Password options include Password Prompt
on Warm Boot. When Password Prompt on Warm Boot is enabled, the password must also be
entered each time the computer is rebooted.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

B NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.
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3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Entering a Power-On Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

2.  When the key icon appears on the monitor, type the current password, then press Enter.

B NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

If a setup password has been established on the computer, you will be prompted to enter it each time
you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon asthe computeris turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. When the key icon appears on the monitor, type the setup password, then press Enter.

Bf NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must turn off the computer, then turn it on again before you can continue.

Changing a Power-On or Setup Password

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press F10 before the
computer boots to the operating system to enter Computer Setup. Press Enter to bypass the title
screen, if necessary.

Bf NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.
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3.

When the key icon appears, type the current password, a slash (/) or alternate delimiter character,
the new password, another slash (/) or alternate delimiter character, and the new password again
as shown: current password/new password/new password

B NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

4,

Press Enter.

The new password takes effect the next time you turn on the computer.

Bf NOTE: Refer to the National Keyboard Delimiter Characters on page 45 for information about the
alternate delimiter characters. The power-on password and setup password may also be changed using
the Security options in Computer Setup.

Deleting a Power-On or Setup Password

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

1.

Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press F10 before the
computer boots to the operating system to enter Computer Setup. Press Enter to bypass the title
screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

When the key icon appears, type the current password followed by a slash (/) or alternate delimiter
character as shown: current password/

Press Enter.

NOTE: Referto National Keyboard Delimiter Characters on page 45 for information about the
alternate delimiter characters. The power-on password and setup password may also be changed
using the Security options in Computer Setup.

National Keyboard Delimiter Characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use to
change or delete the password depend on the keyboard that came with the computer.

National Keyboard Delimiter Characters

/ Arabic - Greek /" Russian

= Belgian . Hebrew - Slovakian

- BHCMSS* - Hungarian - Spanish

/ Brazilian - Italian / Swedish/Finnish
/ Chinese / Japanese - Swiss

- Czech / Korean | Taiwanese

- Danish - Latin American [/ Thai
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National Keyboard Delimiter Characters

! French - Norwegian . Turkish
é  French Canadian - Polish / U.S. English
- German - Portuguese

* For Bosnia-Herzegovina, Croatia, Montenegro, Serbia, and Slovenia

Clearing Passwords

If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide for
instructions on clearing passwords.

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

DriveLock

DriveLock is an industry-standard security feature that prevents unauthorized access to the data on ATA
hard. DriveLock has been implemented as an extension to Computer Setup. It is only available when
hard drives that support the ATA Security command set are detected. DrivelLock is intended for HP
customers for whom data security is the paramount concern. For such customers, the cost of the hard
drive and the loss of the data stored on it is inconsequential when compared with the damage that could
result from unauthorized access to its contents. In order to balance this level of security with the practical
need to accommodate a forgotten password, the HP implementation of DriveLock employs a two-
password security scheme. One password is intended to be set and used by a system administrator
while the other is typically set and used by the end-user. There is no “back-door” that can be used to
unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used when the data
contained on the hard drive is replicated on a corporate information system or is regularly backed up.
In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For users who
do not fit the previously defined customer profile, this may be an unacceptable risk. For users who do
fit the customer profile, it may be a tolerable risk given the nature of the data stored on the hard drive.

Using DriveLock

When one or more hard drives that support the ATA Security command set are detected, the DriveLock
option appears under the Security menu in Computer Setup. The user is presented with options to set
the master password or to enable DriveLock. A user password must be provided in order to enable
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator,
a master password should be set first. HP encourages system administrators to set a master password
whether they plan to enable DriveLock or keep it disabled. This will give the administrator the ability to
modify DriveLock settings if the drive is locked in the future. Once the master password is set, the system
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST will not prompt the user to re-enter
the password. Otherwise, the user will be prompted to enter a DriveLock password. On a cold boot,
either the master or the user password may be used. On a warm boot, enter the same password used
to unlock the drive during the preceding cold-boot. Users will have two attempts to enter a correct
password. On a cold boot, if neither attempt succeeds, POST will continue but the drive will remain
inaccessible. On a warm boot or restart from Windows, if neither attempt succeeds, POST will halt and
the user will be instructed to cycle power.
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DriveLock Applications

The most practical use of the DriveLock security feature is in a corporate environment. The system
administrator would be responsible for configuring the hard drive which would involve, among other
things, setting the DriveLock master password and a temporary user password. In the event that the
user forgets the user password or the equipment is passed on to another employee, the master
password can always be used to reset the user password and regain access to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also establish
a corporate policy for setting and maintaining master passwords. This should be done to prevent a
situation where an employee intentionally or unintentionally sets both DriveLock passwords before
leaving the company. In such a scenario, the hard drive would be rendered unusable and require
replacement. Likewise, by not setting a master password, system administrators may find themselves
locked out of a hard drive and unable to perform routine checks for unauthorized software, other asset
control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock has been designed to protect. Access
to Computer Setup and DriveLock can be restricted through the Setup password. By specifying a Setup
password and not giving it to end users, system administrators are able to restrict users from enabling
DriveLock.

Smart Cover Sensor

Cover Removal Sensor, available on some models, is a combination of hardware and software
technology that can alert you when the computer cover or side panel has been removed. There are
three levels of protection, as described in the following table.

Table 4-2 Smart Cover Sensor Protection Levels

Level Setting Description
Level 0 Disabled Smart Cover Sensor is disabled (default).
Level 1 Notify User When the computer is restarted, the screen displays a message

indicating that the computer cover or side panel has been removed.

Level 2 Setup Password When the computer is restarted, the screen displays a message
indicating that the computer cover or side panel has been removed. You
must enter the setup password to continue.

NOTE: These settings can be changed using Computer Setup. For more information about Computer Setup,
see the Computer Setup (F10) Utility Guide.

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

B NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.
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3. Select Security > Smart Cover > Cover Removal Sensor, and select the desired security level.

4. Before exiting, click File > Save Changes and Exit.

Smart Cover Lock

The Smart Cover Lock is a software-controllable cover lock featured on some HP computers. This lock
prevents unauthorized access to the internal components. Computers ship with the Smart Cover Lock
in the unlocked position.

/A CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup utility.

Bf NOTE: The Smart Cover Lock is available as an option on some systems.

Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon asthe computeris turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security > Smart Cover > Cover Lock > Lock option.

4. Before exiting, click File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. Assoon asthe computeris turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security > Smart Cover > Cover Lock > Unlock.

4. Before exiting, click File > Save Changes and Exit.

Using the Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter the password to disable the lock, you will need a
Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the following
circumstances:

e Power outage
e  Startup failure
e PC component failure (such as processor or power supply)

e  Forgotten password
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/A CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order
this key before you need one at an authorized reseller or service provider.

To obtain the FailSafe Key, do any one of the following:
e Contact an authorized HP reseller or service provider.
e  Call the appropriate number listed in the warranty.

For more information about using the Smart Cover FailSafe Key, consult the Hardware Reference
Guide.

Cable Lock Provision

The rear panel of the computer (some models) accommodates a cable lock so that the computer can
be physically secured to a work area.

For illustrated instructions, please see the Hardware Reference Guide.

Fingerprint Identification Technology

Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens network
security, simplifies the login process, and reduces the costs associated with managing corporate
networks. Affordably priced, it is not just for high-tech, high-security organizations anymore.

Bf NOTE: Support for Fingerprint Identification Technology varies by model.

Fault Notification and Recovery

Fault Notification and Recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a fault
notice to the network management application. With HP Client Manager Software, you can also remotely
schedule diagnostics to automatically run on all managed PCs and create a summary report of failed
tests.

Drive Protection System

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some HP
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When HP computers are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. The service provider can use this information to help diagnose conditions that caused you to run
the DPS software. Refer to the Troubleshooting Guide for instructions on using DPS.

Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the computer is hit with an
unpredictable power surge. This power supply is rated to withstand a power surge of up to 2000 volts
without incurring any system downtime or data loss.
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Thermal Sensor

The thermal sensor is a hardware and software feature that tracks the internal temperature of the
computer. This feature displays a caution message when the normal range is exceeded, which gives
you time to take action before internal components are damaged or data is lost.

/A CAUTION: A high temperature condition can result in damage to the system or data loss.
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5 Serial and Parallel ATA Drive Guidelines
and Features

Ef NOTE: Serial ATA = SATA
Parallel ATA = PATA

SATA Hard Drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 77

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 33V,5V, 12V
Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA connectors on the system board are color coded to make identification easier.

SATA Identification Color Port Attachment Sequence
Primary channel, device 0 Dark blue SATAO 1
Primary channel, device 1 Light Blue SATA 4 4
Secondary channel, device 0 White SATA 1 2
Secondary channel, device 1 Orange SATA 5 3

B NOTE: If there is an error on the application of the attach rules, a POST error message may be
displayed.

SATA Hard Drives 51



SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5
Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As shown
in the table, each cable has 3 grounds, and 4 transmit/receive pins.

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2 A+ Transmit data Receive data
P3 A- Transmit data Receive data
P4 Ground Ground Ground

P5 B- Receive data Transmit data
P6 B+ Receive data Transmit data
P7 Ground Ground Ground

P2 and P3 differential signal pair

P5 and P6 differential signal pair

SATA Power Cable

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5V power
P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V12 12 V power
P6 Ground P14 V12 12 V power
P7 V5 5V power P15 V12 12 V power
P8 V5 5V power
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PATA Device Information

The USDT model is the only product that supports a PATA optical drive. No PATA drives are supported
on any other model.

ATA SMART Drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may be
properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the operating
system may differ from that marked on the hard drive or listed in the computer specification. Drive size
calculations by drive manufacturers are bytes to the base 10 while calculations by Microsoft are bytes
to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File System Controller Type Operating System Partition Drive
FAT 32 ATA Windows 2000/XP/Vista 32GB 27TB
NTFS ATA Windows 2000/XP/Vista 27TB 27TB
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6 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the
system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

Chassis Designations

Convertible Minitower (CMT)

Figure 6-1 Convertible Minitower chassis
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Small Form Factor (SFF)

Figure 6-2 Small Form Factor chassis

Ultra-Slim Desktop (USDT)
Figure 6-3 Ultra-Slim Desktop chassis
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Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

Different activities generate different amounts of static electricity.

Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000 V
Removing DIPs from plastic tube 400 V 700 V 2,000V
Removing DIPs from vinyl tray 2,000V 4,000 V 11,500 V
Removing DIPs from Styrofoam 3,500V 5,000V 14,500 V
Removing bubble pack from PCB 7,000V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

B NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.
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To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.
Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.
Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

Place items on a grounded surface before removing them from their container.

Always be properly grounded when touching a sensitive component or assembly.
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Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm * 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.
Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape
Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids
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Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating Guidelines

To prevent overheating and to help prolong the life of the computer:
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Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.
Never cover the ventilation slots on the monitor with any type of material.

Install or enable power management functions of the operating system or other software, including
sleep states.
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Routine Care

General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Neverimmerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then
use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.

3
4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 59 before cleaning the
computer.

To clean the computer case, follow the procedures described below:
e Toremove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a
cloth or swab dampened with clear water.

e For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

e After cleaning, always wipe the unit with a clean, lint-free cloth.

e  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 59 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 59.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 59 before following these procedures:

/A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.
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e If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

/A CAUTION: Neverremove a wide leveled key (like the space bar) from the keyboard. If these keys
are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 59.

Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

e Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 59.

Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

/A CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off’ modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements
To service the computer, you need the following:
e  Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)
e  Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
e Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

e  Phillips #2 screwdriver
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Screws

Diagnostics software

HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

/A CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal
from the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or
twisting the cables, and ensure that the cables are routed in such a way that they cannot be caught or
snagged by parts being removed or replaced.

/A CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer
to Electrostatic Discharge Information on page 56

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.
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Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.

/A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

Ef NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP, their authorized partners, or their agents.
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Removal and Replacement Procedures

Convertible Minitower (CMT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Identifying the Chassis, Routine Care, and Disassembly Preparation on page 54 for initial safety
procedures.

1.
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Remove/disengage any security devices that prohibit opening the computer (External Security
Devices on page 66).

Close any open software applications.
Exit the operating system.
Remove any diskette, compact disc, or media card from the computer.

Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the

system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

Disconnect the power cord from the electrical outlet and then from the computer.
Disconnect all peripheral device cables from the computer.

As applicable, lay the computer down on its side to achieve a safe working position.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

/A CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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Unlocking the Smart Cover Lock

Bf NOTE: The Smart Cover Lock is an optional feature included on some models only.

The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This lock
prevents unauthorized access to the internal components. The computer ships with the Smart Cover
Lock in the unlocked position. For more information about locking the Smart Cover Lock, refer to the
Desktop Management Guide.

Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:

e Power outage
e  Startup failure
e PC component (for example, processor or power supply) failure

e  Forgotten password

Ef NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order this
key before you need it.

To obtain a FailSafe Key:

e Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-style
key or PN 166527-002 for the screwdriver bit key.

e Refer to the HP Web site (http://www.hp.com) for ordering information.

e  Call the appropriate number listed in the warranty or in the Support Telephone Numbers guide.

Using the Smart Cover FailSafe Key to Remove the Smart Cover Lock
To open the access panel with the Smart Cover Lock engaged:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).
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2. Use the Smart Cover FailSafe Key to remove the two tamper-proof screws that secure the Smart
Cover Lock to the chassis.

Figure 7-1 Removing the Smart Cover Lock Screws

You can now remove the access panel. See Computer Access Panel on page 70.

To reattach the Smart Cover Lock, secure the lock in place with the tamper-proof screws.
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External Security Devices

The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

Installing a Security Lock

The security locks displayed below and on the following page can be used to secure the computer.

Cable Lock
Figure 7-2 Installing a Cable Lock
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Padlock
Figure 7-3 Installing a Padlock
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HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 7-4 Securing the Cable to a Fixed Object

2. Thread the keyboard and mouse cables through the lock.

Figure 7-5 Threading the Keyboard and Mouse Cables
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3.  Screw the lock to the chassis using the screw provided.

Figure 7-6 Attaching the Lock to the Chassis

4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 7-7 Engaging the Lock
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Computer Access Panel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63)

2. Lift up on the access panel handle (1), slide the access panel back about 1.25 cm (1/2 inch), then
lift it up and off the unit (2).

Figure 7-8 Removing the Computer Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Push up on the two release tabs (1), then rotate the front bezel away from the chassis to release
it (2).

Figure 7-9 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the front bezel (Front Bezel on page 71).

P owoN

Gently pull the subpanel, with the bezel blanks secured in it, away from the front bezel, then remove
the desired bezel blank.

/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel
away at an angle could damage the pins that align it within the front bezel.

Figure 7-10 Removing Bezel Blanks from the Subpanel (Desktop Shown)

Bf NOTE: When replacing the subpanel, ensure that the aligning pins and any remaining bezel blanks
are in their proper orientation. The logo on the subpanel should be located at the bottom of the subpanel
when properly oriented.
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Cable Management

Always follow good cable management practices when working inside the computer.

Keep cables away from major heat sources like the heatsink.

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

Some flat ribbon cables come prefolded. Never change the folds on these cables.
Do not bend any cable sharply. A sharp bend can break the internal wires.

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system board,
always follow these steps:

1.
2,

Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

Grasp the cable end of the connector and pull it straight up (2).

/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could

damage the cable and result in a failed power supply.

Figure 7-11 Removing a power supply cable from the connector
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

System Board Connections

System Board Connector

Connector Name

Connector Color

Description

P1 PWR White Power supply, 24-pin

P3 PWRCPU White Power supply, 4-pin

P10 FLOPPY Black Diskette drive

P9 CHFAN White Front chassis fan

P11 CH FAN2 Brown Rear chassis fan

P5 PB/LED Black Front power button/LED

P24 FRONT USB Yellow Front I/O USB cable

P23 FRONT AUD Black Front I/O audio

P6 SPRK White Internal speaker

P52 COMB Black Serial port

P124 HLCK Black Hood lock solenoid

P125 HSENSE White Hood sensor

P150 MEDIA Black Media card reader

P126 PAR Black Flying parallel port header

P151 BOOST Black ReadyBoost module
Power Supply Cable Connections

Power Supply Connector ID Description

P1 Main power

P3 CPU power

P4 1st Hard drive, SATAO

P5 2nd HDD

P9 1st ODD or 2nd HDD if no ODD present, SATA1

P10 2nd ODD

P11 3rd ODD
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Installing Additional Memory

The computer comes with double data rate 2 synchronous dynamic random access memory (DDR2-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a high-
performing dual channel mode.

DDR2-SDRAM DIMMs
For proper system operation, the DDR2-SDRAM DIMMs must be:
e industry-standard 240-pin
e unbuffered PC2-6400 800 MHz-compliant
e 1.8 volt DDR2-SDRAM DIMMs
The DDR2-SDRAM DIMMs must also:

e support CAS latency 5 DDR2 800 Mhz (5-5-5 timing) and CAS latency 6 DDR2 800 Mhz (6-6-6
timing)

e contain the mandatory JEDEC SPD information

In addition, the computer supports:

e 512-Mbit and 1-Gbit non-ECC memory technologies
e single-sided and double-sided DIMMs

e DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

Bf NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMMS3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory channel
A. Sockets DIMM3 and DIMM4 operate in memory channel B.

Figure 7-12 DIMM Socket Locations

Table 7-1 DIMM Socket Locations

Item Description Socket Color
1 DIMM1 socket, Channel A Black
2 DIMM2 socket, Channel A White
3 DIMM3 socket, Channel B White
4 DIMM4 socket, Channel B White

NOTE: ADIMM mustoccupy the black DIMM1 socket. Otherwise, the system
will display a POST error message indicating that a memory module must be
installed in the black socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 512-MB DIMMs and Channel B is populated with one 1-GB DIMM, the system
will operate in dual channel mode.

The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not
equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
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and the remainder is assigned to single channel. For optimal speed, the channels should be
balanced so that the largest amount of memory is spread between the two channels. If one channel
will have more memory than the other, the larger amount should be assigned to Channel A. For
example, if you are populating the sockets with one 1-GB DIMM, and three 512-MB DIMMs,
Channel A should be populated with the 1-GB DIMM and one 512-MB DIMM, and Channel B should
be populated with the two 512-MB DIMMs. With this configuration, 2-GB will run as dual channel
and 512-MB will run as single channel.

e Inany mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

/A CAUTION: You must disconnect the power cord before adding or removing memory modules.
Regardless of the power-on state, voltage is always supplied to the memory modules as long as the
computer is plugged into an active AC outlet. Adding or removing memory modules while voltage is
present may cause irreparable damage to the memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Locate the memory module sockets on the system board.

/A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 7-13 Installing a DIMM
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=’ NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

A DIMM must occupy the black DIMM1 socket.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

Repeat steps 4 and 5 to install any additional modules.
Replace the computer access panel.

Reconnect the power cord and turn on the computer.

© ® N @

Lock any security devices that were disengaged when the computer access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Cards

The computer has three standard full-height PCI expansion slots, one PCI Express x1 expansion slot,
one PCI Express x16 expansion slot, and one PCI Express x16 expansion slot that is downshifted to a
x4 slot.

Figure 7-14 Expansion Slot Locations

Table 7-2 Expansion Slot Locations

Item

Description

1

PCI Express x16 expansion slot

2

PCI Express x16 expansion slot that is
downshifted to a x4 slot

PCI Express x1 expansion slot

PCI expansion slot

PCI expansion slot

PCI expansion slot

Bf NOTE: You can install a PCl Express x1, x8, or x16 expansion card in the PCI Express x16 slots.

For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16
slot that is NOT downshifted to a x4 slot.

To remove, replace, or add an expansion card:

1.
2,

Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.
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4. Press straight down on the two green thumb tabs inside the chassis (1) and rotate the expansion
card retention latch up (2).

Figure 7-15 Opening the Expansion Slot Retainer

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

Bf NOTE: Before removing an installed expansion card, disconnect any cables that may be attached
to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Lift the expansion slot cover from the expansion slot.

Figure 7-16 Removing an Expansion Slot Cover

tL
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b. If you are removing a standard PCI card, hold the card at each end and carefully rock it back
and forth until the connectors pull free from the socket. Lift the card straight up to remove it.
Be sure not to scrape the card against other components.

Figure 7-17 Removing a Standard PCI Expansion Card

i

c. Ifyouareremoving a PCl Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull
free from the socket. Lift the card straight up to remove it. Be sure not to scrape the card
against other components.

Figure 7-18 Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.
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7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/A CAUTION: After removing an expansion card, you must replace it with a new card or expansion
slot cover for proper cooling of internal components during operation.

8. Toinstall a new expansion card, slide the bracket on the end of the card down into the slot on the
back of the chassis and press the card down firmly into the socket on the system board.

Figure 7-19 Installing an Expansion Card

/7

Bf NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.

9. Close the expansion card retention latch, making sure that it snaps firmly into place.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.
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Drives

The computer supports up to five drives that may be installed in various configurations.

When installing additional drives, follow these guidelines:

The primary Serial ATA (SATA) hard drive must be connected to the dark blue SATA connector
on the system board labeled SATAOQ.

Connect the first SATA optical drive to the white SATA connector on the system board labeled
SATA1.

Connect additional SATA drives to the next available (unpopulated) SATA connector on the system
board in the following order: SATAO, SATA1, SATA2, SATAS.

Always populate the dark blue SATAO and white SATA1 connectors before the light blue SATA2
and orange SATAS3 connectors.

Connect an optional external eSATA drive to the black ESATA connector on the system board.
Connect a diskette drive to the connector labeled FLOPPY.

Connect a media card reader USB cable to the USB connector on the system board labeled MEDIA.
If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.
You may install either a third-height or a half-height drive into a half-height bay.

You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws installed on the chassis. The hard drive uses 6-32
isolation mounting guide screws, four of which are installed on the hard drive bracket under the

access panel. All other drives use M3 metric screws, eight of which are installed on the diskette
drive bracket under the access panel. The HP-supplied metric guide screws are black. The HP-
supplied 6-32 isolation mounting guide screws are silver and blue.

Figure 7-20 Extra Hard Drive Isolation Mounting Guide Screws Location
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Figure 7-21 Extra Optical Drive M3 Guide Screws Location

/A CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer,
and unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label
the package “Fragile: Handle With Care.”
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System Board Drive Connections

Refer to the following illustration and table to identify the system board drive connectors.

Figure 7-22 System Board Drive Connections

Table 7-3 System Board Drive Connections

No. System Board Connector System Board Label Color

1 SATAO SATAO dark blue
2 SATA1 SATA1 white

3 SATA2 SATA2 light blue
4 SATA3 SATA3 orange

5 eSATA ESATA black

6 Media Card Reader MEDIA black

7 Diskette Drive FLOPPY black
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Drive Positions

Figure 7-23 Desktop and Minitower Drive Positions

Table 7-4 Drive Positions

1 Three 5.25-inch external drive bays for optional drives (optical drives
shown)'

2 One 3.5-inch external drive bay for optional drives (diskette drive shown)?

3 Two 3.5-inch internal hard drive bays

1 An optional media card reader and an optional hard drive mounting bracket for these drive bays are available from HP. The
bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom bay supports a half-height drive or other
device that is no more than 14.5 cm (5.7 inches) in depth. Do not try to force a larger drive, such as an optical drive, into the
bottom bay. This could cause damage to the drive and the system board. The use of unnecessary force when installing any
drive into the drive bay may result in damage to the drive.

2 Depending on the computer configuration, you may have a bezel blank in this position. If you do not have a drive in this slot,
you may choose to install a 3.5-inch drive (such as a diskette drive, hard drive, or media card reader) later on.

To verify the type and size of the storage devices installed in the computer, run Computer Setup. Refer
to the Computer Setup (F10) Utility Guide for more information.
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Removing a Drive from a Drive Bay

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Disconnect the drive cables, as indicated in the following illustrations:

/A CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid
damaging the cable.

e If you are removing an optical drive, disconnect the power cable (1) and data cable (2) from
the back of the drive.

Figure 7-24 Disconnecting the Optical Drive Cables

e If you are removing a diskette drive, disconnect the data cable (1) and power cable (2) from
the back of the drive.

Figure 7-25 Disconnecting the Diskette Drive Cables
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e If you are removing a media card reader, disconnect the USB cable from the system board.
If the media card reader has a 1394 port, disconnect the 1394 cable from the PCI card.

Figure 7-26 Disconnecting the Media Card Reader USB Cable
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4. Remove the drive from the drive bay as follows:

e Toremove a 5.25-inch drive in the desktop configuration, press down on the yellow drivelock
mechanism (1) and slide the drive from the drive bay (2).

/A CAUTION: When the yellow drivelock is pressed, all the external 5.25-inch drives are
released so do not tilt the unit and allow the drives to fall out.

Figure 7-28 Removing a 5.25-inch Drive in the Desktop Configuration (Optical Drive shown)

e Toremove a 3.5-inch drive or a 5.25-inch drive in the minitower configuration, pull up on the
green drivelock mechanism (1) for that specific drive and slide the drive from the drive bay

(2).

Figure 7-29 Removing a 3.5-inch Drive or a 5.25-inch Drive in the Minitower Configuration
(Optical Drive shown)
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e Toremove a hard drive from and internal 3.5-inch drive bay, pull up on the green hard drive
drivelock mechanism (1) for that drive and slide the drive from the drive bay (2).

Figure 7-30 Removing a Hard Drive
o =

5. Store the removed drive in anti-static packaging.
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Installing a 5.25-inch or 3.5-inch Drive into an External Drive Bay

Bf NOTE: A 3.5-inch drive may be a diskette drive or a media card reader. A 5.25-inch drive may be an
optical drive or a media card reader with a 5.25-inch adapter kit attached.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Ifyou are installing a drive in a bay covered by a bezel blank, remove the front bezel then remove
the bezel blank. See Bezel Blanks on page 72 for more information.

4. Install two guide screws in the lower holes on each side of the drive (1).

Bf NOTE: Optical drives, diskette drives, and media card readers use M3 metric guide screws. Eight
extra metric guide screws are provided on the diskette drive bracket under the access panel. The
HP-supplied metric screws are black. Refer to Drives on page 83 for an illustration of the extra M3
metric guide screws location.

If you are replacing a drive, transfer the guides screws from the old drive to the new one.

Figure 7-31 Installing a 5.25-Inch Drive in a Minitower (top) and Desktop (bottom)

5. Install the drive in the desired drive bay by sliding it all the way into the front of the drive cage until
it locks (2). The drivelock automatically secures the drive in the bay.

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This could
cause damage to the drive and the system board. The use of unnecessary force when installing
any drive into the drive bay may result in damage to the drive.
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NOTE: If you are installing a third optional drive, you may need to remove the strap that bundles
the extra power connectors.

Connect the power cable (1) and data cable (2) to the rear of the optical drive or diskette drive.

Figure 7-32 Connecting the Drive Cables (Optical Drive shown)

If you are installing a new drive, connect the opposite end of the data cable to the appropriate
system board connector.

NOTE: |Ifyou are installing a SATA optical drive, connect the first optical drive to the white SATA
connector on the system board labeled SATA1. Connect a second optical drive to the next available
(unpopulated) SATA connector following the numbered sequence of the connectors.

If you are installing a diskette drive, connect it to the connector on the system board labeled
FLOPPY.

If your are installing a media card reader, connect the USB cable to the USB system board
connector labeled MEDIA. If the media card reader includes a 1394 port, connect the 1394 cable
to the 1394 PCI card.

Refer to System Board Drive Connections on page 85 for an illustration of the system board drive
connectors.

Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.
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Installing a 3.5-inch SATA Hard Drive into an Internal Drive Bay

Bf NOTE: The system does not support Parallel ATA (PATA) hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive, make sure
you have created a Recovery Disc Set to restore the operating system, software drivers, and any
software applications that were preinstalled on the computer. If you do not have this CD set, select
Start > HP Backup and Recovery and create it now.

To install a hard drive in a 3.5-inch internal drive bay:

1.

2
3.
4

Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the computer access panel.
Install four 6-32 isolation mounting guide screws, two on each side of the drive.

Figure 7-33 Installing the Hard Drive Guide Screws

NOTE: The hard drive uses 6-32 isolation mounting guide screws. Four extra guide screws are
installed on the hard drive bracket under the access panel. The HP-supplied isolation mounting
guide screws are silver and blue. Refer to Drives on page 83 for an illustration of the extra 6-32
isolation mounting guide screws location.

If you are replacing a drive, transfer the guides screws from the old drive to the new one.
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5. Slide the hard drive down into the drive cage until it locks. The drivelock automatically secures the
drive in the bay.

Figure 7-34 Installing a Hard Drive into the Hard Drive Bay
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/A CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use of
unnecessary force when installing any drive into the drive bay may result in damage to the drive.

6. Connect the power cable (1) and data cable (2) to the rear of the hard drive.

Figure 7-35 Connecting the Power Cable and Data Cable to a SATA Hard Drive

7. Connect the opposite end of the data cable to the appropriate system board connector.

B NOTE: If your system has only one SATA hard drive, you must connect the hard drive data cable
to the dark blue connector labeled SATAOQ to avoid any hard drive performance problems. If you
are adding a second hard drive, connect the data cable to the next available (unpopulated) SATA
connector on the system board in the following order: SATAO, SATA1, SATA2, SATA3.

8. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.
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Removing and Replacing a Removable 3.5-inch SATA Hard Drive

Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

Bf NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers, and
any software applications that were preinstalled on the computer. If you do not have this CD set,
select Start > HP Backup and Recovery and create it now.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.
2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 7-36 Removing the Carrier Cover
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3.  Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 7-37 Removing the Thermal Sensor

4. Remove the four screws from the bottom of the hard drive carrier.

Figure 7-38 Removing the Security Screws
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5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 7-39 Removing the Hard Drive

Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all the

way into the connector on the carrier's circuit board.

Figure 7-40 Replacing the Hard Drive
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7. Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 7-41 Replacing the Security Screws

8. Place the thermal sensor on top of the hard drive in a position that does not cover the label (1) and
attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 7-42 Replacing the Thermal Sensor
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9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the cover
in place (2).

Figure 7-43 Replacing the Carrier Cover

=

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

B NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Front I/O, USB, Power Switch Assembly

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the front bezel (Front Bezel on page 71).

Disconnect the three cables (front USB, power button LED, and front audio) from the system board.
Remove the audio cable from the clip on top of the fan shroud.

Remove the screw that secures the assembly to the front of the chassis (1).

N o a 0 8 Db

Push the assembly (2) into the unit, rotating the bottom inward first so the tabs at the top clear the
slot in the front of the chassis.

Figure 7-44 Removing the front I/O, USB, power switch assembly

8. Lift the assembly up and out of the chassis while pulling the three cables through the holes on the
inside chassis wall, and then remove the assembly from the computer.

To reinstall the assembly, reverse the removal procedure.
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Speaker

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Disconnect the speaker wire from the system board, and remove the wire from the clip on top of
the fan shroud.

4. Remove the two screws (1) that secure the speaker to the chassis.

5. Lift the speaker up and out of the chassis (2).

Figure 7-45 Removing the speaker

To install the speaker, reverse the removal procedures.
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Rear Chassis Fan

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Disconnect the fan control cable from the system board.

Press down on the two upper tabs to loosen the fan housing from the chassis.

o & 0 b

Rotate the fan forward, and then lift it up and out of the chassis.

ng the rear chassis fan

Figure 7-46 Removi

To install the fan assembly, insert the bottom tabs into the slots in the chassis, and then rotate the fan
upward until the top tabs snap into place. Be sure to orient the air flow out of the unit.
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eSATA port assembly

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

2

3. Remove the two screws that secure the port to the chassis.
4. Disconnect the cable from the system board

5. Remove the port assembly from the chassis.

Figure 7-47 Removing the eSATA port

To install the eSATA port, reverse the removal procedure.
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Heatsink

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

3. Unscrew the four captive screws that secure the heatsink to the system board.

/A CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

4. Lift the heatsink from the processor.

Figure 7-48 Removing the heatsink
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When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/\ CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heatsink on the processor. Failure to do so could result in damage that requires replacing
the system board.
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Fan Shroud

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the heatsink (Heatsink on page 104).
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Pull up on all four shroud tabs simultaneously and slide the shroud from the heatsink.

To reinstall the fan shroud, reverse the removal procedure.
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Processor
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Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the heatsink (Heatsink on page 104).

Rotate the locking lever to its full open position (1).
Raise and rotate the microprocessor retainer to its fully open position (2).

Carefully lift the processor from the socket (3)).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heatsink must be installed within 24 hours of installing the processor to prevent damage to the
processor’s solder connections.

Figure 7-50 Removing the processor

To install a new processor:

1.
2,

Place the processor in its socket and close the retainer.
Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.

If reusing the existing heatsink, apply the thermal grease provided in the spares kit to the top of
the processor.

Clean the bottom of the heatsink with the provided alcohol pad and place it atop the processor.
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5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and place
it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the 4 captive screws and
attach the heatsink control cable to the system board.

/A CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heatsink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

Bf NOTE: Afterinstalling a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Front Chassis Fan

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the heatsink (Heatsink on page 104).

2

3

4. Disconnect the fan control cable from the system board.
5. Push down on the tab at the top of the fan (1).

6. Pull up on the fan (2), and then pull it toward the system board to remove it from the chassis.

Figure 7-51 Removing the front chassis fan
plpu— -

To install the fan assembly, insert the fan tabs into the slots in the inner chassis wall and slide the fan
down until it clicks into place. Be sure to orient the air flow out of the unit. Refer to the air flow arrows
on the side of the fan housing for proper air flow orientation.
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Power Supply

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

2
3. Disconnect all power cables from the mass storage devices and from the system board.
4. Remove the four screws that connect the power supply to the chassis.

Figure 7-52 Removing the power supply, screw locations
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5. Press the tab in front of the power supply that holds it in place.

Figure 7-53 Removing the power supply, release lever

6. Slide the power supply toward the front of the computer, rotate toward the fan so the power supply
clears the lip on the top of the chassis, and then lift the power supply out of the chassis.

To install the power supply, reverse the removal procedure.
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System Board

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2.  When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

e  Memory modules
e Expansion boards
e  Processor

Remove the computer access panel (Computer Access Panel on page 70).

Remove all expansion boards (Expansion Cards on page 79).

Disconnect all cables connected to the system board, noting their location for reinstallation.

Remove the heatsink (Heatsink on page 104).

Remove the 10 screws that secure the system board to the chassis.
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Slide the system board toward the front of the computer so that the connectors loosen from the
rear of the chassis.

9. Lift the system board out of the computer.

Figure 7-54 Removing the system board
I

Bf NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.
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Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally installed
on the computer. The computer comes with a 3-volt lithium coin cell battery.

Ef NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

/A WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup
(F10) Utility Guide for information on backing up the CMOS settings.

Bf NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

/\ CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

2. Remove the computer access panel (Computer Access Panel on page 70).

Bf NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following instructions
to replace the battery:
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Type 1 Battery Holder

1.
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Lift the battery out of its holder.

Figure 7-55 Removing the battery from a type 1 holder

Slide the replacement battery into position, positive side up.

The battery holder automatically secures the battery in the proper position.
Replace the computer access panel.

Plug in the computer and turn on power to the computer.

Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.

Type 2 Battery Holder

1.

3.

To release the battery from its holder, squeeze the metal clamp (1) that extends above one edge
of the battery. When the battery pops up, lift it out.

To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up (2). Push the other edge down until the clamp snaps over the other edge of the
battery.

Figure 7-56 Removing the battery from a type 2 holder

Replace the computer access panel.
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4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
2. Insert the new battery and position the clip back in place.

Figure 7-57 Removing the battery from a type 3 holder

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.
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Changing from a Minitower to a Desktop Configuration

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the front bezel (Front Bezel on page 71).

2
3
4. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.
5

To release the drives from the 5.25-inch drive bay, lift the release tab on the green latch drive
bracket for the drive. While lifting the release tab, slide the drive from its drive bay. Repeat this step
for each 5.25-inch drive.
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6. Before you reinstall each drive into the chassis, turn the drive so that it is perpendicular to the
internal 3.5-inch drive. The drive should be parallel to the green latch drive bracket.

Figure 7-59 Installing a Drive in the Desktop Configuration

7. Gently slide the drive into the uppermost available bay until it snaps into place. When the drive is
properly inserted, the drivelock will secure it. Repeat this step for each drive.

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This could
cause damage to the drive and the system board. The use of unnecessary force when installing
any drive into the drive bay may result in damage to the drive.

8. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

9. Remove the bezel subpanel as described in Bezel Blanks on page 72.

/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the
subpanel away at an angle could damage the pins that align it within the front bezel.

10. Reposition the bezel blanks within the subpanel in the proper orientation for the desktop
configuration.
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11. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the bezel.

Figure 7-60 Changing from a Minitower to a Desktop Configuration

Changing from a Desktop to a Minitower Configuration

1. Prepare the computer for disassembly (Preparation for Disassembly on page 63).

Remove the computer access panel (Computer Access Panel on page 70).

Remove the front bezel (Front Bezel on page 71).

2
3
4. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.
5

To release the drives from the 5.25-inch drive bay, press down on the short yellow drivelock as
shown. While pressing the drivelock, pull the drives out of the drive bay.

Figure 7-61 Releasing the 5.25-inch Drives from the Drive Bays (Desktop)
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6. Before you reinstall each drive into the chassis, turn it so that it is in the same orientation as the
internal 3.5-inch drive. The bottom of the drive should be parallel to the yellow drivelock.

Figure 7-62 Installing a Drive in the Minitower Configuration

7. Gently slide the drive into the uppermost available bay until it snaps into place. When the drive is
properly inserted, the drivelock will secure it. Repeat this step for each drive.

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This could
cause damage to the drive and the system board. The use of unnecessary force when installing
any drive into the drive bay may result in damage to the drive.

8. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

9. Remove the bezel subpanel as described in the Bezel Blanks on page 72 section.

/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the
subpanel away at an angle could damage the pins that align it within the front bezel.

10. Reposition the bezel blanks within the subpanel in the proper orientation for the minitower
configuration.

116 Chapter 7 Removal and Replacement Procedures Convertible Minitower (CMT) Chassis



11. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the bezel.

Figure 7-63 Changing from a Desktop to a Minitower Configuration
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Removal and Replacement Procedures

Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 54 for initial safety
procedures.

1.
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Remove/disengage any security devices that prohibit opening the computer (Unlocking the Smart
Cover Lock on page 64 and External Security Devices on page 121).

Close any open software applications.
Exit the operating system.
Remove any diskette, compact disc. or media card from the computer.

Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the

system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

Disconnect the power cord from the electrical outlet and then from the computer.

Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Unlocking the Smart Cover Lock

Bf NOTE: The Smart Cover Lock is an optional feature included on some models only.

The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This lock
prevents unauthorized access to the internal components. The computer ships with the Smart Cover
Lock in the unlocked position. For more information about locking the Smart Cover Lock, refer to the
Desktop Management Guide.

Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:

e Power outage
e  Startup failure
e PC component (for example, processor or power supply) failure

e Forgotten password

Bf NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order this
key before you need it.

To obtain a FailSafe Key:

e Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-style
key or PN 166527-002 for the screwdriver bit key.

e Refer to the HP Web site (http://www.hp.com) for ordering information.

e Call the appropriate number listed in the warranty or in the Support Telephone Numbers guide.

Using the Smart Cover FailSafe Key to Remove the Smart Cover Lock
To open the access panel with the Smart Cover Lock engaged:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).
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2. Use the Smart Cover FailSafe Key to remove the tamper-proof screw that secures the Smart Cover
Lock to the chassis.

Figure 8-1 Removing the Smart Cover Lock Screw
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You can now remove the access panel. See Computer Access Panel on page 125.

To reattach the Smart Cover Lock, secure the lock in place with the tamper-proof screw.
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External Security Devices

The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

Installing a Security Lock

The security locks displayed below and on the following pages can be used to secure the computer.

Cable Lock
Figure 8-2 Installing a Cable Lock
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Padlock
Figure 8-3 Installing a Padlock
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HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 8-4 Securing the Cable to a Fixed Object

2. Thread the keyboard and mouse cables through the lock.

Figure 8-5 Threading the Keyboard and Mouse Cables
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3. Screw the lock to the chassis using the screw provided.

Figure 8-6 Attaching the Lock to the Chassis

4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 8-7 Engaging the Lock
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Front Bezel Security
The front bezel can be locked in place by installing a security screw provided by HP.

The security screw is located on the fan duct inside the chassis. To lock the front bezel, remove the
security screw from the fan duct (1) and install it through the chassis frame into the front bezel (2).

Figure 8-8 Installing the Front Bezel Security Screw

Computer Access Panel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Press the buttons on the left and right sides of the computer (1) then slide the access panel back
until it stops and lift it up and off the chassis (2).

Figure 8-9 Removing the Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Lift up the latch behind the upper right side of the bezel and push down on the latch behind the
lower right side of the bezel (2), then pull the right side of the bezel off the chassis (1), followed by
the left side.

Figure 8-10 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the front bezel (Front Bezel on page 126)..

2. Toremove the 3.5-inch bezel blank, push the two retaining tabs that hold the bezel blank in place
towards the outer right edge of the bezel (1) and slide the bezel blank to the right to remove it

(2).
Figure 8-11 Removing a 3.5-inch Bezel Blank

3. Toremove the 5.25-inch bezel blank, push the two retaining tabs that hold the bezel blank in place
towards the outer left edge of the bezel (1) and pull the bezel blank inwards to remove it (2).

Figure 8-12 Removing a 5.25-inch Bezel Blank

4. Replace the front bezel.
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Installing Additional Memory

DIMMs

The computer comes with double data rate 2 synchronous dynamic random access memory (DDR2-
SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a high-
performing dual channel mode.

DDR2-SDRAM DIMMs

149,

For proper system operation, the DDR2-SDRAM DIMMs must be:
e industry-standard 240-pin

e unbuffered PC2-6400 800 MHz-compliant

e 1.8 volt DDR2-SDRAM DIMMs

The DDR2-SDRAM DIMMs must also:

e support CAS latency 5 DDR2 800 Mhz (5-5-5 timing) and CAS latency 6 DDR2 800 Mhz (6-6-6
timing)

e contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit and 1-Gbit non-ECC memory technologies
e single-sided and double-sided DIMMs

e DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

B NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMMZ2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory channel
A. Sockets DIMM3 and DIMM4 operate in memory channel B.

Figure 8-13 DIMM Socket Locations

Table 8-1 DIMM Socket Locations

Item Description Socket Color
1 DIMM1 socket, Channel A Black
2 DIMM2 socket, Channel A White
3 DIMM3 socket, Channel B White
4 DIMM4 socket, Channel B White

NOTE: A DIMM mustoccupy the black DIMM1 socket. Otherwise, the system
will display a POST error message indicating that a memory module must be
installed in the black socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 512-MB DIMMs and Channel B is populated with one 1-GB DIMM, the system
will operate in dual channel mode.

The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not
equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
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and the remainder is assigned to single channel. For optimal speed, the channels should be
balanced so that the largest amount of memory is spread between the two channels. If one channel
will have more memory than the other, the larger amount should be assigned to Channel A. For
example, if you are populating the sockets with one 1-GB DIMM, and three 512-MB DIMMs,
Channel A should be populated with the 1-GB DIMM and one 512-MB DIMM, and Channel B should
be populated with the two 512-MB DIMMs. With this configuration, 2-GB will run as dual channel
and 512-MB will run as single channel.

e In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

/A CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to
drain before adding or removing memory modules. Regardless of the power-on state, voltage is always
supplied to the memory modules as long as the computer is plugged into an active AC outlet. Adding
or removing memory modules while voltage is present may cause irreparable damage to the memory
modules or system board. If you see an LED light on the system board, voltage is still present.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Rotate up the external drive bay housing and the power supply to access the memory module
sockets on the system board.

/A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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10.

Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 8-14 Installing a DIMM
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NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

A DIMM must occupy the black DIMM1 socket.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B.

Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

Repeat steps 4 and 5 to install any additional modules.
Replace the access panel.

If the computer was on a stand, replace the stand.
Reconnect the power cord and turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Cards

The computer has one PCI expansion slot, one PCI Express x1 expansion slot, one PCl Express x16
expansion slot, and one PCI Express x16 expansion slot that is downshifted to a x4 slot.

Ef NOTE: The PCland PCI Express slots support only low profile cards. An optional PCI riser card with
two full height standard PCI slots is available from HP.

Figure 8-15 Expansion Slot Locations

Table 8-2 Expansion Slot Locations

Item Description
1 PCI expansion slot
2 PCI Express x16 expansion slot that is

downshifted to a x4 slot

3 PCI Express x16 expansion slot

4 PCI Express x1 expansion slot

B NOTE: You can install a PCl Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slots.

For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16
slot that is NOT downshifted to a x4 slot.

To install an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.
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Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab on
the latch and rotating the latch to the open position.

Figure 8-16 Opening the Expansion Slot Retainer

Before installing an expansion card, remove the expansion slot cover or the existing expansion

card.

Bf NOTE: Before removing an installed expansion card, disconnect any cables that may be attached
to the expansion card.

a.

If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Pull the slot cover straight up then away from the inside

of the chassis.

Figure 8-17 Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card, hold the card at each end, and carefully rock it back
and forth until the connectors pull free from the socket. Pull the expansion card straight up
from the socket then away from the inside of the chassis to release it from the chassis frame.
Be sure not to scrape the card against the other components.

Figure 8-18 Removing a Standard PCI Expansion Card

c. Ifyouareremovinga PCl Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull
free from the socket. Pull the expansion card straight up from the socket then away from the
inside of the chassis to release it from the chassis frame. Be sure not to scrape the card against
the other components.

Figure 8-19 Removing a PCIl Express x16 Expansion Card
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Store the removed card in anti-static packaging.

If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/\ CAUTION: After removing an expansion card, you must replace it with a new card or expansion
slot cover for proper cooling of internal components during operation.

To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bracket on the card is aligned
with the open slot on the rear of the chassis. Press the card straight down into the expansion socket
on the system board.

Figure 8-20 Installing an Expansion Card

Bf NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.
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9. Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 8-21 Closing the Expansion Slot Retainer

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.
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Cable Management

The Small Form Factor chassis is a very compact computer and proper routing of the internal cables is
critical to the operation of the computer. Follow good cable management practices when working inside
the computer.

e Keep cables away from major heat sources like the heatsink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

e When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

e Some flat ribbon cables come prefolded. Never change the folds on these cables.
e Do not bend any cable sharply. A sharp bend can break the internal wires.

e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Figure 8-22 Removing a power supply cable from its connector
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

Cable To Cable Designator

Power Supply System board, 24-pin P1

Power Supply Diskette drive P2

Power Supply CPU power, 6-pin P3

Power Supply 1st SATA hard drive P4

Power Supply 2nd SATA hard drive P5

Power Supply Optical drive P7

System Board Connector Connector Name Connector Color Description

P1 PWR White Power supply, 24-pin

P3 PWRCPU White Power supply, 4-pin

P10 FLOPPY Black Diskette drive

P9 CHFAN Brown Chassis fan

P5 PB/LED Black Front power button/LED

P24 FRONT USB Yellow Front I/0 USB

P23 FRONT AUD Blue Front audio

P6 SPRK White Internal speaker

P52 COMB Black Serial port

P60 SATA O Dark blue 1st HDD

P61 SATA 1 White 1st ODD or 2nd HDD if no
HDD present

P62 SATA 2 Light blue 2nd HDD if ODD present

P64 SATA 4 black eSATA port or extra ODD/
HDD connector

P124 HLCK Black Hood lock solenoid

P125 HSENSE White Hood sensor

P150 MEDIA Black Media card reader

P126 PAR Black Flying parallel port header

P151 BOOST Black ReadyBoost module
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Drives

A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

/A CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

Drive Positions

Figure 8-23 Drive Positions

Table 8-3 Drive Positions

1 3.5-inch internal hard drive bay

2 3.5-inch external drive bay for optional drives

3 5.25-inch external drive bay for optional drives (optical drive shown)

NOTE: The 3.5-inch external drive bay can be configured with a diskette drive,
a media card reader, or a secondary internal hard drive covered by a bezel blank.

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup. Refer to the Computer Setup (F10) Utility Guide for more information.
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Installing and Removing Drives

When installing additional drives, follow these guidelines:

The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.

Connect a second SATA hard drive to the next available (unpopulated) SATA connector on the
system board by following the numbered sequence of the connectors.

Always populate the dark blue SATAO and white SATA1 connectors before the light blue SATA2
connector.

Connect an optional external eSATA drive to the black ESATA connector on the system board.
Connect a diskette drive to the connector labeled FLOPPY.

Connect a media card reader USB cable to the USB connector on the system board labeled MEDIA.
If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws for the external drive bays (four 6-32 standard screws
and four M3 metric screws), installed in the front of the chassis, under the front bezel. The 6-32
standard screws are required for a secondary hard drive. All other drives (except the primary hard
drive) use M3 metric screws. The HP-supplied metric screws are black and the HP-supplied
standard screws are silver. If you are replacing the primary hard drive, you must remove the four
silver and blue 6-32 isolation mounting guide screws from the old hard drive and install them in the
new hard drive.

Figure 8-24 Secondary Hard Drive 6-32 Guide Screws Location
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Figure 8-25 Extra Optical Drive M3 Guide Screws Location

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer,
and unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label
the package “Fragile: Handle With Care.”
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System Board Drive Connections

Refer to the following illustration and table to identify the system board drive connectors.

Figure 8-26 System Board Drive Connections

Table 8-4 System Board Drive Connections

No. System Board Connector System Board Label Color
1 SATAO SATAO dark blue
2 SATA1 SATA1 white
3 SATA2 SATA2 light blue
4 eSATA ESATA black
5 Diskette Drive FLOPPY black
6 Media Card Reader MEDIA black
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Removing an Optical Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Rotate the drive cage to its upright position.

Figure 8-27 Rotating the Drive Cage Up

4. Disconnect the power cable (1) and data cable (2) from the rear of the optical drive.

Figure 8-28 Disconnecting the Power and Data Cables
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5. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 8-29 Rotating the Drive Cage Down

6. Press down on the green drive retainer button located on the left side of the drive to disengage the
drive from the drive cage (1). While pressing the drive retainer button, slide the drive back until it
stops, then lift it up and out of the drive cage (2).

Figure 8-30 Removing the Optical Drive

Ef NOTE: To replace the optical drive, reverse the removal procedure. When replacing a drive, transfer
the four guide screws from the old drive to the new one.

Installing an Optical Drive into the 5.25-inch Drive Bay
To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Ifyou are installing a drive in a bay covered by a bezel blank, remove the front bezel then remove
the bezel blank. See Bezel Blanks on page 127 for more information.
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4. Install two M3 metric guide screws in the lower holes on each side of the drive. HP has provided
four extra M3 metric guide screws on the front of the chassis, under the front bezel. The M3 metric
guide screws are black. Refer to Installing and Removing Drives on page 140 for an illustration of
the extra M3 metric guide screws location.

/A CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal
components of the drive.

B NOTE: When replacing the drive, transfer the four M3 metric guide screws from the old drive to
the new one.

Figure 8-31 Installing Guide Screws in the Optical Drive

5. Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive toward
the front of the computer until it locks into place.

Figure 8-32 Installing the Optical Drive
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6. Rotate the drive cage to its upright position.

Figure 8-33 Rotating the Drive Cage Up

7. Connect the SATA data cable to the white system board connector labeled SATA1.

8. Route the data cable through the cable guides.

/A CAUTION: There are two cable guides that keep the data cable from being pinched by the drive
cage when raising or lowering it. One is located on the bottom side of the drive cage. The other is
located on the chassis frame under the drive cage. Ensure that the data cable is routed through
these guides before connecting it to the optical drive.

9. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

Figure 8-34 Connecting the Power and Data Cables
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10. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 8-35 Rotating the Drive Cage Down

11. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an External 3.5-inch Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

Bf NOTE: The 3.5-inch drive bay may contain a diskette drive or a media card reader.

The 3.5-inch drive is located underneath the optical drive. You must remove the optical drive before
removing the external 3.5-inch drive.

1. Follow the procedure in Removing an Optical Drive on page 143 to remove the optical drive and
access the 3.5-inch drive.

/\ CAUTION: Ensure that the computer is turned off and that the power cord is disconnected from
the electrical outlet before proceeding.
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2. Disconnect the drive cables, as indicated in the following illustrations:

a. If you are removing a diskette drive, disconnect the data cable (1) and power cable (2) from
the back of the drive.

Figure 8-36 Disconnecting the Diskette Drive Cables
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If you are removing a media card reader, disconnect the USB cable from the system board.

b.
If the media card reader has a 1394 port, disconnect the 1394 cable from the PCI card.

Figure 8-37 Disconnecting the Media Card Reader USB Cable
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3. Press the green drive retainer latch (1) located on the right side of the drive to disengage the drive
from the drive cage. While pressing the drive retainer latch, slide the drive back until it stops, then
lift it up and out of the drive cage (2).

Figure 8-39 Removing a 3.5-inch Drive (Diskette Drive shown)

Bf NOTE: To replace the 3.5-inch drive, reverse the removal procedure.

When replacing a 3.5-inch drive, transfer the four guide screws from the old drive to the new one.

Installing a Drive into the 3.5-inch External Drive Bay

Depending on the computer configuration, the 3.5-inch external drive bay on the front of the computer
may be configured with a media card reader or a diskette drive, or it may be an empty drive bay.

If the computer was not configured with a 3.5-inch drive, you can install a media card reader, diskette
drive, or hard drive into the drive bay.

The 3.5-inch bay is located underneath the optical drive. To install a drive into the 3.5-inch bay:

NOTE: Install guide screws to ensure the drive will line up correctly in the drive cage and lock in place.
HP has provided extra guide screws for the external drive bays (four 6-32 standard screws and four M3
metric screws), installed in the front of the chassis, under the front bezel. A secondary hard drive uses
6-32 standard screws. All other drives (except the primary hard drive) use M3 metric screws. The HP-
supplied M3 metric screws are black and the HP-supplied 6-32 standard screws are silver. Refer to
Installing and Removing Drives on page 140 for illustrations of the guide screw locations.

1. Follow the procedure in Removing an Optical Drive on page 143 to remove the optical drive and
access the 3.5-inch drive bay.

/A CAUTION: Ensure that the computer is turned off and that the power cord is disconnected from
the electrical outlet before proceeding.

2. Ifyou areinstalling a diskette drive or media card reader in a bay covered by a bezel blank, remove
the front bezel then remove the bezel blank. See Bezel Blanks on page 127 for more information.
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Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive toward
the front of the computer until it locks into place.

Figure 8-40 Installing a Drive into the 3.5-inch Drive Bay (Diskette Drive shown)

Connect the appropriate drive cables:

a. Ifinstalling a diskette drive, connect the power and data cables to the rear of the drive and
connect the other end of the data cable to the connector on the system board labeled FLOPPY.

b. Ifinstalling a second hard drive, connect the power and data cables to the rear of the drive
and connect the other end of the data cable to the next available (unpopulated) SATA
connector on the system board by following the numbered sequence of the connectors.

c. Ifinstalling a media card reader, connect the USB cable from the media card reader to the
USB connector on the system board labeled MEDIA. If the media card reader includes a 1394
port, connect the 1394 cable to the 1394 PCI card.

EY NOTE: Referto System Board Drive Connections on page 142 for an illustration of the
system board drive connectors.

Replace the optical drive.

Replace the front bezel and access panel.

If the computer was on a stand, replace the stand.
Reconnect the power cord and turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.
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Removing and Replacing the Primary 3.5-inch Internal SATA Hard Drive

Bf NOTE: The system does not support Parallel ATA (PATA) hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive, make sure
you have created a Recovery Disc Set to restore the operating system, software drivers, and any
software applications that were preinstalled on the computer. If you do not have this CD set, select
Start > HP Backup and Recovery and create it now.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the hard
drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Rotate the drive cage for external drives to its upright position.

Figure 8-41 Rotating the Drive Cage Up
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4. Rotate the power supply to its upright position. The hard drive is located beneath the power supply.

/A CAUTION: If the computer has a Smart Cover Lock installed next to the drive cage, carefully
route all cables around the Smart Cover Lock assembly as you raise the power supply to avoid
damage to the cables or lock.

Figure 8-42 Raising the Power Supply

5. Disconnect the power cable (1)and data cable (2) from the back of the hard drive.

Figure 8-43 Disconnecting the Hard Drive Power Cable and Data Cable

_—
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6. Press down on the green release latch next to the hard drive (1). While holding the latch down,
slide the drive forward until it stops, then lift the drive up and out of the bay (2).

Figure 8-44 Removing the Hard Drive

7. Toinstall a hard drive, you must transfer the silver and blue isolation mounting guide screws from
the old hard drive to the new hard drive.

Figure 8-45 Installing Hard Drive Guide Screws
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8. Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the
bay, then slide it back until it stops and locks in place.

Figure 8-46 Installing the Hard Drive

9. Connect the power and data cables to the back of the hard drive.

B NOTE: When replacing the primary hard drive, be sure to route the SATA and power cables
through the cable guide on the bottom of the chassis frame behind the hard drive.

If the system has only one SATA hard drive, the data cable must be connected to the dark blue

connector labeled SATAO on the system board to avoid any hard drive performance problems. If
you are adding a second hard drive, connect the other end of the data cable to the next available
(unpopulated) SATA connector on the system board in the following order: SATAO, SATA1, SATA2.

10. Rotate the drive cage for external drives and the power supply down to their normal positions.

Bf NOTE: If you are replacing the primary hard drive, use the Recovery Disc Set to restore the operating
system, software drivers, and any software applications that were preinstalled on the computer.
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Removing and Replacing a Removable 3.5-inch SATA Hard Drive

Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

B NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers, and
any software applications that were preinstalled on the computer. If you do not have this CD set,
select Start > HP Backup and Recovery and create it now.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.
2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 8-47 Removing the Carrier Cover
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3. Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 8-48 Removing the Thermal Sensor

4. Remove the four screws from the bottom of the hard drive carrier.

Figure 8-49 Removing the Security Screws
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5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 8-50 Removing the Hard Drive

Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all the

way into the connector on the carrier's circuit board.

Figure 8-51 Replacing the Hard Drive
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7.

8.

Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 8-52 Replacing the Security Screws

Place the thermal sensor on top of the hard drive in a position that does not cover the label (1) and
attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 8-53 Replacing the Thermal Sensor
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9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the cover
in place (2).

Figure 8-54 Replacing the Carrier Cover

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

B NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Fan Shroud

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

3. Lift the fan shroud straight up out of the chassis.

Figure 8-55 Removing the fan shroud
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To install the fan shroud, reverse the removal procedure.
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Front Fan Assembly

1.

2
3
4.
5
6
7

Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the front bezel (Front Bezel on page 126).

Remove the fan shroud (Fan Shroud on page 161).

Disconnect the fan cable from the system board.
Disconnect the hood sensor cable.

Remove the screw that secures the fan to the chassis (1), slide the fan to the right (2), tilt the fan
so it clears the top of the chassis, and then lift the fan out of the chassis.

Figure 8-56 Removing the chassis fan
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To install the chassis fan, reverse the removal procedure. Be sure to orient the air flow into the unit.
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Hood Sensor

The hood sensor is installed in the top of the baffle that is attached to the chassis fan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the front bezel (Front Bezel on page 126).

Remove the chassis fan (Front Fan Assembly on page 162).

2
3
4. Remove the fan shroud (Fan Shroud on page 161).
5
6

Lift the hood sensor straight up and out of the chassis fan baffle.

Figure 8-57 Removing the hood sensor from the chassis fan

|

To install the hood sensor, reverse the removal procedure.
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Power Switch Assembly

1.
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10.

Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the front bezel (Front Bezel on page 126).

Remove the chassis fan (Front Fan Assembly on page 162).

Rotate the drive cage to its upright position.
Disconnect the power switch/LED cable from the system board.
Push the two LEDs into the chassis (1).

Squeeze the switch holder retaining clips together at the front of the chassis (2) and push the switch
assembly into the chassis.

Figure 8-58 Removing the power switch assembly

LB R BRI o

Lift the assembly up and out of the chassis, threading the wires through the hole in the drive cage
bracket.

Remove the assembly from the chassis.

To install the power switch assembly, reverse the removal procedure.

When installing the left LED, reach through the slot left open by the rotated drive cage to gain access
to the hole for the LED.

When installing the power switch, you may need to first insert one clip and the power button, then use
a flat-blade screwdriver to help guide the other clip into its slot.
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Front I/0 Device

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the front bezel (Front Bezel on page 126).

Remove the chassis fan (Front Fan Assembly on page 162).

Rotate the drive cage to its upright position.
Disconnect the two front I/0O cables from the system board.

Remove the screw that secures the front I/O device to the chassis.
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Pull the device forward, away from the chassis, and then guide the cables through the hole to
remove them from the chassis.

Figure 8-59 Removing the front I/O device
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To reinstall the front I/O device, reverse the removal procedure.

Speaker

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the front bezel (Front Bezel on page 126).

2
3
4. Rotate the drive cage to its upright position.
5. Disconnect the speaker wire from the system board.
6

Remove the two screws that secure the speaker to the chassis.
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7. Lift the speaker from the inside of the chassis to remove it.
Figure 8-60 Removing the speaker
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To install the speaker, reverse the removal procedures.

Smart Cover Lock

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

2
3.  Remove the power supply to the upright position.

4. Unplug the Smart Cover Lock cable from the system board.
5

Remove the security screw that secures the Smart Cover Lock to the back of the chassis, and then
remove the Smart Cover Lock from the computer.

To install the Smart Cover Lock, reverse the removal procedure
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Heatsink
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Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the fan shroud (Fan Shroud on page 161).

Remove the chassis fan (Front Fan Assembly on page 162).

Loosen the four captive screws that secure the heatsink to the system board tray.

CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

Lift the heatsink from atop the processor and set it on its side to keep from contaminating the work
area with thermal grease.

Figure 8-62 Removing the heatsink

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/A CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heatsink on the processor to avoid damage that could require replacing the system
board.

Failure to install the fan shroud may cause the computer to overheat.
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Processor
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Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove the fan shroud (Fan Shroud on page 161).

Remove the heatsink (Heatsink on page 167).

Rotate the locking lever to its full open position (1).
Raise and rotate the microprocessor retainer to its fully open position (2).

Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heatsink must be installed within 24 hours of installing the processor to prevent damage to the
processor’s solder connections.

Figure 8-63 Removing the processor

To install a new processor:

1.
2.

Place the processor in its socket and close the retainer.

Secure the locking lever. If reusing the existing heatsink, go to step 3. If using a new heatsink, go
to step 6.

If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the
bottom of the heatsink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the spares
kit.

168 Chapter 8 Removal and Replacement Procedures Small Form Factor (SFF) Chassis



Apply the thermal grease provided in the spares kit to the top of the processor and install the
heatsink atop the processor.

Gotostep 7.

If using a new heatsink, remove the protective covering from the bottom of the heatsink and place
it in position atop the processor.

Secure the heatsink to the system board and system board tray with the four captive screws and
attach the heatsink control cable to the system board.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heatsink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

Bf NOTE: Afterinstalling a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

/A WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

1.

2
3
4.
5
6

Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Rotate the drive cage up and disconnect the power cables from all of the drives.
Disconnect the power cables from the system board.
Rotate the power supply to its full upright position.

Release the power supply cables from the cable retaining clips on the bottom of the chassis and
under the drive cage.

Figure 8-64 Cable routing
./
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7. Pull the power supply forward until the posts on the power supply move forward in the power supply
bracket, and then lift the power supply straight up and out of the chassis.

To install the power supply, reverse the removal procedure.

/A CAUTION: When installing the power supply cables, make sure they are properly positioned so they
are not cut by the drive cage and are not pinched by the rotating power supply.

170 Chapter 8 Removal and Replacement Procedures Small Form Factor (SFF) Chassis



System Board

1.

2
3
4
5.
6
7
8
9

10.
1.
12.

13.

Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Remove all PCl and PCI Express expansion boards (Expansion Cards on page 132).

Remove the fan shroud from the chassis (Fan Shroud on page 161).

Remove the fan from the chassis (Front Fan Assembly on page 162).

Rotate the drive cage to its upright position.

Rotate the power supply to its full upright position.

Disconnect all data and power cables from the system board.
If applicable, disconnect the serial port from the system board.
Disconnect the balance of the cables from the system board.

Remove the heatsink (Heatsink on page 167).

Remove the seven screws that secure the system board to the chassis.

Figure 8-66 Removing the system board
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Lift up the front of the system board, and then pull the system board forward, up, and out of the
chassis.

To install the system board, reverse the removal procedure.

Bf NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

NOTE: The heatsink should be installed on the system board before the system board is reinstalled
in the chassis.
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/\ CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of
the heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables itis important that they be positioned so they do notinterfere
with the rotation of the drive cage or power supply.

Backwall

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Unlocking the
Smart Cover Lock on page 64)

Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

Rotate the drive cage to its upright position.

Remove the power supply (Power Supply on page 169).
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If necessary, remove the SmartCover lock from the backwall of the chassis using the special
security wrench and disconnect its cable from the system board (Unlocking the Smart Cover
Lock on page 119).

7. Remove the system board (System Board on page 171).

8. Remove the four screws that secure the backwall assembly to the chassis (1), slide the backwall
assembly toward the front of the chassis, and then lift it out of the chassis (2).

To replace the backwall, reverse the removal procedures.
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Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally installed
on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassembile, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup
(F10) Utility Guide for information on backing up the CMOS settings.

NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

2. Remove the access panel (Computer Access Panel on page 125).

Bf NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following instructions
to replace the battery:
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Type 1 Battery Holder

1.
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Lift the battery out of its holder.

Figure 8-68 Removing the battery from a type 1 holder

Slide the replacement battery into position, positive side up.

The battery holder automatically secures the battery in the proper position.
Replace the computer access panel.

Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.

Type 2 Battery Holder

1.

3.

To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up (2). Push the other edge down until the clamp snaps over the other edge of the
battery.

Figure 8-69 Removing the battery from a type 2 holder

Replace the computer access panel.
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4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
2. Insert the new battery and position the clip back in place.

Figure 8-70 Removing the battery from a type 3 holder

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.
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Using the Small Form Factor Computer in a Tower
Orientation

The Small Form Factor computer can be used in a tower orientation. The HP logo plate on the front
bezel is adjustable for either desktop or tower orientation.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 118).

Remove the access panel (Computer Access Panel on page 125).

2
3.  Remove the front bezel (Front Bezel on page 126).
4

Squeeze together the two sides of the peg on the back side of the logo plate (1) and push the peg
inwards towards the front side of the bezel (2).

5. Rotate the plate 90 degrees (3) then pull back on the peg to lock the logo plate in place.
Figure 8-71 Rotating the HP Logo Plate

6. Replace the front bezel.

7. Replace the access panel.
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8. Orient the computer so that its right side is facing down.

Figure 8-72 Changing from Desktop to Tower Orientation

B NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the optional
tower stand.

9. Reconnect the power cord and any external devices, then turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.

B NOTE: Ensure atleast 10.2 centimeters (4 inches) of space on all sides of the computer remains clear
and free of obstructions.
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Removal and Replacement Procedures

Ultra-Slim Desktop (USDT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 54 for initial safety

procedures.
1.  Remove/disengage any security devices that prohibit opening the computer (External Security
Devices on page 179).
2. Close any open software applications.
3. Exit the operating system.
4. Remove any compact disc from the computer.
5. Turn off the computer and any peripheral devices that are connected to it.
/A CAUTION: Turn off the computer before disconnecting any cables.
Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.
6. Disconnect the power cord from the electrical outlet and then from the computer.
7. Disconnect all peripheral device cables from the computer.
B NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.
/A CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
8. If the PC is mounted in the accessory mounting stand, remove it from the stand.
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External Security Devices

The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

Installing a Security Lock

Cable Lock

There are two cable lock slots on the rear of the computer. The slot next to the thumbscrew should be
used when there is no port cover. The slot on the far right should be used when a port cover is installed.

Figure 9-1 Installing a Cable Lock with No Port Cover

Figure 9-2 Installing a Cable with a Port Cover Installed
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Padlock
Figure 9-3 Installing a Padlock

HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 9-4 Securing the Cable to a Fixed Object
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2. Thread the keyboard and mouse cables through the lock.

Figure 9-5 Threading the Keyboard and Mouse Cables

3. Screw the lock to the chassis using the screw provided.

Figure 9-6 Attaching the Lock to the Chassis
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4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 9-7 Engaging the Lock
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Computer Access Panel

To access internal components, you must remove the access panel:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

2. Loosen the thumbscrew on the rear of the computer (1), slide the access panel toward the front of
the computer, and then lift it off (2).

Figure 9-8 Removing the Computer Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

2. Remove the computer access panel (Computer Access Panel on page 183).

3. Liftthe fan and shroud assembly up and place it on top of the optical drive to access the front bezel
release tabs. You do not need to disconnect the fan cable from the system board.

Figure 9-9 Lifting the Fan Shroud

4. Press the two release tabs on the inside of the bezel towards the right side of the computer (1) and
rotate the bezel off from right to left (2).

Figure 9-10 Removing the Front Bezel

5. Replace the fan shroud.

To install the front bezel, reverse the removal procedure.

184 Chapter 9 Removal and Replacement Procedures Ultra-Slim Desktop (USDT) Chassis



Bezel Blank

On some models, there is a bezel blank covering the external drive bay that needs to be removed before
installing a drive. To remove a bezel blank:

1. Remove the computer access panel (Front Bezel on page 184).

2. Push the two retaining tabs that hold the bezel blank in place towards the outer right edge of the
bezel (1) and pull the bezel blank inwards to remove it (2).

Figure 9-11 Removing a Bezel Blank
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Installing Additional Memory

The computer comes with double data rate 2 synchronous dynamic random access memory (DDR2-
SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard SODIMMs.
These memory sockets are populated with at least one preinstalled SODIMM. To achieve the maximum
memory support, you can populate the system board with up to 8-GB of memory.

DDR2-SDRAM SODIMMs

For proper system operation, the SODIMMs must be:
e industry-standard 200-pin

e unbuffered PC2-6400 800 MHz-compliant

e 1.8 volt DDR2-SDRAM SODIMMs

The DDR2-SDRAM SODIMMs must also:

e support CAS latency 5 DDR2 800 Mhz (5-5-5 timing) and CAS latency 6 DDR2 800 Mhz (6-6-6
timing)

e contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification
In addition, the computer supports:

e  512-Mbit and 1-Gbit non-ECC memory technologies

e single-sided and double-sided SODIMMS

e SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

149,

B NOTE: The system will not operate properly if you install unsupported SODIMMs.

Refer to the Computer Setup (F10) Utility Guide for information on how to determine the processor bus
frequency of a specific computer.
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Populating SODIMM Sockets

There are two SODIMM sockets on the system board, with one socket per channel. The sockets are
labeled DIMM1 and DIMM3. The DIMM1 socket operates in memory channel A. The DIMMS3 socket
operates in memory channel B.

Figure 9-12 SODIMM Socket Locations

Table 9-1 SODIMM Socket Locations

Item Description Socket Color
1 SODIMM1 socket, Channel A Black
2 SODIMM3 socket, Channel B White

NOTE: A SODIMM must occupy the black DIMM1 socket. Otherwise, the
system will display a POST error message indicating that a memory module
must be installed in the black socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed.

e The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

e  The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

e  The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to channel A.

e Inany mode, the maximum operational speed is determined by the slowest SODIMM in the system.
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Installing SODIMMs

/A CAUTION: You must disconnect the power cord before adding or removing memory modules.
Regardless of the power-on state, voltage is always supplied to the memory modules as long as the
computer is plugged into an active AC outlet. Adding or removing memory modules while voltage is
present may cause irreparable damage to the memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

2. Remove the computer access panel (Computer Access Panel on page 183).

3. Locate the memory module sockets on the system board.

/A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

4. If you are adding a second SODIMM, remove the SODIMM from the top DIMM1 socket to access
the bottom DIMM3 socket. Press outward on the two latches on each side of the SODIMM (1) then
pull the SODIMM out of the socket (2).

Figure 9-13 Removing a SODIMM
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5. Slide the new SODIMM into the socket at approximately a 30° angle (1) then press the SODIMM
down (2) so that the latches lock it in place.

Figure 9-14 Installing a SODIMM

Bf NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

A SODIMM must occupy the DIMM1 (top) socket.

Replace the SODIMM in the DIMM1 socket if it was removed.
Replace the access panel.

If the computer was on a stand, replace the stand.
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Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

The computer automatically recognizes the additional memory when you turn on the computer.
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Cable Management

Always follow good cable management practices when working inside the computer.

Keep cables away from major heat sources like the heatsink.

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the parts
are moved.

Do not bend any cable sharply. A sharp bend can break the internal wires.
Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.
Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system board,
always follow these steps:

1.
2,

Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

Grasp the cable end of the connector and pull it straight up (2).

/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could

damage the cable and result in a failed power supply.

Figure 9-15 Removing a power supply cable from its connector
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

System Board Connections

System Board Connector Connector Name Connector Color Description

P9 CHFAN1 Maroon Front chassis fan
P11 CHFAN2 Brown Rear chassis fan

P6 SPRK White Internal speaker
P61 SATA1 White Optical data

P125 HSENSE White Hood sensor

P151 BOOST Black ReadyBoost module
P160 N/A Black Optical power

P160 N/A Black Optical power

Replacing the Optical Drive

The Ultra-Slim Desktop uses a slimline Serial ATA (SATA) optical drive.

Removing
1.
2.
3.

the Existing Optical Drive

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Disconnect the cable on the rear of the optical drive (1), push the green release latch on the right
rear side of the drive toward the center of the drive (2), then slide the drive forward and out of the

bay through the front bezel (3).
Figure 9-16 Removing the Optical Drive
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Preparing the New Optical Drive
Before the new optical drive can be used, the release latch must be attached.
1. Peel the backing off the adhesive on the release latch.

2.  Without allowing the release latch to touch the optical drive, carefully align the holes on the release
latch with the pins on the side of the optical drive. Make sure the release latch is oriented properly.

3. Insert the pin at the front of the optical drive into the hole at the end of the release latch, and press
firmly.

4. Insert the second pin, and press the entire release latch firmly to fasten the latch securely to the
optical drive.

Figure 9-17 Aligning the Release Latch
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Installing the New Optical Drive

Bf NOTE: If you are installing an optical drive in a bay that did not previously have a drive in it, you must
remove the access panel and the bezel blank covering the opening of the bay before proceeding. Follow
the procedures in Computer Access Panel on page 183 and Bezel Blank on page 185.

1.

Attach the release latch to the new optical drive. Refer to Preparing the New Optical Drive
on page 192.

With the back of the optical drive facing the computer and the release latch on the inner side of the
drive, align the drive with the opening in the front bezel.

Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1),
then connect the cable to the rear of the drive (2).

Figure 9-18 Installing the Optical Drive

Optical Drive Connector

1.

2
3.
4

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the optical drive (Removing the Existing Optical Drive on page 191).

Push the top of the connector down through the opening of the hard drive cage until the connector
is on the opposite side of the hard drive cage opening.
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5. Pull the connector straight up to disconnect it from the system board.

Figure 9-19 Removing the optical drive connector

To install the optical drive connector, reverse the removal procedures.
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Hard Drive

Bf NOTE: The Ultra-Slim Desktop supports only 2.5-inch Serial ATA (SATA) internal hard drives; parallel
ATA (PATA) internal hard drives are not supported.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive, make sure
you have created a Recovery Disc Set to restore the operating system, software drivers, and any
software applications that were preinstalled on the computer. If you do not have this CD set, select
Start > HP Backup and Recovery and create it now.

The 2.5-inch hard drive is enclosed in a carrier under the optical drive.

1.

2
3.
4

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the optical drive. Refer to Removing the Existing Optical Drive on page 191 for instructions.

Press in the release latch on the left side of the hard drive carrier (1) then rotate the carrier handle
to the right (2).

Figure 9-20 Unlocking the Hard Drive Carrier
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5. Lift the hard drive carrier straight up and out of the chassis.

Figure 9-21 Removing the Hard Drive Carrier

6. To remove the hard drive from the carrier, remove the guide screw from the front left side of the
carrier.

Figure 9-22 Removing the Hard Drive Guide Screw
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7. Slide the carrier back and remove the hard drive.

Figure 9-23 Removing the Hard Drive

8. Transfer the three remaining guide screws (two on the right and one on the rear left) from the old
drive to the new drive.

Figure 9-24 Transferring the Guide Screws
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9. Align the guide screws with the slots on the carrier and slide the new hard drive into the carrier
(1), then replace the guide screw on the front left of the carrier to secure the drive in the carrier

().

Figure 9-25 Installing the Hard Drive in the Carrier

10. To place the hard drive carrier back in the chassis, align the guide screws with the slots on the
drive bay, drop the carrier straight down into the drive bay (1), and press the handle on the carrier
all the way down (2) so that the drive is properly seated and locked in place.

Figure 9-26 Installing the Hard Drive Carrier

11. Lock any security devices that were disengaged when the computer cover or access panel was
removed.
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B NOTE: No configuration of the SATA hard drive is necessary; the computer automatically

recognizes it the next time you turn on the computer.

After replacing the hard drive, use the Recovery Disc Set that you created when you initially set up
the computer to restore the operating system, software drivers, and any software applications that
were preinstalled on the computer. When the restore process has completed, reinstall any personal
files that you backed up before replacing the hard drive.

Hard Drive Cage

1.

2
3
4.
5

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the optical drive and connector (Removing the Existing Optical Drive on page 191).

Remove the hard drive (Hard Drive on page 195).

Remove the screw that secures the cage to the chassis (1), lift the tab on the hard drive cage (2),
pull the cage toward the rear of the chassis (3), and then lift the cage out of the chassis.

Figure 9-27 Removing the hard drive cage

To install the hard drive cage, reverse the removal procedures.
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Port Cover

An optional rear port cover is available for the computer.
To install the port cover:

1.  Thread the cables through the bottom hole on the port cover (1) and connect the cables to the rear
ports on the computer.

2. Insert the hooks on the port cover into the slots on the rear of the chassis, then slide the cover to
the right to secure it in place (2).

Figure 9-28 Installing a Port Cover

Bf NOTE: For security purposes, you can install an optional cable lock to the chassis that locks the port
cover and secures the computer. See Installing a Security Lock on page 179.

The port cover is secured in place by a retention lever just inside the port cover opening. To remove the
port cover, pull the lever back towards the port cover opening (1), then slide the cover to the left and off
the computer (2).
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Figure 9-29 Removing a Port Cover

Front Fan

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Disconnect the fan control cable from the system board.

P 0D

Lift the fan straight up and out of the chassis.

Figure 9-30 Removing the front fan
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To install the front fan, reverse the removal procedure.
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Speaker

1.

© N o o ~ 0 Db

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the front bezel (Front Bezel on page 184).

Remove the optical drive (Removing the Existing Optical Drive on page 191).

Remove the hard drive (Hard Drive on page 195).

Remove the hard drive cage (Hard Drive Cage on page 199).

Disconnect the speaker cable from the system board.

Remove the two torx T8 screws that secure the speaker to the chassis, and then slide the speaker
up to remove it from the chassis.

Figure 9-31 Removing the speaker

4

To install the speaker, reverse the removal procedure.
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Rear Fan

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Disconnect the fan control cable from the system board.

> w0 DN

Remove the four screws that secure the fan to the chassis (1), slide the fan forward, and then lift
it up and out of the chassis (2).

Figure 9-32 Removing the rear fan
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To install the rear fan, reverse the removal procedure.
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Heatsink

> w0 DN

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the front fan (Front Fan on page 201).

Lift the fan up and place it on top of the optical drive to access the front bezel release tabs. You
do not need to disconnect the fan cable from the system board.

Unscrew the four screws that secure the heatsink to the system board, and then lift the heatsink
from the system board.

Figure 9-33 Removing the heatsink
ﬂ'—_‘-—:_—:h_ : | = a L E

CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor to avoid damage that could require replacing the
system board.

Lay the heatsink on its top in a safe area to prevent the thermal grease from contaminating the
work surface.

If reusing the existing heatsink go to step 1.

If using a new heatsink, go to step 3.

1.

If reusing the existing heatsink, clean bottom of the heatsink and apply the thermal grease provided
in the spares kit to the top of the processor.

Position the heatsink atop the processor.

If using a new heatsink, remove the protective covering from the bottom of the heatsink and place
it in position atop the processor.

Secure the heatsink to the system board and system board tray with the 4 captive screws and
attach the heatsink control cable and the thermal sensor cable to the system board.
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/\ CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heatsink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

Processor

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the heatsink (Heatsink on page 204).

Rotate the processor locking lever to its full open position (1).

Raise and rotate the microprocessor retainer to its fully open position (2).

o g M~ o b

Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heatsink must be installed within 24 hours of installing the processor to prevent damage to the
processor’s solder connections.

Figure 9-34 Removing the processor

To install a new processor:
1. Place the processor in its socket and close the retainer.
2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.

3. Ifreusing the existing heatsink, clean bottom of the heatsink and apply the thermal grease provided
in the spares kit to the top of the processor.
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Position the heatsink atop the processor.

If using a new heatsink, remove the protective covering from the bottom of the heatsink and place
it in position atop the processor.

Secure the heatsink to the system board and system board tray with the 4 captive screws and
attach the heatsink control cable to the system board.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heatsink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

B NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

System Board

/\ CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.

1.

2
3
4
5.
6
7

Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the optical drive (Removing the Existing Optical Drive on page 191).

Remove the memory modules (Installing Additional Memory on page 186).

Remove the hard drive (Hard Drive on page 195).

Remove the hard drive cage (Hard Drive Cage on page 199).

Remove the front I/O panel cage:
a. Remove the screw from the left side of the cage that holds the 1/0 panel cage in place (1).

b. Press the tab on left side of the cage (2), and then swing the cage toward right to remove it
from the chassis.

Bf NOTE: If the cage sticks and will not come loose, press down on the top of the panel near
the tab while pressing the tab.

Figure 9-35 Removing the I/O panel cage

Remove the heatsink (Heatsink on page 204).

Disconnect all cables connected to the system board, noting their location for reinstallation.
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10. Remove the five remaining screws that secure the system board to the chassis.

Figure 9-36 Removing the system board

11. Slide system board toward the front of the unit until the rear connectors are clear of their slots in
the chassis.

12. Lift the rear of the system board until it clears the chassis, and then remove the system board from
the chassis.

To install the system board, reverse the removal procedure.

Bf NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.
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Hood Sensor

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

Remove the optical drive (Removing the Existing Optical Drive on page 191).

Remove the hard drive (Hard Drive on page 195).

Remove the hard drive cage (Hard Drive Cage on page 199).

Unplug the hood sensor cable from the system board.

N o a 0 v Db

Slide the hood sensor into the chassis to remove it from its slot.

Figure 9-37 Removing the hood sensor
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To install the hood sensor, reverse the removal procedures.

Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally installed
on the computer. The computer comes with a 3-volt lithium coin cell battery.

Ef NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.
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/A WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup
(F10) Utility Guide for information on backing up the CMOS settings.

Bf NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/

recycle.

/A CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

Remove the computer access panel (Computer Access Panel on page 183).

2
3. Pull back on the clip(1) that holds the battery in place, then remove the battery (2).
4. Insert the new battery and position the clip back in place.

Figure 9-38 Removing the battery

5. After the battery has been replaced, reverse the disassembly procedure.
6. Plug in the computer and turn on power to the computer.

7. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.
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Changing from Desktop to Tower Configuration

1. Prepare the computer for disassembly (Preparation for Disassembly on page 178).

2. Remove the computer access panel (Computer Access Panel on page 183).

3. Remove the front bezel (Front Bezel on page 184).

4. On the back side of the logo plate, press down on the “step” to remove the logo plate from the
bezel (1).

5. Rotate the plate 90 degrees (2) then press the logo plate back into the bezel.
Figure 9-39 Rotating the HP Logo Plate

6. Replace the front bezel.

7. Replace the access panel.
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8. Place the computer firmly down into the stand.

Figure 9-40 Placing the Computer on the Stand

9. Reconnect the external equipment, plug the power cord into a power outlet, and turn the computer
on.

10. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

To change from the tower configuration to the desktop configuration, reverse the previous steps.

Ef NOTE: An optional Quick Release mounting bracket is available from HP for mounting the computer
to a wall, desk, or swing arm.
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some of
these connectors may not be used on the product being serviced.

Keyboard

Connector and Icon Pin Signal
1 Data
2 Unused
laf1a| oopoooon 3 Ground
O =068 ooooooa
| = | me— = | 4 +5VDC
5 Clock
6 Unused
Mouse
Connector and Icon Pin Signal
1 Data
2 Unused
|:E|3 Q\. EE A 3 Ground
[8]n] 4 +5VDC
5 Clock
6 Unused

Ethernet BNC

Connector and Icon Pin Signal

1 Data

" ﬁ 2 Ground
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Ethernet RJ-45

Connector and Icon Pin Signal
1 (+) Transmit Data
2 (-) Transmit Data
3 (+) Receive Data
G @ @ 4 Unused
‘ﬁ‘ 5 Unused
6 (-) Receive Data
7 Unused
8 Unused
Ethernet AUI
Connector and Icon
\@@ OOO000 / CIE]
[cYoleleYolcYo! ﬁ-
Pin Signal Pin Signal
1 Ground 9 Positive AUI Differential Receive
2 Negative AUI Differential Collision 10 +12V
3 Positive AUI Differential Collision 11 Ground
4 Negative AUI Differential Transmit 12 Ground
5 Positive AUI Differential Transmit 13 Unused
6 Ground 14 Unused
7 Ground 15 Unused
8 Negative AUI Differential Receive 16 Unused
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Parallel Interface

Connector and Icon

\@@@@@@ca@@o/ m

PPRAPORPRLOOEO ﬂ_JW
Pin Signal Pin Signal
1 Strobe 10 Acknowledge
2 Data Bit 0 11 Busy
3 Data Bit 1 12 Paper End
4 Data Bit 2 13 Select
5 Data Bit 3 14 Auto Linefeed
6 Data Bit 4 15 Error
7 Data Bit 5 16 Initialize Printer
8 Data Bit 6 17 Select IN
9 Data Bit 7 18-25 Signal Ground

Serial Interface, Powered and Non-Powered

Connector and Icon Pin Signal
1 Carrier Detect (12V if powered)
2 Receive Data
3 Transmit Data

Data Terminal Ready

1010J0J0JO)
loJoJoJo]

5 Signal Ground

6 Data Set Ready

7 Request to Send

8 Clear to Send

9 Ring Indicator (5V if powered)
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USB

Microphone

Headphone

Connector and Icon Pin Signal

1 +5VDC

é | 3 + Data

4 Ground
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_left
123
qﬁ.ﬁfﬂ]:[]: QOU 2 (Ring) Power_Right

3 (Shield) Audio_right
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_left
123
w (( )) 2 (Ring) Power_Right

3 (Shield) Ground

Line-in Audio

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left
123
qﬁ.ﬁfg]:[]: e 2 (Ring) Audio_In_Right

3 (Shield) Ground

Line-out Audio

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left
123
qﬁfﬂ:[]: = 2 (Ring) Audio_Out_Right

3 (Shield) Ground
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External Infrared Transceiver

Connector and Icon Pin Signal

1 Transmit
2 Receive
3 Ground

o]ao) N 4 5V

B ngE| on'

Bln| & 5 Mode
6 Not Used
7 Not Used
8 Not Used
Monitor

Connector and Icon

Pin Signal Pin Signal

1 Red Analog 9 +5V (fused)

2 Green Analog 10 Ground

3 Blue Analog 11 Not used

4 Not used 12 DDC Serial Data
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync

7 Ground 15 DDC Serial Clock
8 Ground
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ATA/ATAPI (IDE) Standard Drive Cable

Connector

39 1

40 2
Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1 29 DMAK
2 Ground 16 DD14 30 Ground
3 DD7 17 DDO 31 INTRQ
4 DD8 18 DD15 32 I0CS16
5 DD6 19 Ground 33 DA1
6 DD9 20 (Key) 34 PDIAG (cable detect)
7 DD5 21 DMARQ 35 DAO
8 DD10 22 Ground 36 DA2
9 DD4 23 DIOW 37 CS1FX
10 DD11 24 Ground 38 CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY
14 DD13 28 CSEL
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CD-ROM 50-Pin Connector

Connector

50 2

499nunnuBnnnnuunnununnnuuu:
Pin Signal Pin Signal Pin Signal Pin Signal
1 Audio L-ch 14 DD12 27 IORDY 40 +5V
2 Audio R-ch 15 DD3 28 DMACK 41 +5V
3 Audio GND 16 DD13 29 INTRQ 42 +5V
4 GND 17 DD2 30 I0CS16 43 GND
5 RESET 18 DD14 31 DA1 44 GND
6 DD8 19 DD1 32 PDIAG 45 GND
7 DD7 20 DD15 33 DAO 46 GND
8 DD9 21 DDO 34 DA2 47 CSEL
9 DD6 22 DMARQ 35 CS1FX 48 GND
10 DD10 23 GND 36 CS3FX 49 Vendor-specific
11 DD5 24 DIOR 37 DASP 50 Vendor-specific
12 DD11 25 DIOW 38 +5V
13 DD4 26 GND 39 +5V

24-Pin Power

Connector

24 | 13

[=)[=) (= ][=)(=]Ca](a](a][)Ca][=][=]

gBEBEE@BEEB@
Pin Signal Pin Signal Pin Signal Pin Signal
1 +3.3V 7 GND 13 +3.3V 19 GND
2 +3.3V 8 POK 14 -12v 20 open
3 GND 9 +5 Vaux 15 GND 21 +5V
4 +5V 10 +12V 16 PSON 22 +5V
5 GND 11 +12V 17 GND 23 +5V
6 +5V 12 +3.3V 18 GND 24 GND
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24-Pin MicroFit Power (CMT, SFF)

Connector

24 - 130

DREPEEUEREEE| ...

[«)[=)(=][«){a](=]Ca][=)(=]Ca][=)[=)

12 1
Pin  Signal Pin  Signal Pin  Signal Pin  Signal
1 +5 Vaux 7 PWRGD 13 +12v 19  GND
2 GND 8 +3.3V 14 +5V Sense 20 +33V
3 +5V 9 +3.3V 15 GND 21 Sense
4 +5V 10 Tach 16 +5V 22 433V
5 PS_ON 11 GND 17 45V 23 433V
6 GND 12 Fan-CMD 18 +3.3V 24 GND

4-Pin Power (for CPU)

Connector and Icon Pin Signal

1 GND

o0 2 o
@E 3 +12V CPU

6-Pin Power (for CPU) (CMT, SFF)

[=](™)(™ 3 GND
O:@EE 4 12V CPU

4 M 6

5 12V CPU

6 +12V
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SATA Data and Power

Drive Connector

S1 S7 P1 P15
=0 ]
Pin Signal Pin Signal Pin Signal Pin Signal
S1 Ground S2 A+ S3 A- S4 Ground
S5 B- S6 B+ S7 Ground
P1 Ground P2 V3.3 P3 V3.3 P4 Ground
P5 B- P6 Ground P7 V5 P8 V5
P9 V5 P10  Ground P11 Reserved P12  Ground
P13 V12 P14 V12 P15 V12

S = Data, P = Power

PCI Express

x1, x4, x8, and x16 PCI Express Connector

A1 AB2

Immmmmmmﬂ
t-L-‘.-ltlllll-ltI-L'l-'l-li-J'l-th-l'l'i-M'I'L-H!L'I'l-]'J'I'l-{-J-l-t-MtJﬂ-HtJ!I'l-I'1'I-J-(-l'J'l-ldtlll-ldd'l'l-.'-]'J'l'I.-J'IIIN-I'I'I-I‘J'I'I
— —  — -

B1 B82

Pin A

Pin Signal Pin Signal Pin Signal Pin  Signal Pin Signal
1 PRSNT1 6 JTAG3 11 PERST# 16 PERpO 21 PERp1
2 +12V 7 JTAG4 12 GND 17  PERnO 22  PERn1
3 +12V 8 JTAG5 13 REFCLK+ 18 GND 23 GND

4 GND 9 +3.3V 14  REFCLK- 19 RSVD 24  GND

5 JTAG2 10 +3.3V 15 GND 20 GND 25 PERp2
26 PERn(2) 31  GND 36 PERn4 41  GND 46 GND
27 GND 32 RSVD 37 GND 42 GND 47  PERp7
28 GND 33 RSVD 38 GND 43  PERp6 48 PERn7
29  PERp3 34 GND 39 PERp5 44  PERn6 49 GND
30 PERn3 35 PERp4 40 PERn5 45 GND 50 RSVD
51 GND 56  PERp9 61 PERn10 66 GND 71 GND
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52 PERp8 57 PERn9 62 GND 67 GND 72  PERp13

53  PERNS 58  GND 63 GND 68 PERp12 73 PERn13
54 GND 59  GND 64 PERp11 69 PERn12 74  GND
55  GND 60 PERp10 65 PERn11 70  GND 75 GND
76  PERp14 81 PERn15

77 PERn14 82 GND

78  GND

79  GND

80 PERp15

NOTE: x1 PCI Express uses pins 1-18
x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8

PCI Express

x1, x4, x8, and x16 PCI Express Connector

A1 AB2

T :
[HHH G R R R
D e e e s A S e Ao

M 1

B1 B82
PinB
Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal
1 +12V 6 SMDAT 11 WAKE# 16 GND 21  GND
2 +12V 7 GND 12 RSVD 17 GND 22 GND
3 RSVD 8 +3.3V 13 GND 18 GND 23  PETp2
4 GND 9 JTAG1 14 PETpO 19 PETp1 24  PETn2
5 SMCLK 10  3.3vAux 15  PETnO 20 PETn1 25 GND
26 GND 31 PRSNT2# 36 GND 41  PETp6 46  PETn7
27 PETp3 32 GND 37 PETp5 42  PRTn6 47  GND
28 PETn3 33 PETp4 38 PETn5 43 GND 48  PRSNT2#
29 GND 34 PETn4 39 GND 44 GND 49 GND
30 RSVD 35 GND 40 GND 45  PETp7 50 PETp8
51  PETn8 56 GND 61 GND 66 PETp12 71 PETn13
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52 GND 57 GND 62 PETp11 67 PETn12 72  GND
53 GND 58 PETp10 63 PETNn11 68 GND 73 GND
54  PETp9 59 PETn10 64 GND 69 GND 74  PETp14
55 PETNn9 60 GND 65 GND 70 PETp13 75 PETn14
76  GND 81 PRSNT2#
77 GND 82 RSVD
78 PETp15
79 PETn15
80 GND
NOTE: x1 PCI Express uses pins 1-18
x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49
x16 PCI Express uses pins 1-8
PCI Express Mini Card
PCI Express Mini Card Connector
51
¥
i ADAOAONOAAG DANORA,
/LI;II_JI_I 1 8
2 52
Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal
1 WAKE# 7 CLKREQ# 13 REFCLK+ 19  Reserved** 25 PERpO
(UiM_C4)
2 3.3V 8 UIM_PWR 14  UIM_RESET 26 GND
20  W_DISABLE#
3 Reserved** 9 GND 15 GND 27 GND
21 GND
4 GND 10 UIM_DATA 16  UIM_VPP 28  +1.5V
22 PERST#
5 Reserved** 11 REFCLK- 17  Reserved *** 29 GND
(UIM_C8) 23 PERnO
6 1.5V 12 UIM_CLK 30 SMB_CLK
18  GND 24 +3.3Vaux
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31 PETNn0 37 Reserved* 43 Reserved* 49 Reserved*

32 SMB_DATA 38 USB_D+ 44  LED_WLAN# 50 GND

33  PETpO 39 Reserved® 45  Reserved* 51 Reserved*
34 GND 40 GND 46 LED_WPAN# 52 +3.3V

36 GND 41  Reserved* 47  Reserved*®

36 USB_D- 42 LED_WWAN# 48 +1.5V

NOTE: *Reserved for future second PCI Express LAN (if needed)
**Reserved for future wireless coexistence control interface (if needed)

***Reserved for future UIM interface (if needed)

DVI Connector

Connector and Icon

-

Pin Signal Pin Signal

1 T.M.D.S. Data2— 13 T.M.D.S. Data3+

2 T.M.D.S. Data2+ 14 +5V Power

3 T.M.D.S. Data2/4 Shield 15 Ground (for +5V)

4 T.M.D.S. Data4— 16 Hot Pug Detect

5 T.M.D.S. Datad+ 17 T.M.D.S. Data0—

6 DDC Clock 18 T.M.D.S. Data0O+

7 DDC Data 19 T.M.D.S. Data0/5 Shield
8 No Connect 20 T.M.D.S. Data5—

9 T.M.D.S. Data1- 21 T.M.D.S. Data5+

10 T.M.D.S. Data1+ 22 T.M.D.S. Data Shield
11 T.M.D.S. Data1/3 Shield 23 T.M.D.S. Clock+

12 T.M.D.S. Data3— 24 T.M.D.S. Clock-

DVI Connector
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal
switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon
it or against it. Particular attention should be paid to the plug, electrical outlet, and the point where the
cord exits from the product.

/A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

/A CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) UL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must

be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10 or
F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

B NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide.
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POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

B NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1 Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option 1. Verify the correct ROM.

ROM checksum.
2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS.

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS.
2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs  Recently added PCI expansion card contains 1.  If a PCl expansion card was recently
an option ROM too large to download during added, remove it to see if the problem
POST. remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to prevent
PXE option ROM for the internal NIC
from being downloaded during POST to
free more memory for an expansion
card's option ROM. Internal PXE option
ROM is used for booting from the NIC to
a PXE server.

162-System Options Not Set Configuration incorrect. Run Computer Setup and check the

configuration in Advanced > Onboard

RTC (real-time clock) battery may need to Devices.

be replaced.
Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set Invalid time or date in configuration memory. Reset the date and time under Control
Panel (Computer Setup can also be used). If
RTC (real-time clock) battery may needto  the problem persists, replace the RTC
be replaced. battery. See the Hardware Reference Guide
for instructions on installing a new battery, or
contact an authorized dealer or reseller for
RTC battery replacement.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4.  Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty
memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1.  If additional memory was recently
added, remove it to see if the problem
remains.

2.  Check product documentation for
memory support information.

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2.  Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error

1/0 board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2.  Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card (if applicable).
2. Clear CMOS.

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.

3. Replace CPU or chassis fan.

601-Diskette Controller Error

Diskette controller circuitry or floppy drive
circuitry incorrect.

1. Check and/or replace cables.
2. Clear CMOS.
3. Replace diskette drive.

4. Replace the system board.

605-Diskette Drive Type Error

Mismatch in drive type.

1. Disconnect any other diskette controller
devices (tape drives).

2. Clear CMOS.

660-Display cache is detected unreliable

Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected

Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix
an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the SATA
0 and SATA 1 connectors must be used
before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA 1.
For three devices, use SATA 0, SATA 1, and
SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options > SATA
Emulation to IDE, and select File > Save
Changes and Exit. Reenter Computer Setup
and select Security > Drivelock Security.
For each listed Drivelock-capable SATA
device, ensure Drivelock is Disabled. Lastly,
change Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2200-PMM Allocation Error during MEBx Memory error during POST execution of the 1.  Reboot the computer.

Download Management Engine (ME) BIOS Extensions
option ROM. 2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system

board.
2201-MEBx Module did not checksum Memory error during POST execution of the 1. Reboot the computer.
correctly Management Engine (ME) BIOS Extensions
option ROM. 2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2202-PMM Deallocation Error during MEBx ~ Memory error during POST execution of the 1.  Reboot the computer.

cleanup Management Engine (ME) BIOS Extensions
option ROM. 2.  Unplug the power cord, re-seat the

memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBXx execution MEBX selection or exit resulted in a setup 1. Reboot the computer.
failure.
2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx 1. Reboot the computer.
resulted in a failure.
2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message Description

Recommended action

2205-Interface error during MEBx execution MEBXx operation experienced a hardware
error during communication with ME.

1.

2,

Reboot the computer.

If the error persists, update to the latest
BIOS version.

If the error still persists, replace the
system board.

2211-Memory not configured correctly for DIMM1 is not installed.
proper MEBXx execution.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly

seated.
Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.
Network Server Mode Active and No Keyboard failure while Network Server Mode 1. Reconnect keyboard with computer
Keyboard Attached enabled. turned off.
2. Check connector for bent or missing
pins.
3. Ensure that none of the keys are
depressed.
4. Replace keyboard.
Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.
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Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Table C-2 Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action
Green Power LED On. None Computer on. None
Green Power LED flashes None Computer in Suspend to None required. Press any key or move the mouse
every two seconds. RAM mode (some models to wake the computer.
only) or normal Suspend
mode.
Red Power LED flashes two 2 Processor thermal Ensure that the computer air vents are not
times, once every second, protection activated: blocked and the processor cooling fan is
followed by a two second running.
pause. Beeps stop after fifth A fan may be blocked or
iteration but LEDs continue not turning. Open hood, press power button, and see if
until problem is solved. the processor fan spins. If the processor fan
OR is not spinning, make sure the fan's cable is
plugged onto the system board header.
The heatsink/fan
assembly is not properly If fan is plugged in, but is not spinning, then
attached to the processor. replace heatsink/fan assembly.
Contact an authorized reseller or service
provider.
Red Power LED flashes three 3 Processor not installed Check to see that the processor is present.

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

(not an indicator of bad
processor).

Reseat the processor.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause

Recommended Action

Red Power LED flashes four 4
times, once every second,
followed by a two second

pause. Beeps stop after fifth OR
iteration but LEDs continue
until problem is solved.

Power failure (power
supply is overloaded).

The incorrect external
power supply adapter is

being used on the USDT.

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and repeat
this procedure until failure occurs. Replace
the device that is causing the failure.
Continue adding devices one at a time to
ensure all devices are functioning properly.

3. Replace the power supply.
4. Replace the system board.
OR

The USDT power supply adapter must be at 135W
and use the Smart ID technology before the
system will power up. Replace the power supply
adapter with the HP-supplied USDT power supply
adapter.

Red Power LED flashes five 5
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Pre-video memory error.

CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six 6
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Pre-video graphics error.

For systems with a graphics card:
1. Reseat the graphics card.

2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, replace the
system board.

Red Power LED flashes seven 7
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

System board failure
(ROM detected failure
prior to video).

Replace the system board.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eight 8
times, once every second, checksum.

Invalid ROM basedonbad 1. Reflashthe system ROM with the latest BIOS
image. See the “Boot Block Emergency

followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

Recovery Mode” section of the Desktop
Management Guide for more information.

2. Replace the system board.

Red Power LED flashes nine 9 System powers on but is
times, once every second, unable to boot.

followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

1. Check that the voltage selector, located on
the rear of the power supply (some models),
is set to the appropriate voltage. Proper
voltage setting depends on your region.

2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3. Replace the system board.

4. Replace the processor.

Red Power LED flashes ten 10 Bad option card.

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

1. Check each option card by removing the card
(one at a time if multiple cards), then power
on the system to see if fault goes away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.

Red Power LED flashes eleven 11 The current processor 1. Install a TXT capable processor.

times, once every second, does not support a feature

followed by a two second previously enabled on this 2. Disable TXT in the Computer Setup (F10)
pause. Beeps stop after fifth system. utility.

iteration but LEDs continue
until problem is solved.

3. Reinstall the original processor.

System does not power onand None System unable to power

LEDs are not flashing. on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.
OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a working
AC outlet.

2. Open hood and check that the power button
harness is properly connected to the system
board.

3. Check that both power supply cables are
properly connected to the system board.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps

Possible Cause

Recommended Action

4.

Check to see if the 5V_aux light on the

system board is turned on. If it is turned on,
then replace the power button harness. If the
problem persists, replace the system board.

If the 5V_aux light on the system board is not
turned on, remove the expansion cards one
at a time until the 5V_aux light on the system
board turns on. It the problem persists,
replace the power supply.
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D Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette drive,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.

B NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 226.

Safety and Comfort

/A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For safety and regulatory information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support

If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

Run the HP diagnostic tool.

Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 226 for more information.

If the screen is blank, plug the monitor into a different video port on the computer if one is available.
Or, replace the monitor with a monitor that you know is functioning properly.

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and see if the computer functions
properly.

If you recently installed new software, uninstall the software and see if the computer functions
properly.

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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e Refer to the comprehensive online technical support at http://www.hp.com/support.

e Refer to Helpful Hints on page 238 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/gol/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers and
HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

e Bein front of your computer when you call.

e  Write down the computer serial number, product ID number, and monitor serial number before
calling.

e Spend time troubleshooting the problem with the service technician.
e Remove any hardware that was recently added to your system.
e Remove any software that was recently installed.

e Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in HP Backup and Recovery Manager.

/A CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files
before running the restore process.

B NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful Hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

e  Check that the computer and monitor are plugged into a working electrical outlet.

e Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

e  Check that the computer is turned on and the green power light is on.
e  Check that the monitor is turned on and the green monitor light is on.

e Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 226 for more information.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.
e Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

e Check all cable connections for loose connections or incorrect connections.
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e  Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for
at least four seconds then press the power button again to restart the computer. If the system will
not shut down, unplug the power cord, wait a few seconds, then plug it in again. The computer will
restart if it is set to power on automatically as soon as power is restored in Computer Setup. If it
does not restart, press the power button to start the computer.

e Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 259 for instructions.

e Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

e Remove all bootable media (diskette, CD, or USB device) from the system before turning it on.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

e If the system has multiple video sources (embedded, PCI, or PCl-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems

You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table D-1 Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced. First, reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If

NOTE: Connecting the computer to a live AC outlet prolongs  the problem persists, replace the RTC battery. See the

the life of the RTC battery. Hardware Reference Guide for instructions on installing a new
battery, or contact an authorized dealer or reseller for RTC
battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.
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Table D-1 Solving General Problems (continued)

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not affect
the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3.  Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually disabling
the Smart Cover Lock, is available from HP. You will need the
FailSafe Key in case of forgotten password, power loss, or
computer malfunction. Order PN 166527-001 for the wrench-
style key or PN 166527-002 for the screwdriver bit key.

Poor performance is experienced.

Cause

Solution

Processor is hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heatsink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP) or Start > Accessories > Run
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Table D-1 Solving General Problems (continued)

Poor performance is experienced.

Cause

Solution

(Windows Vista) and type msconfig. On the Startup tab
of the System Configuration Utility, clear applications that
you do not want to launch automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

2

3.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two
second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution
Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2.  Open hood, press power button, and see if the processor
OR fan spins. If the processor fan is not spinning, make sure
the fan's cable is plugged onto the system board header.
The heatsink is not properly attached to the processor.
3. Iffanis plugged in, but is not spinning, then replace the
heatsink/fan assembly.
4. Contact an authorized reseller or service provider.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns green, then:

1.

3.

OR

Check that the voltage selector, located on the rear of the
power supply on some models, is set to the appropriate
voltage. Proper voltage setting depends on your region.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on green then:

1.

2

Check that the unit is plugged into a working AC outlet.

Open hood and check that the power button harness is
properly connected to the system board.
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Table D-1 Solving General Problems (continued)

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

3. Check that both power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
harness.

5. Ifthe 5V_auxlight on the system board is off, then replace
the power supply.

6. Replace the system board.

Solving Power Problems

Common causes and solutions for power problems are listed in the following table.

Table D-2 Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some Select the proper AC voltage using the selector switch.
models) not switched to correct line voltage (115V or 230V).

Power supply will not turn on because of internal power supply Contact an authorized service provider to replace the power
fault. supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two
second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open hood, press power button, and see if the processor
OR fan spins. If the processor fan is not spinning, make sure
the fan's cable is plugged onto the system board header.
The heatsink is not properly attached to the processor.
3. Iffanis plugged in, but is not spinning, then replace the
heatsink/fan assembly.

4. Contact an authorized reseller or service provider.
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Table D-2 Solving Power Problems (continued)

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check that the voltage selector, located on the rear of the
power supply (some models), is set to the appropriate
voltage. Proper voltage setting depends on your region.

2.  Open the hood and ensure the 4- or 6-wire power supply
cable is seated into the connector on the system board.

3. Checkif a device is causing the problem by removing ALL
attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If the
system enters the POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

The incorrect external power supply adapter is being used on The USDT power supply adapter must be at 135W and use the

the USDT. Smart ID technology before the system will power up. Replace
the power supply adapter with the HP-supplied USDT power
supply adapter.

Solving Diskette Problems

Common causes and solutions for diskette problems are listed in the following table.

B NOTE: You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. See Solving Hardware Installation Problems on page 259 for instructions.

Table D-3 Solving Diskette Problems

Diskette drive light stays on.

Cause Solution

Diskette is damaged. In Microsoft Windows XP, right-click Start, click Explore, and
select a drive. Select File > Properties > Tools. Under Error-
checking click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive cable is not properly connected. Reconnect drive cable. Ensure that all four pins on the diskette
power cable are connected to the drive.
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Table D-3 Solving Diskette Problems (continued)

Drive not found.

Cause

Solution

Cable is loose.

Reseat diskette drive data and power cable.

Removable drive is not seated properly.

Reseat the drive.

The device has been hidden in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the Legacy Diskette in Security > Device
Security.

Diskette drive cannot write to a diskette.

Cause

Solution

Diskette is not formatted.

Format the diskette.
1. From Windows Explorer select the disk (A) drive.
2. Right-click the drive letter and select Format.

3. Select the desired options, and click Start to begin
formatting the diskette.

Diskette is write-protected.

Use another diskette or remove the write protection.

Writing to the wrong drive.

Check the drive letter in the path statement.

Not enough space is left on the diskette.

1. Use another diskette.

2. Delete unneeded files from diskette.

Legacy diskette writes are disabled in Computer Setup.

Enter Computer Setup and enable Legacy Diskette Write
in Storage > Storage Options.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Cause

Solution

Invalid media reported.

When formatting a disk in MS-DOS, you may need to specify
diskette capacity. For example, to format a 1.44-MB diskette,
type the following command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be write-protected.

Open the locking device on the diskette.

Legacy diskette writes are disabled in Computer Setup.

Enter Computer Setup and enable Legacy Diskette Write
in Storage > Storage Options.
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Table D-3 Solving Diskette Problems (continued)

A problem has occurred with a disk transaction.

Cause

Solution

The directory structure is bad, or there is a problem with a file.

In Microsoft Windows XP, right-click Start, click Explore, and
select a drive. Select File > Properties > Tools. Under Error-
checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Diskette drive cannot read a diskette.

Cause

Solution

You are using the wrong diskette type for the drive type.

Check the type of drive that you are using and use the correct
diskette type.

You are reading the wrong drive.

Check the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk” message is displayed.

Cause

Solution

A diskette that does not contain the system files needed to start
the computer has been inserted in the drive.

When drive activity stops, remove the diskette and press the
Spacebar. The computer should start up.

Diskette error has occurred.

Restart the computer by pressing the power button.

Cannot Boot to Diskette.

Cause

Solution

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been disabled in Computer Setup.

1. Run Computer Setup and enable diskette boot in
Storage > Boot Order.

2.  Run Computer Setup and enable diskette boot in
Storage > Storage Options > Removable Media
Boot.

NOTE: Both steps should be used as the Removable Media
Boot function in Computer Setup overrides the Boot Order
enable command.

Network server mode is enabled in Computer Setup.

Run Computer Setup and disable Network Server Mode in
Security > Password Options.
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Solving Hard Drive Problems

Table D-4 Solving Hard Drive Problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click
Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore, and
select a drive. Select File > Properties > Tools. Under Error-
checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 259 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Table D-4 Solving Hard Drive Problems (continued)

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from a diskette that is not bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

System files missing or not properly installed.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board connector labeled P60 SATA 0.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.”

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 226 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
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Table D-4 Solving Hard Drive Problems (continued)

Computer seems to be locked up.

Cause Solution

off the power. To restart the computer, press the power button
again.

The removable hard drive has no power to the hard drive enclosure.

Cause Solution

The lock on the enclosure is not turned to the “ON” position.  Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the enclosure Check the power supply to make sure it is properly connected
frame is not properly connected. to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the Push the carrier into the enclosure frame so that the connector
enclosure frame or the hard drive is not fully seated in the on the rear of the frame is properly seated. If this does not solve
carrier. the problem, turn off the computer, remove the carrier, and

check to see if the connector on the hard drive is properly
seated in the carrier.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has  Shut down the computer and contact HP for a replacement
been activated. enclosure.

Solving Media Card Reader Problems

Table D-5 Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows XP or Microsoft Windows Vista.

Cause Solution

By default, Windows XP and Windows Vista will format any Either format the media card in the digital camera or select FAT
media card with a capacity greater than 32MB with the FAT32 file system to format the media card in a computer with
format. Most digital cameras use the FAT (FAT16 & FAT12)  Windows XP or Windows Vista.

format and can not operate with a FAT32 formatted card.
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Table D-5 Solving Media Card Reader Problems (continued)

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer's documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the wrong
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause

Solution

The computer’s software is used to safely eject the card.

Open My Computer (Windows XP) or Computer (Windows
Vista), right-click on the corresponding drive icon, and select
Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized

by the computer.

Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize
whatever media is inserted in the reader.
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Table D-5 Solving Media Card Reader Problems (continued)

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

If you do not want to boot from the media card, remove it during
boot or do not select the option to boot from the inserted media
card during the boot process.

Solving Display Problems

If you encounter display problems, see the documentation that came with the monitor and to the common

causes and solutions listed in the following table.

Table D-6 Solving Display Problems

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image. See the
“Boot Block Emergency Recovery Mode” section of the
Desktop Management Guide for more information

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Monitor cable is plugged into the wrong connector.

If the computer system has both an integrated graphics
connector and an add-in graphics card connector, plug the
monitor cable into the graphics card connector on the back of
the computer.

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance and
Personalization, select Adjust screen resolution.

2. Use the sliding control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.
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Table D-6 Solving Display Problems (continued)

Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause

Solution

On systems with Intel integrated graphics, the integrated
graphics cannot be enabled after installing a PCI Express x16.

The integrated graphics can be enabled in Computer Setup if
a PCl or PCI Express x1 graphics card is installed, but it cannot
be enabled if there is a graphics card in the PCI Express x16
slot.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video memory error.

1. Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the
computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video graphics error.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

252 Appendix D Troubleshooting Without Diagnostics



Table D-6 Solving Display Problems (continued)

Dim characters.

Cause Solution
The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.
Cables are not properly connected. Check that the graphics cable is securely connected to the

graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics  Install the video drivers included in the upgrade kit.
drivers may not be loaded.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor 1. Be sure the monitor cable is securely connected to the
may be incorrectly adjusted. computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the

image.
“No Connection, Check Signal Cable” displays on screen.
Cause Solution
Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

Solving Display Problems 253



Table D-6 Solving Display Problems (continued)

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the Restart the computer and enter Safe Mode. Change the
monitor supports. settings to a supported setting then restart the computer so that
the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated when
the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be 1.  Select the monitor's Auto-Adjustment option in the
unable to correctly interpret the output synchronization of the monitor’s on-screen display menu.
graphics card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories > System
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Table D-6 Solving Display Problems (continued)

Certain typed symbols do not appear correct.

Cause

Solution

Tools > Character Map. You can copy the symbol from the
Character Map into a document.

Solving Audio Problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Table D-7 Solving Audio Problems

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2. Onthe Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust
the volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the front
headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.
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Table D-7 Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause

Solution

Digital CD audio is not enabled.

Enable digital CD audio. In the Device Manager, right-click on
the CD/DVD device and select Properties. Make sure Enable
digital CD audio for this CD-ROM device is checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices
and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack
or set the jack to its default value.

Solving Printer Problems

If you encounter printer problems, see the documentation that came with the printer and to the common

causes and solutions listed in the following table.

Table D-8 Solving Printer Problems

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.
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Table D-8 Solving Printer Problems (continued)

Printer will not print.

Cause

Solution

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ >

[printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause

Solution

The printer may be out of paper.
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Solving Keyboard and Mouse Problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table D-9 Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista Desktop, click Start, click the
arrow on the lower right corner of the Start menu, then
select Shut Down.

2.  After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key may be on.

Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.

Table D-10 Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
the Enter key.

3.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the keyboard)
and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.
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Table D-10 Solving Mouse Problems (continued)

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution
Mouse roller ball or the rotating encoder shafts that make Remove roller ball cover from the bottom of the mouse and
contact with the ball are dirty. clean the internal components with a mouse cleaning kit

available from most computer stores.

Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non—plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

/A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table D-11 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are Ensure that all cables are properly and securely connected and
unplugged. that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration, Reboot the computer and follow the instructions for accepting
you did not accept them. the changes.

A plug and play board may not automatically configure when  Use Windows Device Manager to deselect the automatic
added if the default configuration conflicts with other devices. settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use Computer
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Table D-11 Solving Hardware Installation Problems (continued)

A new device is not recognized as part of the system.

Cause Solution

Setup to reconfigure or disable devices to resolve the resource
conflict.

USB ports on the computer are disabled in Computer Setup.  Enter Computer Setup (F10) and enable the USB ports.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory 1. Review the documentation that came with the system to
modules were installed in the wrong location. determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM 1 must always be installed.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.
NOTE: DIMM 1 must always be installed.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system board For systems with a graphics card:

is bad.
1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.
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Table D-11 Solving Hardware Installation Problems (continued)

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at time
(if multiple cards), then power on the system to see if fault
goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table D-12 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:

1. Select Start > Control Panel.

2. Double-click Network Connections.

3. Double-click Local Area Connection.

4. Click Properties.

5. Click Configure.

6. Click the Power Management tab, then select the check
box to Allow this device to bring the computer out of
standby.

To enable Wake-on-LAN in Windows Vista:

1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Inthe Tasks list, select Manage network connections.
4. Double-click Local Area Connection.

5.  Click the Properties button.
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Table D-12 Solving Network Problems (continued)

Wake-on-LAN feature is not functioning.

Cause

Solution

6. Click the Configure button.

7. Click the Power Management tab, then select the check
box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are operating
correctly.
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Table D-12 Solving Network Problems (continued)

Diagnostics reports a failure.

Cause

Solution

Network controller interrupt is shared with an expansion board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.

Cause

Solution

New network card may be defective or may not meet industry-

standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.
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Table D-12 Solving Network Problems (continued)

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems

If you encounter memory problems, some common causes and solutions are listed in the following table.

/\ CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

Ef NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

Table D-13 Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the XMM1 (or DIMM1) Ensure that a memory module is installed in the black XMM1
socket. (or DIMM1) socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the Replace module with the correct industry-standard device for
system or the new memory module is not seated properly. the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution
Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.
You have run out of memory to run the application. Check the application documentation to determine the memory

requirements.
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Table D-13 Solving Memory Problems (continued)

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are Delete any TSRs that you do not need.
installed.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Processor Problems

If you encounter processor problems, common causes and solutions are listed in the following table.

Table D-14 Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heatsink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.
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Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause

Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.
2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table D-15 Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure CD-
ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 259 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

266 Appendix D Troubleshooting Without Diagnostics



Table D-15 Solving CD-ROM and DVD Problems (continued)

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove

the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to

determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause

Solution

Wrong or poor quality media type.

1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.
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USDT computer boots too slow after removing a CD-ROM or DVD drive.

Cause

Solution

The system is searching for the drive during boot because the Disconnect the drive cable from the system board.

drive cable is still attached to the system board.

Solving USB Flash Drive Problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following

table.

Table D-16 Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure USB
is enabled in Storage > Boot Order.

The image on the device is not bootable.

Follow the procedures described in the “ROM Flash:
Replicating the Setup: Creating a Bootable Device: Supported
USB Flash Media Device” section of the Service Reference
Guide.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

Table D-17 Solving Front Panel Component Problems

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. If possible, replace the cable.

2. Restart the computer.

The device is not working.

1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Enter Computer Setup (F10) and enable the USB ports.

Solving Internet Access Problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table D-18 Solving Internet Access Problems

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly.

Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED light
on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due
to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will be
on.)
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Table D-18 Solving Internet Access Problems (continued)

Unable to connect to the Internet.

Cause

Solution

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the

Windows Vista

Web browser. This is useful for having the browser remember 1.  Select Start > Control Panel.
some specific information that the Web server can later
retrieve.) 2. Click Network and Internet.
3.  Click Internet Options.
4. Inthe Browsing history section on the General tab, click
the Delete button.
5.  Click the Delete cookies button.
Windows XP
1. Select Start > Control Panel.
2. Double-click Internet Options.
3. Onthe General tab, click the Delete Cookies button.
Cannot automatically launch Internet programs.
Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating

properly.

Windows XP

1. Select Start > Control Panel.
2. Double-click System.

3. Click the Hardware tab.

4. Inthe Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates the
modem is connected and working properly.

Windows Vista

270 Appendix D Troubleshooting Without Diagnostics



Table D-18 Solving Internet Access Problems (continued)

Internet takes too long to download Web sites.

Cause Solution

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. Inthe Tasks list, select Device Manager.
5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates the
modem is connected and working properly.

Solving Software Problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e There is insufficient memory available to run the application.

e There is a conflict between applications.

e Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table D-19 Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the computer.
See Appendix A, POST Error Messages on page 226 to
determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.
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Table D-19 Solving Software Problems (continued)

“lllegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version Verify that the software is certified by Microsoft for your version

of Windows. of Windows (see program packaging for this information).
Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.

Contacting Customer Support

For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

Bf NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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E System Board and Riser Board
Reference Designators

These reference designators are used on most but not all HP system and riser boards.

Designator Component

BAT Battery socket/Battery

CR1 LED - 5V_Aux or VIN

CR2 Health-LED

CR3 UID LED

CR4 Power LED

E14 Boot block header/jumper
E15 Boot block recovery header
E16 ROM recovery header

E17 LAN IEEE test header

E25 CPLD programming header
E49/JP49 Clear Password header/jumper
E50 Clear CMOS header

J7 RJ45 jack

J9 Stacked RJ45/Dual USB

J10 Quad stacked USB

J11 First IEEE 1394 connector
J12 Second IEEE 1394 connector
J13 SPDIF input

J14 SPDIF output

J20- 29 PClI slots

J30 PCI extender slot (male)
J31-J35 PCI Express X1 slots

Ja1 PCI Express x16 graphics slot
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J42 PCI Express x4 graphics slot

J50 First parallel port

J51 Second parallel port

J52 Double-stacked parallel port, Top = Port B, Bottom = Port A
J53 Parallel port over single Serial Port

J54 Parallel port over Serial Port and Video Port

J55 Parallel port over dual VGA ports

J64 Display port connector

J65 DVI connector

J66 Keyboard connector, PS/2 (Closest to power supply)

J67 Mouse connector, PS/2

J68 Stacked mouse (Top)/keyboard (Bottom) connector

J69 Video connector, VGA

J70 Primary single USB connector

J71 Secondary single USB port

J72 Microphone jack

J73 Line-in jack

J74 Line-out jack

J75 Headphone jack

J76 Volume control

J77 Double-stacked headphone (Bottom)/microphone (Top) connector
J78 Double-stacked line-in (Top)/line-out (Bottom) connector
J8o Stacked serial/audio connector

J81 Primary double-stack USB, Top = Port 2, Bottom = Port 1
Jg2 Secondary double-stack USB, Top = Port 4, Bottom = Port 3
J83 Triple-stacked audio jack (line in, line out/headphone, microphone)
J101 Security board connector - for security card

J103 DC input power

J105 PCI Express MiniCard

J9020-J9029 PCI slots on riser card

J9030-J9034 PCI express slots on riser card

JP49/E49 Clear password header/jumper

L1 USB front port choke (1st)

L2 USB rear port choke (1st)
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L3

USB rear port choke (2nd)

L4 USB rear port choke (3rd)

L5 USB front port choke (2nd)

P1 P/S connector (20 or 24 pin)

P2 Second P/S connector (as required)

P3 Processor 12V header

P4 Secondary Processor 12V header

P5 Main Power/Control Panel

P6 Speaker connector

P7 Analog audio connector (from CD-ROM)
P8 Primary chassis fan header or primary CPU heatsink fan
P9 Secondary chassis fan header

P10 Diskette drive connector

P11 Power supply or rear chassis fan header
P12 Alert on LAN connector

P13 VRM module footprint

P15 AUI connector

P16 Fan command/fan sink header (may be 2 or 4 pin)
P17 Digital audio expansion header

P18 SPDIF internal input header

P19 SPDIF internal output header

P20 Primary IDE connector

P21 Secondary IDE/MultiBay connector

P22 Header for NEWCARD

P23 Header for front panel audio

P24 Header for front panel USB

P25 Internal USB connector 1

P26 Internal USB connector 2

P27 MultiBay header

P29 SCSI LED connector

P30 PCI extender slot (female)

P40 Blade PC graphics connector (outboard)
P41 Blade PC graphics connector (inboard)
P52 Second serial port connector
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P54 Primary serial port/Connector for first serial port

P55 Double stack serial port, Top = Serial B, Bottom = Serial A
P58 Riser edge connector (male-mates with J30)
P60 Primary Serial ATA (SATA) connector

P61 Second Serial ATA (SATA) connector

P62 Third Serial ATA (SATA) connector

P63 Fourth Serial ATA (SATA) connector

P64 VSFF expansion connector

P65 Graphics option connector

P66 Fifth Serial ATA (SATA) connector

P67 Sixth Serial ATA (SATA) connector

P68 Seventh Serial ATA (SATA) connector

P69 Eighth Serial ATA (SATA) connector

P70 Primary (CPU) fan header for fansink

P71 Secondary CPU fan header for fansink

P80 Primary Serial Attached SCSI (SAS) connector
P81 Second Serial Attached SCSI (SAS) connector
P82 Third Serial Attached SCSI (SAS) connector
P83 Fourth Serial Attached SCSI (SAS) connector
P84 Fifth Serial Attached (SAS) connector

P85 Sixth Serial Attached (SAS) connector

P86 Seventh Serial Attached (SAS) connector
P87 Eighth Serial Attached (SAS) connector

P101 Security board connector, system board
P106 Secondary speaker connector

P124 Hood lock header

P125 Hood sensor header

P126 Flying parallel port header

P150 Media reader header

P151 ReadyBoost header

P160 SATA power header

P216 White box chassis fan header

SW2 Security hood switch on riser card

SW50 Clear CMOS switch
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U2

Single chip solution (combined northbridge/southbridge)

U3 North bridge

U4 South bridge

us Super I/0

U6 Clock chip

u7 64 bit Bridge

u10 NIC Chip

U11 NIC SPI ROM

u12 LOM1 PHY

U13 Audio Codec

u14 Audio internal speaker amplifier
u16 LOM2

u17 LOM2 EEPROM

u18 LOM2 PHY

u19 SPI ROM - SOIC-8 footprint

u20 Fan controller

u21 SPI ROM - SO16 footprint

u29 TMDS controller

u30 Parallel port diode array

U31 First serial port transceiver

u32 Second serial port transceiver
u40 TPM controller

U46 VRD controller

us0 USB front port power switch

u51 First USB rear port power switch
us2 Second USB rear port power switch
us3 Third USB rear port power switch
XBT Battery socket

XMM1 Memory slot

XMM2 - XMM5 Following memory slots

XU1 Processor socket

Xu2 Secondary processor socket
XU15/U15 System ROM and Socket (Socket = XU15, ROM = U15)
XU19/U19 SPI ROM and socket (XU19 = socket, U19 = SPI ROM)
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Y1 Primary (TH) system clock crystal

Y2 Secondary (SMT) system clock crystal
Y3 Primary NIC clock crystal

Y4 Secondary NIC clock crystal

Y5/H5 RTC clock crystal/tie-down

Y6 SATA-to-PATA crystal

L1-5 USB chokes
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F Specifications

CMT Specifications

Table F-1 Specifications

Desktop Dimensions

Height 7.0in 17.8cm
Width 17.63in 44.8 cm
Depth 17.8in 45.2 cm
Tower Dimensions

Height 17.63in 44.8 cm
Width 7.0in 17.8 cm
Depth 17.8in 45.2 cm
Approximate Weight 26.41b 12.0 kg
Weight Supported (maximum distributed load in desktop 77 b 35kg
position)

Temperature Range

Operating 50° to 95°F 10° to 35°C
Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of

options installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%
Nonoperating (38.7°C max wet bulb) 5-95% 5-95%
Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
Nonoperating 30,000 ft 9144 m

Heat Dissipation
Maximum (standard PS) 1,916 BTU/hr

Typical (idle; standard PS) 307 BTU/hr

483 kg-cal/hr

77 kg-cal/hr

CMT Specifications
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Table F-1 Specifications (continued)

Maximum (85% Efficient PS) 1519 BTU/hr 383 kg-cal/hr
Typical (idle; 85% Efficient PS) 239 BTU/hr 60 kg-cal/hr
Power Supply 115V 230V
Operating Voltage Range’ 90-264 VAC 90-264 VAC
Rated Voltage Range 100-240 VAC 100-240 VAC
Rated Line Frequency 50-60 Hz 50-60 Hz
Power Output 365 W 365 W

Rated Input Current (maximum)’
Standard PS 6A @ 100 VAC 3A @ 200 VAC

85% Efficient PS 5A @ 100VAC 2.5A @ 200VAC

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

SFF Specifications

Table F-2 Specifications

Desktop Dimensions (in the desktop position)

Height 3.95in 10.0 cm
Width 13.3in 33.8cm
Depth 14.9in 37.8cm
Approximate Weight 191b 8.6 kg
Weight Supported (maximum distributed load in desktop 77 b 35 kg
position)

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of
options installed.

Relative Humidity (noncondensing)
Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 5-95% 5-95%

Maximum Altitude (unpressurized)
Operating 10,000 ft 3048 m

Nonoperating 30,000 ft 9144 m

Heat Dissipation

Maximum (standard PS) 1260 BTU/hr 318 kg-cal/hr
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Table F-2 Specifications (continued)

Typical (idle; standard PS) 307 BTU/hr 77 kg-cal/hr
Maximum (85% Efficient PS) 999 BTU/hr 252 kg-cal/hr
Typical (idle; 85% Efficient PS) 239 BTU/hr 60 kg-cal/hr
Power Supply 115V 230V
Operating Voltage Range 90-264 VAC 90-264 VAC
Rated Voltage Range 100-240 VAC 100-240 VAC
Rated Line Frequency 50-60 Hz 50-60 Hz
Power Output 240 W 240 W

Rated Input Current (maximum)’
Standard PS 4A @ 100 VAC 2A @ 200 VAC

85% Efficient PS 3.5A @ 100VAC 1.75A @ 200VAC

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

USDT Specifications

Table F-3 Specifications

Desktop Dimensions (in the desktop position)

Height 2.60in 6.6 cm
Width 9.90 in 25.1 cm
Depth 10.00 in 25.4 cm

(depth will increase if the computer is equipped with a port security bracket)

Approximate Weight 6.95 b 3.15kg
Weight Supported (maximum distributed load in desktop position) 77 b 35 kg
Temperature Range (values subject to change with increasing altitude above sea

level)

Operating 50° to 95° F 10°to 35° C
Nonoperating -22°to 140° F -30° to 60° C

NOTE: Operating temperature is derated 1.0° C per 300 m (1,000 ft) to 3,000 m (10,000 ft) above sea level, no direct sustained
sunlight. Maximum rate of change is 10° C (50° F)/Hr. The upper limit may be limited by the type and number of options installed.

Relative Humidity (noncondensing)
Operating (28° C (82.4° F) max wet bulb) 10-90% 10-90%

Nonoperating (38.7° C (101.66° F) max wet bulb) 5-95% 5-95%

Maximum Altitude (unpressurized)
Operating 10,000 ft 3,048 m

Nonoperating 30,000 ft 9,144 m
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Table F-3 Specifications (continued)

Heat Dissipation

Maximum 550 BTU/hr 139 kg-cal/hr
Typical (idle) 222 BTU/hr 56 kg-cal/hr
Power Supply

Operating Voltage Range 90-264 VAC

Rated Voltage Range’ 100-240 VAC

Rated Line Frequency 50-60 Hz

Power Output 135 W

Rated Input Current (maximum)'

2.2A @ 100VAC 1.1A @ 200VAC

1

This system utilizes an active power factor corrected external power supply. This allows the system to pass the CE mark

requirements for use in the countries of the European Union. The active power factor corrected power supply also has the

added benefit of not requiring an input voltage range select switch.
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Index

Symbols/Numerics
24-pin MicroFit power pin
assignments 219
24-pin power pin
assignments 218
4-pin power pin assignments 219
6-pin power pin assignments 219

A
access panel
locking and unlocking 64,
119
removing 70, 183
access panel, locked 241
access to computer,
controlling 40
Altiris
AClient 24
Client Management Suite 29
Deployment Solution
Agent 24
asset tracking 40
ATA/ATAPI (IDE) drive cable pin
assignments 217
audible codes 233
audio problems 255

B
Backup and Recovery
Manager 29
backwall, SFF removal and
replacement 172
battery
CMT removal and
replacement 110
disposal 62
SFF removal and
replacement 173
USDT removal and
replacement 208

beep codes 233
bezel, removing 184
BIOS

HPQFlash 33

Remote ROM Flash 33
boot problems 268
bootable device

creating 36

USB flash media device 36
booting options

Full Boot 226

Quick Boot 226

C
cable connections
CMT 74
SFF 138
USDT 191
cable lock 179
cable lock provision 49
cable management
CMT 73
SFF 137
UsSDT 190
cable pinouts
SATA data 52
SATA power 52
cautions
AC power 54
cables 61
cooling fan 60
electrostatic discharge 56
keyboard cleaning 59
keyboard keys 60
CD-ROM connector pin
assignments 218
CD-ROM or DVD problems 266
change notification 32
changing computer
configuration 113, 115

changing operating systems,
support 39
changing password 44
chasis types, illustrated 54
chassis
CMT illustrated 54
SFF illustrated 55
USDT illustrated 55
cleaning
computer 59
mouse 60
safety precautions 59
clearing password 46
Client Management Interface 25
Client Manager from
Symantec 28
cloning tools, software 23
CMT
battery removal and
replacement 110
cable connections 74
cable management 73
chassis, illustrated 54
disassembly preparation 63
eSATA port removal and
replacement 103
external security 66
fan shroud removal and
replacement 105
front chassis fan removal and
replacement 107
front I/O device removal and
replacement 100
heatsink removal and
replacement 104
power supply removal and
replacement 108
preparation for
disassembly 63
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processor removal and
replacement 106

rear chassis fan removal and
replacement 102

speaker removal and
replacement 101

system board connections 74

system board removal and
replacement 109

computer
changing from desktop to
tower 210

specifications 280, 281
computer access panel
removing 125
computer cleaning 59
configuring power button 38
connecting drive cables 140
connections
CMT system board 74
SFF system board 138
USDT system board 191
connector pin assignments 212
controlling access to
computer 40
country power cord set
requirements 225
cover lock 48
Customer Support 237, 272

D
deleting password 45
delimiter characters, table 45
deployment tools, software 23
desktop conversion 113
diagnostic tool for hard drives 49
diagnostics utility 17
DIMMs. See memory
disassembly preparation
CMT 63
SFF 118
USDT 178
diskette drive
installing 91, 150
removing 87, 147
diskette problems 244
drive
installing optical drive 193
removing optical drive 191

284 Index

transferring hard drive
screws 197
upgrading hard drive 195
drive connectors 85
drive, protecting 49
DriveLock 46

drives
connecting cables 140
installing 140

locations 86, 139

removing 87

SFF removal and

replacement 139
dual-state power button 38
DVI pin assignments 223

E
electrostatic discharge (ESD)
preventing damage 56
entering
power-on password 44
setup password 44
error
codes 226, 233
messages 227
eSATA port
CMT removal and
replacement 103
ethernet
AUI pin assignments 213
BNC pin assignments 212
RJ-45 pin assignments 213
expansion card
installing 79, 132
removing 79, 132
slot locations 79, 132
expansion slot cover
removing 80, 133
replacing 82, 135

F
FailSafe Key 64, 119
FailSafe Key, ordering 48
fan shroud
CMT removal and
replacement 105
SFF removal and
replacement 161
fan, power supply 60

Fault Notification and
Recovery 49
fingerprint identification
technology 49
flash drive problems 268
flashing LEDs 233
front bezel
removing 71, 126
removing and replacing 184
removing blanks 72, 127,
185
security 125
front chassis fan
CMT removal and
replacement 107
front fan
SFF removal and
replacement 162
USDT removal and
replacement 201
front 1/0 device
CMT removal and
replacement 100
SFF removal and
replacement 165
front panel problems 269

G

general problems 240
grounding methods 57
guide screws 140

H

hard drive
installing 93, 152
installing secondary 150
proper handling 61
removing 87, 152
SATA characteristics 51
upgrading 195

hard drive cage
USDT removal and

replacement 199

hard drive problems 247

hard drives, diagnostic tool 49

hardware installation

problems 259
headphone pin assignments 215



heatsink
CMT removal and
replacement 104
SFF removal and
replacement 167
USDT removal and
replacement 204
helpful hints 238
hood sensor
SFF removal and
replacement 163
USDT removal and
replacement 208
HP
Backup and Recovery
Manager 29
Client Automation Starter,
Standard, and Enterprise
Editions 27
Client Catalog for Microsoft
System Center & SMS
Products 29
Client Management
Interface 25
Client Manager from
Symantec 28
ProtectTools Security
Manager 27
System Software Manager 26
HPQFlash 33

|

industry standards 39

infrared (IR) transceiver, external,
pin assignments 216

initial configuration 23

Insight Diagnostics 17

installing
diskette drive 91, 150
drive cables 140
expansion card 79, 132
guide screws 140
hard drive 93, 152, 195
media card reader 91, 150
memory 75, 77, 128
memory module 186, 188
optical drive 91, 144, 193
port cover 200
removable hard drive 95, 156
SODIMMs 186, 188

internal components,
accessing 183
internal temperature of
computer 50
Internet access problems 269
Internet addresses. See Web sites

K
keyboard

cleaning 59

pin assignments 212
keyboard delimiter characters,
national 45
keyboard problems 258

L

LEDs
blinking power 233
blinking PS/2 keyboard 233

line-in audio pin

assignments 215

line-out audio pin

assignments 215

locking Smart Cover Lock 48

locks
cable lock 66, 121, 179
front bezel 125
HP Business PC Security
Lock 68, 123, 180
padlock 67, 122, 180
Smart Cover Lock 64, 119

M
Management Technology 30
media card reader
installing 91, 150
removing 87, 147
Media Card Reader
problems 249
memory
installing 75, 77, 128
populating sockets 76, 129
specifications 75, 128
memory module
installing 186
specifications 186
memory problems 264
microphone pin assignments 215
minitower conversion 115
monitor
pin assignments 216

monitor problems 251
mouse

cleaning 60

pin assignments 212
mouse problems 258

N

national keyboard delimiter
characters 45

network problems 261

notification of changes 32

numeric error codes 227

(0]
operating guidelines 58
operating systems, support for
changing 39
optical drive
attaching release latch 192
installing 91, 144, 193
removing 87, 143, 191
optical drive connector
USDT removal and
replacement 193
optical drive problems 266
ordering FailSafe Key 48
overheating, prevention 58

P

padlock 180
parallel interface pin
assignments 214

password
changing 44
clearing 46
deleting 45
power-on 43, 44
security 43
setup 43, 44

PClcard 79, 81, 132, 134
PCI Express card 79, 81, 132,
134
PCI Express Mini Card pin
assignments 222
PCI Express pin
assignments 220
port cover 200
POST error messages 226
power button configuration 38
power cord set requirements
country specific 225
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power problems 243
power supply

CMT removal and
replacement 108

fan 60

operating voltage range 282

SFF removal and

processor problems 265

protecting hard drive 49

ProtectTools Security
Manager 27

PXE (Preboot Execution
Environment) 24

R

replacement 169
power supply, surge-tolerant 49
power switch assembly

SFF removal and
replacement 164
power-on password
changing 44
deleting 45
entering 44
setting 43
Preboot Execution Environment
(PXE) 24
preinstalled software image 23
printer problems 256
Proactive Change Notification
(PCN) 32
problems
audio 255
CD-ROM or DVD 266
diskette 244
flash drive 268
front panel 269
general 240
hard drive 247
hardware installation 259
Internet access 269
keyboard 258
Media Card Reader 249
memory 264
monitor 251
mouse 258
network 261
power 243
printer 256
processor 265
software 271
processor
CMT removal and
replacement 106
SFF removal and
replacement 168
USDT removal and
replacement 205

286 Index

rear chassis fan

CMT removal and
replacement 102

rear fan

USDT removal and
replacement 203

recovery, software 23
reference designators 273
release latch

attaching optical drive 192

Remote ROM Flash 33
remote setup 24

Remote System Installation 24
removable hard drive

replacing 95, 156

removal and replacement

CMT battery 110

CMT eSATA port 103

CMT fan shroud 105

CMT front chassis fan 107

CMT front I/O device 100

CMT heatsink 104

CMT power supply 108

CMT processor 106

CMT rear chassis fan 102

CMT speaker 101

CMT system board 109

port cover 200

SFF backwall 172

SFF battery 173

SFF drives 139

SFF fan shroud 161

SFF front fan 162

SFF front I/O device 165

SFF heatsink 167

SFF hood sensor 163

SFF power supply 169

SFF power switch
assembly 164

SFF processor 168

SFF Smart Cover Lock 166

SFF speaker 165

SFF system board 171
USDT battery 208
USDT front fan 201

USDT hard drive cage 199

USDT heatsink 204

USDT hood sensor 208

USDT optical drive
connector 193

USDT processor 205

USDT rear fan 203

USDT speaker 202

USDT system board 206

removing
access panel 183

bezel blanks 72, 127, 185
computer access panel 70,

125
diskette drive 147
drives from drive bay 87
expansion card 79, 132

expansion slot cover 80,
front bezel 71, 126, 184

hard drive 152, 195

133

media card reader 87, 147

optical drive 143, 191
PClcard 81, 134

PCIl Express card 81, 134

port cover 200

Smart Cover Lock 64, 119

retired solutions 32
riser board

reference designators 273

S
safety and comfort 237
safety precautions
cleaning 59
SATA
connectors on system
board 51
data cable pinouts 52
hard drive characteristics
pin assignments 220
power cable pinouts 52
screws
transferring to hard drive
screws, correct size 61
security

51

197

cable lock 49, 66, 121, 179

CMT 66



DriveLock 46
features, table 40
fingerprint identification
technology 49
front bezel 125
HP Business PC Security
Lock 68, 123, 180
padlock 67, 122, 180
password 43
ProtectTools Security
Manager 27
settings 40
SFF 121
Smart Cover Lock 48, 64,
119
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